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本マニュアルは，輸出する場合，経済産業省への役務取引許可申請は不要です。�

電話技術相談窓口�

インターネットによる三菱電機FA機器技術情報サービス�
   MELFANSwebホームページ：http://www.MitsubishiElectric.co.jp/melfansweb�
   MELFANSwebのFAランドでは、体験版ソフトウェアやソフトウェアアップデートのダウンロードサービス、MELSECシリーズの�
   オンラインマニュアル、Q&Aサービス等がご利用いただけます。FAランドのID登録（無料）が必要です。�

対 象 機 種 � 電 話 番 号 � 受 付 時 間※1

MELSEC-Q/QnA/A

MELSOFTシーケンサ�
プログラミングツール�
MELSOFT通信支援�
ソフトウェアツール�
MELSECパソコンボード�
MELSEC計装/Q二重化�

シーケンサ一般�
(ネットワーク/インテリジェント機能ユニット以外）�
ネットワーク、シリアルコミュニケーションユニット�
インテリジェント機能ユニット（ネットワーク以外）�
MELSOFT GXシリーズ�
SW□IVD-GPPA/GPPQなど�
MELSOFT MXシリーズ�
SW□D5F-CSKP/OLEX/XMOPなど�
Q80BDシリーズなど�
プロセスCPU（Q12/Q25PHCPU）�
二重化CPU（Q12/Q25PRHCPU）�
MELSOFT PXシリーズ�
GOT1000/A900シリーズなど�
MELSOFT GTシリーズ�
�

月曜～木曜　  9：00～19：00�
　　　金曜　  9：00～17：00

052-711-5111�
�
052-712-2578�
052-712-2579�
052-711-0037�
�
052-712-2370�
�
�
052-712-2830�
�
�
052-712-2417

※1: 土・日・祝祭日、春期・夏期・年末年始を除く通常業務日�

FAX技術相談窓口�

対 象 機 種 � F A X 番 号 � 受 付 時 間※1

※2: 春期・夏期・年末年始を除く�

上記対象機種� 9：00～16：00（受信は常時※2）�052-719-6762

本社機器営業部 〒104-6215 東京都中央区晴海1-8-12（オフィスタワーZ棟15階） （03）6221-2190�
北海道支社 〒060-8693 札幌市中央区北二条西4-1（北海道ビル） （011）212-3792�
東北支社 〒980-0011 仙台市青葉区上杉1-17-7（仙台上杉ビル） （022）216-4546�
関越支社 〒330-6034 さいたま市中央区新都心11番地2（明治安田生命さいたま新都心ビル ランド・アクシス・タワー３４F） （048）600-5835�
新潟支店 〒950-8504 新潟市東大通2-4-10（日本生命ビル） （025）241-7227�
神奈川支社 〒220-8118 横浜市西区みなとみらい2-2-1（横浜ランドマークタワー） （045）224-2624�
北陸支社 〒920-0031 金沢市広岡3-1-1（金沢パークビル） （076）233-5502�
中部支社 〒450-8522 名古屋市中村区名駅3-28-12（大名古屋ビル） （052）565-3314�
豊田支店 〒471-0034 豊田市小坂本町1-5-10（矢作豊田ビル） （0565）34-4112�
関西支社 〒530-8206 大阪市北区堂島2-2-2（近鉄堂島ビル） （06）6347-2771�
中国支社 〒730-0037 広島市中区中町7-32（日本生命ビル） （082）248-5445�
四国支社 〒760-8654 高松市寿町1-1-8（日本生命高松駅前ビル） （087）825-0055�
九州支社 〒810-8686 福岡市中央区天神2-12-1（天神ビル） （092）721-2247

お問い合わせは下記へどうぞ�
　   三菱電機株式会社 〒100-8310　東京都千代田区丸の内2-2-3（三菱電機ビル）�

GOT表示器�
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● 安全上のご注意 ● 
(ご使用前に必ずお読みください) 

 

本製品のご使用に際しては，本マニュアルおよび本マニュアルで紹介している関連マニュアルをよくお

読みいただくと共に，安全に対して十分に注意を払って，正しい取扱いをしていただくようお願いいたし

ます。 

本マニュアルで示す注意事項は，本製品に関するもののみについて記載したものです。シーケンサシス

テムとしての安全上のご注意に関しては，使用するCPUユニットのユーザーズマニュアルを参照してくだ

さい。 

この●安全上のご注意●では，安全注意事項のランクを「危険」,「注意」として区分してあります。 

 

 

取扱いを誤った場合に，危険な状況が起こりえて，死亡または重傷を受ける

可能性が想定される場合。 

 

取扱いを誤った場合に，危険な状況が起こりえて，中程度の傷害や軽傷を受

ける可能性が想定される場合および物的損害だけの発生が想定される場合。 

 

 

なお， 注意に記載した事項でも，状況によっては重大な結果に結びつく可能性があります。 

いずれも重要な内容を記載していますので必ず守ってください。 

 

本マニュアルは必要なときに読めるよう大切に保管すると共に，必ず最終ユーザまでお届けいただくよ

うお願いいたします。 

 

注意 

危険 
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改 定 履 歴 

※取扱説明書番号は，本説明書の裏表紙の左下に記載してあります。 

印刷日付 ※取扱説明書番号 改  定  内  容 

2005年 8月 SH(名)-080580-A 初版印刷 

2006年 3月 SH(名)-080580-B 
 
全面見直し 
 
追加 

1.2節，4.1.8項，6.2節 
 
削除 

6.3.5項，6.3.10項，6.3.11項，6.4.1項 
 
項番号変更 

4.1.8項→4.1.9項，6.2節→6.3節，6.3節→6.4節，6.4節→6.5節， 

6.4.2項→6.5.2項，6.4.3項→6.5.1項 

2006年 8月 SH(名)-080580-C 
 
修正 

5.1節，5.2節，6章～10章 
 
追加 

3章，4章，5.3節，8章 
 
削除 

3.5節，5.2節，6.3.5項，6.3.10項，6.3.11項，6.4.1項 
 
項番号変更 

1.1節～1.2節→1章，2.1節→2章，2.2節～2.4節→2.1節～2.3節， 

3.1節～3.2節→5章，3.3節～3.4節→5.1節～5.2節， 

3.6節～3.9節→5.4節～5.7節，4.1節→6章，4.2節→7章， 

5.1節→9章，6.1節～6.4節→10章，6.5節→11章 

  
 

 

本書によって，工業所有権その他の権利の実施に対する保証，または実施権を許諾するものではありません。また

本書の掲載内容の使用により起因する工業所有権上の諸問題については，当社は一切その責任を負うことができません。

© 2005 MITSUBISHI ELECTRIC CORPORATION 



A - 3                                          A - 3 

 

は  じ  め  に 

このたびは，三菱統合FAソフトウェアMELSOFTシリーズをお買い上げいただきまことにありがとうございま

した。 

ご使用前に本書をよくお読みいただき，MELSOFTシリーズの機能・性能を十分ご理解のうえ，正しくご使用

くださるようお願い致します。 
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第８章 I/O Mapping 8- 1～8- 3 

 

第９章 接続先設定 9- 1～9- 8 

 

第10章 Webベースオンラインアクセス機能 10- 1～10-26 

 

第11章 トラブルシューティング 11- 1～11- 4 

 

索  引 索引- 1～索引- 2 
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マニュアルについて 

本製品に関連するマニュアルには，下記のものがあります。 

必要に応じて本表を参考にしてご依頼ください。 

 

関連マニュアル  

 

マニュアル名称 
マニュアル番号 

(形名コード) 
標準価格

PROFIBUS-DPマスタユニットユーザーズマニュアル（詳細編） 

QJ71PB92Vの概要，システム構成，仕様，機能，運転までの手順，プログラミングおよび専用命

令について説明しています。 （別売） 

SH-080571 

(13JP81) 
\3,000

PROFIBUS-DPインタフェースユニットユーザーズマニュアル(詳細編) 

QJ71PB92Dの概要，システム構成，仕様，機能，運転までの手順，プログラミングおよび専用命

令について説明しています。 （別売） 

SH-080126 

(13JT23) 
\3,000

PROFIBUS-DPスレーブユニットユーザーズマニュアル(詳細編) 

QJ71PB93Dの概要，システム構成，仕様，機能，運転までの手順，プログラミングおよび専用命

令について説明しています。 （別売） 

SH-080317 

(13JT95) 
\3,000

AJ71PB92D，A1SJ71PB92D形PROFIBUS-DPインタフェースユニットユーザーズマニュアル 

AJ71PB92D，A1SJ71PB92Dの概要，システム構成，仕様，機能，運転までの手順，プログラミン

グおよび専用命令について説明します。 （別売） 

SH-3330 

（13JQ13） 
\600 

GX Configurator-DPオペレーティングマニュアル（CommDTM編） 

MELSOFT PROFIBUS CommDTMの概要，インストール方法，使用方法などについて説明しています。

 （別売） 

SH-080581 

(13JV86) 
\1,000

GX Configurator-ST Version1 オペレーティングマニュアル 

GX Configurator-STの操作方法，インテリジェント機能ユニットのパラメータ設定方法，

MELSEC-STシステムのモニタ方法について説明しています。 （別売） 

SH-080438 

(13JV79) 
\3,000

 
 

備考：下記マニュアルはソフトウェアパッケージとセットでCD-ROMに入っています。 

・GX Configurator-DP Version7 オペレーティングマニュアル 

・GX Configurator-DP オペレーティングマニュアル（CommDTM編） 

・GX Configurator-ST Version1 オペレーティングマニュアル 

単品でマニュアルを希望する場合は，印刷物を別売で用意していますので上記表のマニュアル番号（形

名コード）にてご用命願います。 
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本マニュアルで使用する総称・略称 

本マニュアルでは，特に明記する場合を除き，下記に示す総称・略称を使って 

GX Configurator-DPについて説明します。 

 

総称／略称 総称・略称の内容 

GX Configurator-DP 製品形名SW7D5C-PROFID-Eの総称製品名。 

QJ71PB92V 製品形名QJ71PB92V，PROFIBUS-DPマスタユニットの略称。 

QJ71PB92D 製品形名QJ71PB92D，PROFIBUS-DPインタフェースユニットの略称。 

QJ71PB93D 製品形名QJ71PB93D，PROFIBUS-DPスレーブユニットの略称。 

AJ71PB92D 製品形名AJ71PB92D，PROFIBUS-DPインタフェースユニットの略称。 

A1SJ71PB92D 製品形名A1SJ71PB92D，PROFIBUS-DPインタフェースユニットの略称。 

FX3U-64DP-M 製品形名FX3U-64DP-M，PROFIBUS-DPインタフェースブロックの略称。 

QJ71PB92□ QJ71PB92V，QJ71PB92Dの総称。 

PROFIBUS-DP PROFIBUS-DPネットワークの略称。 

マスタユニット QJ71PB92V，QJ71PB92D，AJ71PB92D，A1SJ71PB92D，FX3U-64DP-Mの総称。 

スレーブユニット QJ71PB93Dの総称。 

QCPU（Qモード） 
Q00JCPU，Q00CPU，Q01CPU，Q02CPU，Q02HCPU，Q06HCPU，Q12HCPU，Q25HCPU，Q12PHCPU，Q25PH CPU，

Q12PRHCPU，Q25PRHCPUの総称。 

QCPU QCPU（Qモード）の略称。 

QCPU（Aモード） Q02-ACPU，Q02H-ACPU，Q06H-ACPUの総称。 

QnACPU 
Q2ACPU，Q2AHCPU，Q2ASCPU，Q2ASHCPU，Q2A-S1CPU，Q2AH-S1CPU，Q2AS-S1CPU，Q2ASH-S1CPU，

Q3ACPU，Q4ACPU，Q4ARCPUの総称。 

AnNCPU A1NCPU，A2CCPU，A2NCPU，A3NCPUの総称。 

AnACPU A2ACPU，A2A-S1CPU，A3ACPUの総称。 

AnUCPU 
A2UCPU，A2U-S1CPU，A3UCPU，A2ASCPU，A2AS-S1CPU，A2AS-S30CPU，A2AS-S60CPU，A2USCPU，

A2US-S1CPU，A2US-S30CPU，A2US-S60CPU，A2USH-S1CPUの総称。 

AnSCPU A1SCPU，A1S-S1CPU，A2SCPU，A2S-S1CPUの総称。 

AnSHCPU A1SHCPU，A1SJHCPU，A2SHCPU，A2SH-S1CPUの総称。 

ACPU AnNCPU，AnACPU，AnUCPU，AnSCPU，AnSHCPUの総称。 

FXCPU FX3UCPUの総称。 

シーケンサCPU QCPU，QnACPU，ACPU，FXCPUの総称。 

Qシリーズ対応E71 QJ71E71-100，QJ71E71-B5，QJ71E71-B2，QJ71E71の総称。 

QE71 

AJ71QE71，AJ71QE71-B5，A1SJ71QE71-B2，A1SJ71QE71-B5，AJ71QE71N-T，A1SJ71QE71N-T，

AJ71QE71N-B5，A1SJ71QE71N-B5，AJ71QE71N-B2，A1SJ71QE71N-B2，AJ71QE71N-B5T，

A1SJ71QE71N-B5T，AJ71QE71N3-T，A1SJ71QE71N3-Tの総称。 

E71 

AJ71E71-S3，A1SJ71E71-B2-S3，A1SJ71E71-B5-S3，AJ71E71N-B2，AJ71E71N-B5T，A1SJ71E71N-B2，

A1SJ71E71N-B5T，AJ71E71N-T，A1SJ71E71N-T，AJ71E71N-B5，A1SJ71E71N-B5，AJ71E71N3-T，

A1SJ71E71N3-Tの総称。 

Ethernetユニット Qシリーズ対応E71，QE71，E71の総称。 

MELSECNET/H Q対応MELSECNET/Hの略称。 

MELSECNET/10 AnU対応，QnA/Q4AR対応MELSECNET/10の略称。 

GX Configurator-ST 製品形名SWnD5C-STPB-Eの製品形名。（n＝1以降） 

パソコン IBM PC/AT
R
パソコンおよび互換機のDOS/V対応パソコンの略称。（PC98-NX

R
を含む。） 
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用語の意味と内容 

本マニュアルで使用する用語の意味と内容について説明します。 

 

用  語 用語の意味 

クラス1 スレーブ局と入出力データを交信する機器です。（QJ71PB92V，QJ71PB92Dなど） 

マスタ局 
クラス2 

スレーブ局と交信し，局番設定，動作状態の確認を行う機器です。 

ネットワーク管理用マスタ局として使用し，立上げ，保守および診断を行うことができます。

スレーブ局 クラス1マスタ局と入出力データを交信する機器です。（QJ71PB93D，ST1H-PBなど） 

終端抵抗 PROFIBUS-DPの各セグメントの両端に接続する抵抗です。 

GSD(DDB)ファイル 
スレーブ局のパラメータが記載された電子ファイルです。 

GX Configurator-DPでスレーブパラメータを設定する場合に使用します。 

GSDデバイスデータベー

ス 

GSD(DDB)ファイルを登録して，ユニットの情報を一括管理するデータベースです。 

GX Configurator-DPでユニットを設定する場合に使用します。 

局  番 
マスタ局およびスレーブ局に割り付けられる番号です。 

0～125の範囲で設定します。 

バスパラメータ PROFIBUS-DPの通信設定を行うためのパラメータです。 

マスタパラメータ マスタユニットの設定（局番，伝送速度など）を行うためのパラメータです。 

スレーブパラメータ 
マスタ局で設定するスレーブ局のパラメータです。 

設定項目については，GSDファイルに記述されています。 

アイデントNo. 
PROFIBUS-DPに接続する各ユニット固有の番号です。 

各ユニットのGSD(DDB)ファイルに記述されています。 

 

 

製品構成 

GX Configurator-DPの製品構成を下記に示します。 

 

用  語 品  名 個  数 

GX Configurator-DP Version7            (CD-ROM
＊1

) 1 

ソフトウェア使用契約書
＊1

 1 

ソフトウェア登録証
＊1

 1 
SW7D5C-PROFID-E 

ライセンス許諾書
＊1

 1 
 
＊1 各書類はGX Configurator-STと共用となります。 
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第１章 概  要 

(1) はじめに 

本マニュアルは，GX Configurator-DPの仕様，機能，操作方法について説明した

ものです。 

GX Configurator-DPは，PROFIBUS-DPの構成を設定し，バスパラメータやスレーブ

パラメータなどを設定して，マスタ局に書込むために使用します。 

 

終端抵抗

GX Configurator-DP

マスタ局

スレーブ局スレーブ局スレーブ局

終端抵抗

RESET

RELEASE

PROFIBUS I/F

ST1H-PB R U N

A U X

E R R

S T 1P S D

S Y S

R U N E R R R U N E R R

 

図1-1 GX Configurator-DPの使用例 
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(2) 問題発生時の対処方法 

GX Configurator-DPの使用方法や動作結果などで問題が発生した場合は，下記の

ように処置してください。 

 

問題発生

下記を参照してください。
・マニュアル
・GX Configurator-DPのヘルプ
　（5.7節参照）

最寄りの支社または代理店に症状を説
明，ご相談ください。

問題は解決か？

いいえ

はい

完　　了

 

 
図1-2 問題の処置方法 
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第２章 インストール 

(1) インストールの前に 

 

(a) 著作権 
 

重  要  

このソフトウェアは著作権で保護されています。 

この販売されたディスクパッケージを操作されることにより自動的にこのライセ

ンス契約の条件に承諾されたことになります。 

オリジナル・ディスクのコピーは，ユーザ自身のバックアップおよび保管用として

1枚だけ複写することが許されています。 

 

(b) ソフトウェアの用途 

GX Configurator-DPは，下記ユニットの設定を行うソフトウェアです。 
 

表2-1 GX Configurator-DPの対応ユニット 

ユニット分類 ユニット形名 

マスタユニット 

QJ71PB92V， 

QJ71PB92D， 

AJ71PB92D＊1， 

A1SJ71PB92D＊1， 

FX3U-64DP-M 

スレーブユニット QJ71PB93D 
 

＊1 A(1S)J71PB92Dには，下記制約事項があります。  
 

表2-2 A(1S)J71PB92Dの制約事項 

ユニット形名
ソフトウェア

バージョン 
制約事項 

AJ71PB92D A 

A1SJ71PB92D E以前 

GX Configurator-DP Version 7は，CPUユニッ

ト経由でA(1S)J71PB92Dと接続できません。

この場合は，最寄りの支社または代理店に

症状を説明，ご相談ください。 
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(c) 特長 

GX Configurator-DPの特長を下記に示します。 

 

① グラフィカルネットワークエディタ 

グラフィカルネットワークエディタでは，PROFIBUS-DPを構成する各ユ

ニットやケーブルを図で表示します。 

このため，ネットワーク構成の編集やパラメータの設定操作を容易に行う

ことができます。 
 

 

図2-1 グラフィカルネットワークエディタ 

 

② 各パラメータのチェック 

各パラメータをチェックすることで，各パラメータの間違いによる誤動作

を減らすことができます。 

 

③ 各パラメータのダウンロード／照合 

各パラメータを，マスタユニットまたはスレーブユニットへダウンロード

できます。 

また，GX Configurator-DPで編集中の各パラメータと，マスタユニットに

ダウンロードした各パラメータを照合できます。 

 

④ プロジェクトファイルの流用 

GSDデバイスデータベースの情報をプロジェクトファイル内に保存できま

す。 

このため，プロジェクトファイルのみをコピーするだけで，他のパソコン

で同じPROFIBUS-DPの設定ができます。 

プロジェクトファイルと一緒に，GSD(DDB)ファイルをコピーする必要はあ

りません。 

 

⑤ パラメータの印刷 

各パラメータの一覧を印刷できます。 
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2.1 システム要求条件 

本節では，GX Configurator-DPをインストールして使用する場合に必要な，システ

ムの条件を説明します。 

 

(1) 動作環境 

GX Configurator-DPの動作環境を下記に示します。 

 

表2-3 動作環境 

項  目 内  容 

コンピュータ本体 

 CPU 

 必要メモリ 

下表の「使用する基本ソフトウェアとパソコン本体に必要な性能」を参照。 

ハードディスク空き容量 200Mバイト以上 

ディスクドライブ CD-ROMドライブ必須 

ディスプレイ 
サイズ：17型以上 

解像度：1024×768ピクセル以上 

通信用インタフェース RS-232ポートまたはUSBポート 

基本ソフトウェア（OS） GX Configurator-DPを使用できるOSについては，本節(2)を参照。 
 
 

表2-4 使用する基本ソフトウェアとパソコン本体に必要な性能 

パソコン本体に必要な性能 
基本ソフトウェア 

CPU 必要メモリ 

Microsoft R Windows R 98 Operating System PentiumⅡ R 350MHz以上 32MB以上 

Microsoft R Windows R Millennium Edition Operating System PentiumⅡ R 350MHz以上 32MB以上 

Microsoft R WindowsNT R Workstation Operating System Version4.0 PentiumⅡ R 350MHz以上 64MB以上 

Microsoft R Windows R 2000 Professional Operating System PentiumⅡ R 350MHz以上 64MB以上 

Microsoft R Windows R XP Professional Operating System PentiumⅡ R 350MHz以上 128MB以上 

Microsoft R Windows R XP Home Edition Operating System PentiumⅡ R 350MHz以上 128MB以上 
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(2) ソフトウェア要求条件 

GX Configurator-DPを実行できる基本ソフトウェア（OS）を下記に示します。 

 

(a) Microsoft R Windows R 98 Operating System（英語版） 

・Microsoft R Internet Explorer 5.5以降のインストールが必要です。 

 

(b) Windows R Meillennium Edition Operating System（英語版） 

・Microsoft R Internet Explorer 5.5以降のインストールが必要です。 

 

(c) Microsoft R WindowsNT R Workstation Operating System Version4.0（英語版） 

・Service Pack 6以降のインストールが必要です。 

・Microsoft R Internet Explorer 5.5以降のインストールが必要です。 

 

(d) Microsoft R Windows R 2000 Professional Operating System（英語版） 

・Service Pack 2以降のインストールが必要です。 

・Microsoft R Internet Explorer 5.5以降のインストールが必要です。 

 

(e) Microsoft R Windows R XP Professional Operating System（英語版） 

 

(f) Microsoft R Windows R XP Home Edition Operating System（英語版） 

 

ポイント  

・Windows R 2000またはWindows R XPのご使用を推奨します。 

・Windows R XPの新機能について 

Microsoft R Windows R XP Professional Operating System， 

Microsoft R Windows R XP Home Edition Operating Systemをご使用の場合は，下記

に示す新機能が使用できません。 

下記に示す新機能を使用した場合，本製品は正常に動作しない可能性があります。
 

Windows R 互換モードでのアプリケーション起動 

ユーザ簡易切替え 

リモートデスクトップ 

大きいフォント（画面プロパティの詳細設定） 
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(3) 接続ケーブル 

(a) ACPU/QnACPU/FXCPUへの接続 

パソコンとCPUユニットの接続設定は，GX Configurator-DPで行います。 
 

(a-1) USBケーブルについて（FXCPU対応） 

FXCPUと接続する場合のUSBケーブル，機能拡張ボード，変換ユニットを下

記に示します。 
 

① 変換ユニットを使用する場合 

・システム構成 

  FX-USB-AW       USBケーブル（同梱） 
 

 MI
TS
UB
IS
HI

FX
-U
SB
-A
W

PW SD RD

FX
(R
S-
42
2)

B

 
 

・Windows R 98, Windows R Me, Windows R 2000 Professional, Windows R XP 

ProfessionalおよびWindows R XP Home Editionを使用時，FX-USB-AWま

たは，FX3U-USB-BDに同梱しているCD-ROMのドライバがインストールされ

ている場合に使用できます。 

・Windows NT R Workstation 4.0の場合は，使用できません。 

・FX-USB-AW使用時の注意事項，制約事項については，FX-USB-AWに同梱し

ているマニュアルを参照してください。 
 

② USB通信用機能拡張ボードを使用する場合 

・システム構成 

  FX3U-USB-BD      USBケーブル（同梱） 
 

     
 

・Windows R 98, Windows R Me, Windows R 2000 Professional, Windows R XP 

ProfessionalおよびWindows R XP Home Editionを使用時，FX-USB-AWま

たは，FX3U-USB-BDに同梱しているCD-ROMのドライバが，インストールさ

れている場合に使用できます。 

・Windows NT R Workstation 4.0の場合は，使用できません。 

・FX3U-USB-BD使用時の注意事項，制約事項については，FX3U-USB-BDに同

梱しているマニュアルを参照してください。 
 

③ RS-422通信用機能拡張ボードを使用する場合 

FX3U-422-BDを使用する場合は，下記の接続方法に加えてFX3U-422-BDを接

続してください。 

・ USBケーブルと変換ユニットを使用した接続方法。（本項(a-1)①参照） 

・ RS-422ケーブル，RS-232ケーブル，変換器を使用した接続方法。 

（本項(a-2)①参照） 
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(a-2) RS-422 ケ ー ブ ル と RS-232 ケ ー ブ ル と 変 換 器 な ど に つ い て

（ACPU/QnACPU/FXCPU対応） 

ACPU, QnACPU, FXCPUと接続する場合のRS-422ケーブル，変換器を下記に示

します。 
 

① 三菱電機製を使用する場合 
 

パソコン側（RS-232ケーブル） 
RS-232/RS-422 

変換器 
シーケンサCPU側（RS-422ケーブル） 

 

 

F2-232CAB 
（Dサブ25ピン Dサブ25ピン） 

（NEC PC-9800 R ,DOS/Vパソコンに使用する場合

 は，Dサブ9ピン Dサブ25ピンストレート変換

 ケーブルが必要です｡） 

ACPU，QnACPUの場合 

FX-422CAB (0.3m) 

FX-422CAB-150 (1.5m)  

 

F2-232CAB-1 

（Dサブ9ピン Dサブ25ピン） 
 

 

F2-232CAB-2 

（ハーフピッチ Dサブ25ピン） 

FX3UCPUの場合 

FX-422CAB0 (1.5m) 

 
 

AC30N2A(25ピン―25ピン) 
（NEC PC-9800 R ,DOS/Vパソコンに使用する場合

 は，Dサブ9ピン Dサブ25ピンストレート変換

 ケーブルが必要です｡） 

 

FX-232AW 

 

 

FX-232AWC 

 

 
FX-232AWC-H 

(FXシリーズのみ) 

 

 

・ F2-232CAB,F2-232CAB-1ケーブルのACPU, QnACPU対応製品見分け方 

ケーブルに付いている形名ラベルの表示方法で確認してください。 
 

 

F2-232CAB
Y990C*****

F2-232CAB-1
Y990C*****

F2-232CAB(F/FX/A)
  Y990C*****

F2-232CAB-1(F/FX/A)
  Y990C*****

未対応品 対応品（(F/FX/A)の記述あり）

 
 

・ FX3U/FX3UCにFX-232AWC-Hを用いて接続した場合は，伝送速度9.6kbps, 

19.2kbps,38.4kbps,57.6kbps,115.2kbpsをご使用できます。 

FX-232AWC,FX-232AWで接続した場合は，伝送速度9.6kbps,19.2kbpsどち

らかを選択してください。 

・FXシリーズに接続する場合には，必ず上表に示す機器をご使用ください。 

・ RS-422通信用機能拡張ボードを使用する場合は，本項(a-1)③を参照し

てください。 
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② ダイヤトレンド製を使用する場合(紹介品) 
 

・ ダイヤトレンド株式会社 

〒542-0081 大阪府大阪市中央区南船場2-2-14 

TEL(06)4705-2100 FAX(06)4705-2101 
 

RS-232/RS-422変換ケーブル 

ACPU
QnACPU 

DAFXIH-CAB*1 

（PC9800用 Dサブ25ピン Dサブ25ピン） 

ACPU
QnACPU 

DAFXIH-CABV 

（DOS/V用 Dサブ9ピン Dサブ25ピン） 

ACPU
QnACPU

 

DAFXIH-CABL 

（PC9800用 ハーフピッチ Dサブ25ピン） 

 

ACPU
QnACPU 

DCNV9F-RS42R 

（DOS/V用 Dサブ9ピン Dサブ25ピン） 

ACPU
QnACPU 

DCNV25M-RS42R 

（PC9800用 Dサブ25ピン Dサブ25ピン） 

 
 

 
ACPU
QnACPU 

 
DCR4-003（RS-422ケーブル） 

 
＊1： DOS/Vパソコン，PC98-NX R シリーズ（Dサブ9pin）の場合に，DAFXIH-CABケーブルを使用するときは，D232V-CAB

が必要です。 

また，PC-9800 R シリーズノート（ハーフピッチ）の場合には，DAC01R2Lが必要です。 

 

DCNV9F-RS42RによるDOS/Vパソコン ←→ QnACPU間の接続例 

 
DOS/Vパソコン QnACPUDCNV9F-RS42R

＊1

＊2

DCR4-003 ＊3

 

 
＊1： 上図に示すDOS/Vパソコン ←→ A/QnACPU接続用変換ケーブル 

DCNV9F-RS42R（Dサブ9ピン ←→ Dサブ25ピン） 

＊2： DCNV9F-RS42Rをご使用になる場合には，必ずシーケンサシステムのFGを接地してください。 

＊3： DCR4-003（Dサブ25ピン ←→ Dサブ25ピン）のケーブル長は，3m以内で使用してください。 
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DCNV25M-RS42RによるPC9800 ←→ QnACPU間の接続例 

 
PC9800 QnACPUDCNV25M-RS42R

＊1

＊2

DCR4-003 ＊3

 

 
＊1： PC本体のRS-232コネクタの形状により，ハーフピッチ ←→ Dサブ25ピンのストレート変換ケーブル（コネ

クタ）が別途必要になる場合があります。 

ご使用のPC9800取扱説明書の指示に従い，必要に応じて変換ケーブルをご用意ください。 

（上図に示すPC9800 ←→ 三菱シーケンサA/QnACPU接続用変換ケーブル） 

DCNV25M-RS42R（Dサブ25ピン ←→ Dサブ25ピン） 

＊2： DCNV25M-RS42Rをご使用になる場合には，必ずシーケンサシステムのFGを接地してください。 

＊3： DCR4-003（Dサブ25ピン ←→ Dサブ25ピン）のケーブル長は，3m以内で使用してください。 
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③ エル・エンジニアリング製を使用する場合 
 

・ 有限会社エル・エンジニアリング 

〒454-0805 愛知県名古屋市中川区船戸町7番16号 

TEL(052)361-2290 FAX(052)363-1050 
 

・EL-LINE-Ⅱ（ケーブルユーザ作成） 
 

EL-LINE-ⅡによるDOS/Vパソコン ←→ QnACPU間の接続例 
 

23

2

4

6

8

5

2

3

4

1

5

20

6

8
7

15

3

16

4

17

5

18

7

20

21

2

15

6

19

3

16

7

20

1または14

TXD

FGDOS/V

RS232信号

SW1 SW2

RS422信号

FG

QnACPU

RXD(+)

RXD(-)

TXD(+)

TXD(-)

DSR(+)

DSR(-)

DTR(+)

DTR(-)

SG

TX
RXD

TXD

DTR

RXD

DSR

RTS

CTS

CTS

SG

DTR

DSR

CD

SG

1 OFF

2 OFF

3 OFF

4 OFF

5 OFF

6 OFF

7 OFF

1 OFF

2 ON

3 OFF

4

5 OFF

6

7 OFF

8

ON

ON

ON

SG

SG

RX

RTS

CTS

SG

EL-LINE-Ⅱ

RS-232/RS-422変換器

QnACPU側に接続するコネクタは，DDK製17JE-23250-02相当品を使用してください。

 

 
EL-LINE-ⅡによるPC9800 ←→ QnACPU間の接続例 

22

3

20

5

6

7

1
2

3

4

1

5

20

6

8
7

15

3

16

4

17

5

18

7

20

21

2

15

6

19

3

16

7

20

1または14

FG FG

PC9800 RS232信号

SW1 SW2

RS422信号

FG

QnACPU

RXD(+)

RXD(-)

TXD(+)

TXD(-)

DSR(+)

DSR(-)

DTR(+)

DTR(-)

SG

TXTXD TXD

RXD RXD

DTR RTS

CTS CTS

DSR DTR

GND DSR

CD

SG

1 OFF

2 OFF

3 OFF

4 OFF

5 OFF

6 OFF

7 OFF

1 OFF

2 ON

3 OFF

4

5 OFF

6

7 OFF

8

ON

ON

ON

SG

SG

RX

RTS

CTS

SG

EL-LINE-Ⅱ

RS-232/RS-422変換器

QnACPU側に接続するコネクタは，DDK製17JE-23250-02相当品を使用してください。
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④ KS-10P-HS,KS-1-HS（システムサコム製）を使用する場合 
 

株式会社システムサコム販売 

〒103-0002 東京都中央区日本橋馬喰1-6-6 

TEL(03)5623-5933  FAX(03)3660-0891 
 

・KS-10P-HS, KS-1-HS 

KS-10P-HS, KS-1-HSによるDOS/Vパソコン ←→ QnACPU間の接続例 

2

15

3

16

4

17

5

18

7

20

21

19

25

15

17

14

16

21

23

FGDOS/V

RS232信号

SW1

RS422信号

FG

QnACPU

RXD(+)

SG

(+)
DATA
OUT
(-)

1 ON

2 ON

3 ON

4

5 OFF

6

7 ON

8

OFF

OFF

ON

SG

SG

KS-10P-HS，KS-1-HS

RS-232/RS-422変換器

FG

(+)
DATA
IN
(-)
(+)
CONT
OUT
(-)
(+)
CONT
IN
(-)

SG

1

RXD(-)

TXD(+)

TXD(-)

DSR(+)

DSR(-)

DTR(+)

DTR(-)

1

7

OPEN

SW2

上(ON)

TXD

RXD

RTS

CTS

CD

SG

TXD

RXD

DTR

DSR

CTS

GND

3

2

4

6

8

5

1

2

3

4

5

6

7

CBL11MH CBL45M

＊4

＊1 ＊3

＊2

 

＊1： 上図に示すDOS/Vパソコン←→変換器接続用RS-232ケーブル 

CBL11MH（Dサブ9ピン ←→ Dサブ25ピン） 

＊2： KS-10P-HSをご使用になる場合には，必ずシーケンサシステムのFGを接地してください。 

＊3： CBL45Mのケーブル長は，3m以内で使用してください。 

＊4： KS-1-HSの場合，DIPスイッチSW1-4はONにします。 

 
KS-10P-HS, KS-1-HSによるPC-9800シリーズ ←→ QnACPU間の接続例 

1

2

15

3

16

4

17

5

18

7

20

21

19

25

15

17

14

16

21

23

FG FG

PC9800 RS232信号

SW1

RS422信号

FG

QnACPU

RXD(+)

SG

(+)
DATA
OUT
(-)

1 ON

2 ON

3 ON

4

5 OFF

6

7 ON

8

OFF

OFF

ON

SG

SG

KS-10P-HS，KS-1-HS

RS-232/RS-422変換器

FG

(+)
DATA
IN
(-)
(+)
CONT
OUT
(-)
(+)
CONT
IN
(-)

SG

1

RXD(-)

TXD(+)

TXD(-)

DSR(+)

DSR(-)

DTR(+)

DTR(-)

1

7

20

21

OPENOPEN

SW2

上(ON)

RD

SD

CS

RS

CD

SG

TXD

RXD

DTR

CTS

DSR

GND

2

3

20

5

6

7

1

2

3

4

5

6

7

CBL11MA CBL45M

＊4

＊1 ＊3

＊2

 

＊1： PC9800本体のRS-232コネクタの形状により，ハーフピッチ ←→ Dサブ25Pのストレート変換ケーブル（コ

ネクタ）が別途必要になる場合があります。 

ご使用のPC9800取扱説明書の指示に従い，必要に応じて変換ケーブルをご用意ください。 

（上図に示すPC9800 ←→ 変換器接続用RS-232ケーブル） 

CBL11MA（Dサブ25ピン ←→ Dサブ25ピン） 

＊2： KS-10P-HSをご使用になる場合には，必ずシーケンサシステムのFGを接地してください。 

＊3： CBL45Mのケーブル長は，3m以内で使用してください。 

＊4： KS-1-HSの場合，DIPスイッチSW1-4はONにします。 
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(a-3) RS-232ケーブルと変換ユニットなどについて 
 

パソコンのシリアル 

ポートの形状 
シリーズ 必要になる機能拡張ボードおよび特殊アダプタ RS-232ケーブル 

FX3U-232-BD 
Dサブ9ピン FX3U 

機能拡張ボード(FX3U-***-BD)＋FX3U-232ADP 
FX-232CAB-1 

FX3U-232-BD 
ハーフピッチ14ピン FX3U 

機能拡張ボード(FX3U-***-BD)＋FX3U-232ADP 
FX-232CAB-2 

FX3U-232-BD 
Dサブ25ピン FX3U 

機能拡張ボード(FX3U-***-BD)＋FX3U-232ADP 
F2-232CAB-1 

 
機能拡張ボード(FX3U-***-BD)の***には，232,485,422,USB,CNVが入ります。 

 

ポイント  

・RS-422インタフェース変換ケーブル・変換器は，仕様や注意事項などについて各

製品のマニュアルをよくお読みいただき，正しい取り扱いをしていただきますよ

うお願いいたします。 

・RS-422インタフェースからDC5V電源を受電する変換ケーブル・変換器を抜き差し

する場合は，シーケンサCPUユニット側の電源をOFFしてから操作するようにして

ください。 

・RS-422インタフェースからDC5V電源を受電しない（外部電源より受給する）周辺

機器，および変換ケーブルを抜き差しする場合も，作業前には必ずアースバンド

もしくは接地された金属などに触れて，ケーブルや人体などに帯電している静電

気を放電し，その後に下記操作手順にてお取り扱い願います。 

① パソコン側の電源をOFFする。 

② 変換ケーブル・変換器の電源をOFFする。FG端子がある場合は接地する。 

③ パソコンとシーケンサ間の変換ケーブル・変換器を抜き差しする。 

④ 変換ケーブル・変換器の電源をONする。 

⑤ パソコンの電源をONする。 

⑥ ソフトウェアパッケージを立ち上げる。 
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(b) QCPUへの接続 

パソコンとCPUユニットの接続設定は，GX Configurator-DPで行います。 
 

(b-1) USBケーブルについて(QCPU(Qモード)対応) 

・ Windows R 98, Windows R Me, Windows R 2000 Professional, Windows R XP 

ProfessionalおよびWindows R XP Home Editionを使用時，USBのドライバ

がインストールされている場合に使用できます。 

・ Windows R 95, Windows NT R Workstation 4.0の場合は，使用できません。 

・ USBケーブル使用時は，1台のシーケンサCPUのみ接続できます。 

下記に利用できない構成を示します。 
 

・USBハブを介して複数のQCPU(Qモード)への接続

・複数USBポート搭載パソコンから，複数のQCPU(Qモード)への接続

QCPU(Qモード)

USBケーブル

USBケーブル

USBケーブル

USBハブ
USBケーブル

USB
ケーブル

＜利用できない構成＞

QCPU(Qモード)

QCPU(Qモード)

QCPU(Qモード)

 

 

・ 弊社で動作確認したUSBケーブルを下記に示します。 
 

形  名 メーカ名 

USB2-30 エレコム株式会社 

AU2-30 株式会社アーベル 

 

ポイント  

・ パソコンのレジューム機能・サスペンド設定・省電力機能・スタンバイモードを

設定してシーケンサCPUと交信すると交信エラーが発生することがあります。 

そのためシーケンサCPUと交信する場合は，本機能の設定を行わないでください。

・ パソコンの機種，USBケーブルなどの組み合わせによっては，通信エラーが発生す

る場合があります。その場合は，メッセージを参考に再度操作してください。 

 

・ USB通信の処理時間 

パソコン(NEC Mate NX MA35D Pentium R Ⅱ(350) Win98)でプログラム容

量26658ステップ（約26k）をPC書込した場合，12秒で書込み完了します。 
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(b-2) 変換器／ケーブルについて（QCPU(Qモード)，QCPU(Aモード)対応） 

115.2/57.6kbpsで通信する場合 

使用するパソコンが，115.2/57.6kbpsの通信速度に対応していないと高速

通信できません。 

通信エラーが発生した場合は，伝送速度の設定をさげて再度通信を行って

ください。 

弊社で動作確認したケーブル／変換器を下記に示します。 
 

・三菱電機製を使用する場合 
 

RS-232ケーブル 

 
 

 
QC30R2（パソコンのコネクタがDサブ9ピン） 
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2.2 プロジェクトファイルの互換性 

GX Configurator-DP Version7は，下表に示すソフトウェアで保存したプロジェクト

ファイルを開くことができます。 

下表以外のソフトウェアで保存したプロジェクトファイルは，開くことができませ

ん。 

 

表2-5 プロジェクトファイルの互換性 

プロジェクトファイルの種類 保存したソフトウェア 

*.dp2 
MELSEC ProfiMap Version3 

GX Configurator-DP Version4～7 

*.dpx GX Configurator-DP Version5～7 
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2.3 ソフトウェアのインストール 

(1) GX Configurator-DPインストール時の注意事項 

GX Configurator-DPのインストールに関する注意事項を下記に示します。 

 

(a) インストールを行う前に，Windows R で動作している他のアプリケーションを

すべて終了させてください。 

 

(b) 下記OSにインストールする場合は，Administrator（コンピュータ管理者）の

属性を持つユーザとしてログオンしてください。 

・Microsoft R Windows NT R Workstation Operating System Version4.0 

・Microsoft R Windows R 2000 Professional Operating System 

・Microsoft R Windows R XP Professional Operating System 

・Microsoft R Windows R XP Home Edition Operating System 

 

(c) Version6 以前のGX Configurator-DPがインストールされている場合の注意事

項 
 

(c-1) Version6 以前のGX Configurator-DPをアンインストールしても良い場合 

Version6 以前のGX Configurator-DPをアンインストールしてから，

Version7 をインストールしてください。 
 

(c-2) Version6 以前とVersion7の両方のGX Configurator-DPを使用する場合 

・インストールについて 

Version6 以前のGX Configurator-DPとは別のフォルダおよびプログラム

フォルダに，Version7 をインストールしてください。 

Version6 以前のGX Configurator-DPと同じフォルダまたはプログラム

フォルダにインストールすると，両者とも正常に動作しなくなる場合が

あります。 

この場合は，Version6以前とVersion7の両方のGX Configurator-DPを，

アンインストールしてください。 

 

・アンインストールについて 

Version6 以前のGX Configurator-DPをアンインストールする場合は，

Version7 のGX Configurator-DPもアンインストールしてください。 

Version6 以前のGX Configurator-DPのみをアンインストールすると，

Version7 のGX Configurator-DPが正常に動作しなくなる場合があります。 
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(2) GX Configurator-DP/GX Configurator-STのインストール 

インストールは下記の手順で行ってください。 

 

① Windows R を起動してください。 

② CD-ROMをCD-ROMドライブに挿入してください。 

③ スタートメニューから[Programs（＊1）]→[Run]をクリックします。 
 

＊1 下記OS使用時は，[All Programs]と表示されます。 

・Microsoft R Windows R XP Professional Operating System 

・Microsoft R Windows R XP Home Edition Operating System 
 

④ “d:\GXConfiguratorDP\setup.exe”と入力してください。 

（“d:”についてはCD-ROMドライブのドライブ文字を入力してください。） 

⑤ ソフトウェア使用契約画面が表示されますので，そこに書かれている条件を

よくお読みください。 

 

図2-2 ソフトウェア使用契約画面 

⑥ インストールを続けたい場合には，“Yes”をクリックしてライセンス契約に

同意します。インストールを中断する場合は“No”をクリックしてください。 

次にユーザ情報画面が表示されますので，氏名(User Name)，会社名(Company 

Name)および製品のプロダクトID(Serial Number)（＊2）を入力してください。 

 ＊2 プロダクトIDは，ライセンス許諾書を参照して入力してください。 
 

 

図2-3 ユーザ情報画面 
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⑦ “Next>”をクリックすると，確認のダイアログボックスが表示されますので，

登録情報をチェックすることができます。 

“Yes”をクリックしてインストールを続けます。 

 

図2-4 ユーザ情報の確認 

⑧ インストールパスを入力してくださいと表示されますので，GX 

Configurator-DPソフトウェアのインストール先フォルダを入力します。 

（デフォルトはC:\Melsec\GX Configurator-DP） 

 

図2-5 インストール先フォルダの確認 

⑨ デフォルト設定に同意する場合は，“Next>”をクリックします。変更する場

合は，“Browse”をクリックして，変更先ドライブとディレクトリを入力し

ます。 

 

図2-6 インストール先フォルダの設定 

⑩ インストールしたいプログラムフォルダを選択します。 

新たなフォルダ名を入力するか表示されたものを選択して“Next>”をクリッ

クすると，インストールが開始されます。 
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⑪ 下記の3種類のセットアップ方法があります。 

・Typical ：GX Configurator-DPとGX Configurator-STのインストール 

（デフォルト設定） 

・Compact ：GX Configurator-DPのみのインストール 

・Custom ：GX Configurator-STをインストールするかどうかを選択できます。 
 

 

図2-7 セットアップ方法の選択 

⑫ インストールが開始されます。 

インストールの進行状況が下記のように表示されます。 
 

 

図2-8 インストールの進行状況 
 

⑬ インストールされたら，完了のメッセージが表示されます。 

 

(3) ボタンの機能 

表2-6 インストール時に使用するボタンの機能 

ボタン 機能内容 

 次の画面に進みます。 

 前の画面に戻ります。 

 インストールを中止します。 
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第３章 システムの説明 

(1) システムの概要 

GX Configurator-DPは，PROFIBUS-DPマスタユニット／スレーブユニット／インタ

フェースユニット専用の，コンフィグレーションソフトです。 

 

(a) 設定とダウンロード 

PROFIBUS-DPの構成やパラメータを設定し，三菱電機製シーケンサのネット

ワークを介して，各ユニットへ設定内容をダウンロードする機能を備えてい

ます。 

 

RESET

RELEASE

PROFIBUS I/F

ST1 H-PB R U N

A U X

E R R

S T 1 P S D

S Y S

R U N E R R R U N E R R

RS-232，USB，
Ethernet，MELSECNET/Hなど

MELSECNET/Hなど

終端抵抗

終端抵抗

マスタ局

スレーブ局スレーブ局スレーブ局

GX Configurator-DP

設定内容をダウンロード

 

図3-1 設定内容のダウンロードイメージ図 

 

 

 

 

 

3 
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(b) Webを使用したアクセス 

遠隔地からアクセスするための，Webサーバの機能を備えています。 

 

終端抵抗

サーバ＊1 

マスタ局

スレーブ局スレーブ局スレーブ局

終端抵抗

RESET

RELEASE

PROFIBUS I/F

ST1H-PB R U N

A U X

E R R

S T 1P S D

S Y S

R U N E R R R U N E R R

イントラネットまたは
インターネット

クライアント（Webブラウザ）＊1

＊1 サーバのパソコンのWebブラウザを，クライアントとして使用することもできます。

 

図3-2 Webサーバの機能イメージ図 

 

 

 

 

 

3 
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(2) システム構築の概要 

① GX Configurator-DPで，スレーブユニット固有の情報を，スレーブユニッ

トのメーカが提供するGSDファイルから取得します。 

② GX Configurator-DPで，PROFIBUS-DPの構成やパラメータを設定し，マス

タユニットへプロジェクトをダウンロードします。 

③ GX IEC Developerで使用するために，POUや自動リフレッシュパラメータ

をエクスポートします。 

④ エクスポートしたPOUを使って，GX IEC Developerでプログラミングし，

シーケンサCPUへプログラムをダウンロードします。 

 

①

スレーブユニットの
メーカが提供する
GSDファイル

POUおよび
自動リフレッシュ
パラメータ

③

マスタユニット

GX Configurator-DP

プロジェクトを
ダウンロード

②

②

GX IEC Developer

プログラムを
ダウンロード

④

④

 

図3-3 システム構築の概要 
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第４章 運転までの手順と設定 

本章では，QJ71PB92Vを例にして，運転までの概略手順を説明します。 

 

表4.1 概略手順 

手  順 参照項 

GX Configurator-DPの起動 本項(1)

GSDファイルの追加 本項(2)

新規プロジェクトの作成 本項(3)

スレーブ局の追加 本項(4)

スレーブ局に装着されたユニットの選択と，ユーザパラメータの設定 本項(5)

CPUユニットへの接続方法を設定 本項(6)

プロジェクトをマスタユニットにダウンロード 本項(7)

POUを作成 本項(8)

GX IEC DeveloperでPOUをインポート 本項(9)

 

(1) GX Configurator-DPの起動 

① スタートメニューから[Programs（＊1）]→[MELSOFT Application]→[GX 

Configurator-DP] → [GX Configurator-DP] （ ＊ 2 ） をクリックし，GX 

Configurator-DPを起動します。 

 

＊1 下記OS使用時は，[All Programs]と表示されます。 

・Microsoft Windows XP Professional Operating System 

・Microsoft Windows XP Home Edition Operating System 

＊2 GX Configurator-DPのアイコンを，プログラムフォルダの“MELSOFT 

Application\GX Configurator-DP”にインストールした場合です。 

 

 

 

 

 

 

 

 

 4 
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(2) GSDファイルの追加 

① [Setup]→[GSD Device-Database]メニュー（ ）をクリックし，“Device 

Database”ダイアログボックスを表示させます。 

 

 

②  Add ボタンをクリックします。 

 

③  Open ボタンをクリックし，GSDデバイスデータベースにスレーブ局を追

加します。 

 

 

(3) 新規プロジェクトの作成 

① [File]→[New]メニュー（ ）をクリックし， 

 

② 設定するマスタユニットを選択し， OK ボタンをクリックします。 

  

 

 

 

 

 

 

 

 4 
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③ グラフィカルネットワークエディタが起動し，②選択したマスタユニット

の新規プロジェクトが表示されます。 

 

 

(4) スレーブ局の追加 

① グラフィカルネットワークエディタのケーブルの図上で右クリックし，

[Insert DP-Slave]メニューを選択して，“Device Database”ダイアログ

ボックスを表示させます。 

 

② PROFIBUS-DPに追加するスレーブ局を選択します。 

 

③  OK ボタンをクリックし，“Slave Parameter Settings”ダイアログボッ

クスを表示させます。 
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(5) スレーブ局に装着されたユニットの選択と，ユーザパラメータの設定 

① “Slave Parameter Settings”ダイアログボックスで Select Modules ボ

タンをクリックし，“Slave Modules”ダイアログボックスを表示させま

す。 

“Slave Parameter Settings”ダイアログボックスを閉じた後に再度開く

ときは，グラフィカルネットワークエディタのスレーブ局の図上で右ク

リックし，[Modify Settings]メニューを選択します。 

  

② スレーブ局に装着されているユニットを“Available Modules”から選択

し， Add before ／ Add after ボタンをクリックして，“Installed 

Module”へ追加します。 

“Installed Module”のユニットの表示順序は，設定対象のユニットの装

着順序に合わせてください。 

“Installed Module”からユニットを削除する場合は，削除するユニット

を選択して Remove ボタンをクリックしてください。 
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(6) CPUユニットへの接続方法を設定 

① [Online]→[Transfer Setup]メニュー（ ）をクリックし，“Transfer 

Setup List”ダイアログボックスを表示させます。 

“Transfer Setup List”ダイアログボックスでは，新規に接続方法を設

定したり，設定済みの接続方法を変更したりできます。 

“Transfer Setup List”ダイアログボックスの詳細は，9章を参照してく

ださい。 

 

 

(7) プロジェクトをマスタユニットにダウンロード 

① [Online]→[Transfer]→[Download to Module]メニューを選択し，プロ

ジェクトをマスタユニットへダウンロードします。 

 

 

(8) POUを作成 

GX IEC Developerのプログラムで，PROFIBUS-DPの交信データ（入出力データ）を

扱う場合に，POUを作成します。 

① [File]→[Export]→[POU for GX IEC Developer]メニューを選択し，

“Select the POU file”ダイアログボックスを表示させます。 

 

② POUを保存するフォルダおよびファイル名を設定して保存します。 
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(9) GX IEC DeveloperでPOUをインポート 

① GX IEC Developerを起動し，マスタユニットにアクセスするCPUユニット

のプロジェクトを開きます。 

② GX Configurator-DPで作成したPOUをインポートします。 

 

（GX IEC Developerの場合） 
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第５章 メニュー 

(1) GX Configurator-DPの起動 

GX Configurator-DPを起動するときは，スタートメニューから[Programs]→ 

[MELSOFT Application]→[GX Configurator-DP]→[GX Configurator-DP]（＊1）

をクリックします。 

備  考 

下記のOS使用時は，スタートメニューから[All Programs]→[MELSOFT Application]

→[GX Configurator-DP]→[GX Configurator-DP]（＊1）をクリックします。 
 

・Microsoft R Windows R XP Professional Operating System 

・Microsoft R Windows R XP Home Edition Operating System 

 
 

＊1 GX Configurator-DPのアイコンを，プログラムフォルダの“MELSOFT 

Application\GX Configurator-DP”にインストールした場合です。 

 

(2) メインメニュー 

メインメニューは，メニューバーとツールバーがあります。 
 

メニューバー

ツールバー
 

図5-1 メニューバーとツールバー 

 

(a) メニューバー 

メニューバーのメニュー一覧を，下記に示します。 

 

表5-1 メニューバーのメニューとショートカットキー 

メニュー名 内  容 

File 
プロジェクトファイルの操作，パラメータの印刷，POUの作成などを

行う機能を含みます。 

Setup 
マスタユニットとCPUユニット間のデータ交信設定，GSDデバイス

データベースの編集などを行う機能を含みます。 

Online＊1 
接続先の設定，パラメータの書込み，PROFIBUS通信の開始／停止な

どを行う機能を含みます。 

Tools 
Webベースオンラインアクセス機能のサーバ／クライアント，および

GX Configurator-STの起動などを行う機能を含みます。 

View 
ツールバーやステータスバーの表示／非表示，またはグラフィカル

ネットワークエディタの表示を拡大／縮小する機能を含みます。 

Window＊2 ダイアログボックスの配置を操作する機能を含みます。 

Help 
ヘルプを表示する機能，ソフトウェアバージョンを表示する機能を

含みます。 
 

＊1 マスタユニットのプロジェクトを最前面に表示している場合のみ，表示されます。 

マスタユニットのプロジェクトを最前面に表示していない場合は，表示されません。 

＊2 マスタユニットまたはスレーブユニットのプロジェクトを開いている場合のみ，表

示されます。 

プロジェクトを開いていない場合は，表示されません。 
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メニューを開き，コマンド名の下線の付いた文字をキーボードから入力する

と，そのコマンドを実行できます。 

 

(b) ツールバー 

ツーバーのボタン一覧を，下記に示します。 

 

表5-2 ツールバーのボタン 

ボタン 内  容 

 New 新規にプロジェクトを作成します。 

 Open 既存のプロジェクトファイルを開きます。 

 Save プロジェクトを上書き保存します。 

 Print 各パラメータの一覧を印刷します。 

 Page Setup 印刷するパラメータを選択します。 

 Transfer Setup パソコンとシーケンサCPUの接続を設定します。 

 MXChange 本ボタンは使用できません。 

 GSD GSDデバイスデータベースを編集します。 

 Help ヘルプを表示します。 

 Help Tool クリックした場所のヘルプを表示します。 

 About GX Configurator-DPのソフトウェアバージョンを表示します。 
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5.1 Fileメニュー 

Fileメニューは，プロジェクトファイルの操作，パラメータの印刷，POUの作成など

を行う機能を含みます。 

 

 

図5-2 Fileメニュー 

 

表5-3 Fileメニューのコマンド 

コマンド 内  容 

New 新規にプロジェクトを作成します。 

Open 既存のプロジェクトファイルを開きます。 

Close 開いているプロジェクトを閉じます。 

Save プロジェクトを上書き保存します。 

Save As... 開いているプロジェクトに名前を付けて保存します。 

Export＊1 POU，設定イメージファイルなどをエクスポートします。 

 
POU for GX IEC 

Developer＊1 

GX IEC Developerのプログラミングで使用する，POUおよユーザライブラリを

エクスポートします。 

 
Configuration 

Image＊1 
設定イメージファイルをエクスポートします。 

Change Master Type 
＊1 

設定対象のマスタユニットと動作モードを変更します。 

Print＊1 各パラメータの一覧を印刷します。 

Page Setup＊1 印刷するパラメータを選択します。 

Project Select 最近開いたプロジェクトファイル4つの中から，1つを開きます。 

Exit GX Configurator-DPを終了します。 

 
＊1 マスタユニットのプロジェクトを最前面に表示している場合のみ，表示します。 

マスタユニットのプロジェクトを最前面に表示していない場合は，表示しません。 
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(1) Newコマンド 

新規にプロジェクトを作成します。 

プロジェクト作成時に，設定対象のマスタユニットを選択します。 

 

(a) 基本操作 

① 下記いずれかを実行し，“Network Setup”ダイアログボックスを表示さ

せます。 

・[File]→[New]メニュー( )をクリックします。 
 

・キーボードから Ctrl ＋ N キーを入力します。 

“Network Setup”ダイアログボックスについては，本項(1)(b)を参照し

てください。 

② マスタユニットを装着しているCPUユニットに合わせて“CPU Series”を

選択し，“MELSEC Device”でマスタユニットを選択します。 

③  OK ボタンをクリックし，下記ダイアログボックスに新規のプロジェクト

を表示させます。 

表5-4 プロジェクトを表示するダイアログボックス 

②の選択 ダイアログボックス 参照項

マスタユニット グラフィカルネットワークエディタ 6章(2)

スレーブユニット スレーブパラメータ設定用ダイアログボックス 7章(2)

 

(b) 表示／設定画面 
 

 

図5-3 Network Setupダイアログボックス 

 

表5-5 Network Setupダイアログボックスの項目 

項  目 内  容 

CPU Series 

マスタユニットの対応シーケンサシリーズを選択します。  

Qn ：MELSEC-Qシリーズ  

QnA/A ：MELSEC-QnAシリーズまたはMELSEC-Aシリーズ  

FX ：MELSEC-F FXシリーズ 

“CPU Series”の選択後に，マスタユニットを選択します。  

MELSEC Device 

QJ71PB92D（PROFIBUS DP V0 Master）

QJ71PB92V（PROFIBUS DP V1/V2 Master）

QJ71PB93D（PROFIBUS DP V0 Slave）

QJ71PB92D - Mode 0（PROFIBUS-DP V0 Master）

A(1S)J71PB92D（PROFIBUS DP V0 Master） 

 

A(1S)J71PB92D - Mode 0（PROFIBUS DP V0 Master）

 

FX3U-64DP-M（PROFIBUS DP V1 Master）

：QJ71PB92D（拡張サービスモード(MODE E)） 

：QJ71PB92V 

：QJ71PB93D 

：QJ71PB92D（通常サービスモード(MODE 0)） 

：A(1S)J71PB92D（拡張サービスモード（MODEスイ

ッチ：No.E）） 

：A(1S)J71PB92D（通常サービスモード（MODEスイ

ッチ：No.0）） 

：FX3U-64DP-M 
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(2) Openコマンド 

既存のプロジェクトファイルを開きます。 

 

ポイント  

① GX Configurator-DP Version7 では，プロジェクトファイルにGSDデータが保存

されます。 

このため，プロジェクトファイルを他のパソコンにコピーして開く場合，GSD

デバイスデータベースにGSDデータが存在しなくても開くことができます。 

② プロジェクトファイルを開くときに優先して使用するGSDデータを，下記いずれ

かに設定できます。 

・プロジェクトファイルに保存されているGSDデータ 

・GSDデバイスデータベースに登録されているGSDデータ 

この設定は，プロジェクトファイルを開く前に“GSD database has priority”

で設定する必要があります。 

詳細については，5.2節(5)を参照してください。 

 

(a) 基本操作 

① 下記いずれかを実行し，“Open”ダイアログボックスを表示させます。 

・[File]→[Open]メニュー( )をクリックします。 

・キーボードから Ctrl ＋ O キーを入力します。 

“Open”ダイアログボックスについては，本項(2)(b)を参照してください。 

② 開くプロジェクトファイルを選択します。 

③  Open ボタンをクリックし，下記ダイアログボックスにプロジェクトを表

示させます。 

表5-6 プロジェクトを表示するダイアログボックス 

②の選択した 

ファイルの拡張子
ダイアログボックス 参照項

*.dp2 グラフィカルネットワークエディタ 6章(2)

*.dpx スレーブパラメータ設定用ダイアログボックス 7章(2)

 

備  考 

上記の方法以外に，プロジェクトファイルを直接ダブルクリックしても，プロジェ

クトファイルを開くことができます。 
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(b) 表示／設定画面 
 

 

図5-4 Openダイアログボックス 

 

表5-7 Openダイアログボックスの項目 

項  目 内  容 

Lock in プロジェクトファイルが保存されているフォルダを選択します。 

File name 開くプロジェクトファイルのファイル名を選択または入力します。 

Files of type 

プロジェクトファイルの種類を選択します。 

DP2 Project-Files (*.dp2) ：マスタユニットのプロジェクトファイル 

DPX XML Project-Files (*.dpx) ：スレーブユニットのプロジェクトファイル 
 
 Open ボタン 
 

選択または入力されたプロジェクトファイルを開きます。 

 

 

ポイント  

MELSEC ProfiMap Version2 以前のソフトウェアバージョンで作成されたプロジェ

クトファイルは開くことができません。 

GX Configurator-DPで開くことができるプロジェクトファイルについては，2.2節

を参照してください。  

 

(3) Closeコマンド 

開いているプロジェクトを閉じます。 

 

備  考 

プロジェクトを保存していない場合は，下記ダイアログボックスを表示し，プロジェ

クトを保存することができます。 
 

 

図5-5 プロジェクトの保存の確認 
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(4) Saveコマンド 

プロジェクトを上書き保存します。 

 

備  考 

新規のプロジェクトを保存せずに本コマンドを実行した場合は，“Save As”ダイア

ログボックスを表示します。 

“Save As”ダイアログボックスについては，本節(5)を参照してください。 

 

(a) 基本操作 

下記いずれかを実行すると，プロジェクトを上書き保存させます。 

・[File]→[Save]メニュー( )をクリックします。 
 

・キーボードから Ctrl ＋ S キーを入力します。 

 

(b) GSDデータの保存について 

プロジェクトで使用しているスレーブ局のGSDデータは，プロジェクトファイ

ルに保存します。 

詳細については，5.2節(4)を参照してください。 
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(5) Save Asコマンド 

開いているプロジェクトに名前を付けて保存します。 

 

(a) 基本操作 

① [File]→[Save As]メニューを選択し，“Save As”ダイアログボックスを

表示させます。 

“Save As”ダイアログボックスについては，本節(5)(b)を参照してくだ

さい。 

② プロジェクトファイルのファイル名を入力します。 

③  Save ボタンをクリックし，入力したファイル名のプロジェクトファイル

に保存させます。 

 

(b) 表示／設定画面 
 

 

図5-6 Save Asダイアログボックス 

 

表5-8 Save Asダイアログボックスの項目 

項  目 内  容 

Save in プロジェクトファイルを保存するフォルダを選択します。 

File name プロジェクトファイルのファイル名を入力します。 

Save as type 

ダイアログボックスに表示するファイルの種類を選択します。 

DP2 Project-Files (*.dp2)
＊1

 ：マスタユニットのプロジェクトファイル 

DPX XML Project-Files (*.dpx) ＊2
 ：スレーブユニットのプロジェクトファイル 

All files(*.*) ：すべてのファイル 
 
 Save ボタン 
 

入力されたファイル名でプロジェクトを保存します。 

 
＊1 マスタユニットのプロジェクトを開いている場合のみ表示されます。 

＊2 スレーブユニットのプロジェクトを開いている場合のみ表示されます。 

 

(c) GSDデータの保存について 

プロジェクトで使用しているスレーブ局のGSDデータは，プロジェクトファイ

ルに保存されます。 

詳細については，5.2節(4)を参照してください。 
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(6) Exportコマンド 

POU，設定イメージファイルなどをエクスポートします。 

 

(a) POU for GX IEC Developerコマンド 

GX IEC Developerのプログラミングで使用する，POUおよびユーザライブラリ

をエクスポートします。 

 

ポイント  

① POUをGX IEC Developerにインポートするときに，ユーザライブラリも同時にイ

ンポートされます。 

② エクスポートしたPOUおよびユーザライブラリは，他のフォルダへ移動させない

でください。 

他のフォルダへ移動すると，GX IEC Developerでインポートするときに，ユー

ザライブラリをインポートできなくなります。 

他フォルダへの移動が必要な場合は，本コマンドにより移動させたいフォルダ

へ直接エクスポートしてください。 

③ QJ71PB92VをリモートI/O局に装着した場合は，リモートI/O局のプロジェクトに

インポートしないでください。 

リモートマスタ局のプロジェクトにインポートしてください。 

 

備  考 

本コマンドは，下記以外のマスタユニットのプロジェクトを，最前面に表示してい

る場合のみ，実行できます。 

下記のマスタユニット，およびスレーブユニットのプロジェクトを最前面に表示し

ている場合は，実行できません。 

・QJ71PB92D（通常サービスモード(MODE 0)） 

・A(1S)J71PB92D（通常サービスモード（MODEスイッチ：No.0）） 

 

(a-1) 基本操作 

① [File]→[Export]→[POU for GX IEC Developer]メニューをクリックし，

“Select the POU file”ダイアログボックスを表示させます。 

“Select the POU file”ダイアログボックスについては，本節(6)(a-2)

を参照してください。 

② POUのファイル名を入力します。 

③  Save ボタンをクリックし，入力したファイル名（＊1）のPOUおよびユーザ

ライブラリをエクスポートします。 

 

＊1 拡張子が“*.asc”，“*.sul”および“*.sul.asc”の3ファイルをエ

クスポートします。 
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(a-2) 表示／設定画面 

  

図5-7 Select the POU fileダイアログボックス 

 

表5-9 Select the POU fileダイアログボックスの項目 

項  目 内  容 

Save in POUおよびユーザライブラリを作成するフォルダを選択します。 

File name POUのファイル名を入力します。 
 
 Save ボタン 
 

入力されたファイル名でプロジェクトを保存します。 
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(b) Configuration Imageコマンド 

設定イメージファイルをエクスポートします。 

 

備  考 

本コマンドは，マスタユニットのプロジェクトを最前面に表示している場合のみ，

実行できます。 

マスタユニットのプロジェクトを最前面に表示していない場合は，実行できません。 

 

(b-1) 設定イメージファイルとは 

設定イメージファイルとは，マスタユニットに格納されるパラメータファ

イルです。 

設定イメージファイルは，マスタユニットに格納されるパラメータ（マス

タパラメータおよびスレーブパラメータ）のみを，他のマスタユニットに

書き込む場合などに使用します。 

 

プロジェクト 設定イメージ
ファイル

パソコン

＊1

(Export)

マスタユニット

設定イメージ
ファイル

(Upload) (Download)＊2

＊3

＊3

 

図5-8 設定イメージファイル 

 

＊1 マスタユニットからパソコンにアップロードした設定イメージファイル

は，GX Configurator-DPのプロジェクトにインポートできません。 

＊2 設定イメージファイルのアップロードおよびダウンロードについては，

5.3節を参照してください。 

＊3 設定イメージファイルには，マスタパラメータおよびスレーブパラメー

タが含まれます。 

自動リフレッシュ設定などの，シーケンサCPUに書き込まれる設定は，設 

定イメージファイルには含まれません。 
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(b-2) 基本操作 

① [File]→[Export]→[Configuration Image]メニューをクリックし，

“Select file for configuration image”ダイアログボックスを表示さ

せます。 

“Select file for configuration image”ダイアログボックスについて

は，本節(6)(b-3)を参照してください。 

② 設定イメージファイルのファイル名を入力します。 

③  Save ボタンをクリックし，入力したファイル名の設定イメージファイル

をエクスポートさせます。 

 

(b-3) 表示／設定画面 

 

図5-9 Select file for configuration imageダイアログボックス 

 

表5-10 Select file for configuration imageダイアログボックスの項目 

項  目 内  容 

Save in 設定イメージファイルを作成するフォルダを選択します。 

File name 設定イメージファイルのファイル名を入力します。 
 
 Save ボタン 
 

入力されたファイル名で設定イメージファイルを保存します。 
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(7) Change Master Typeコマンド 

設定対象のマスタユニットと動作モードを変更します。 

 

備  考 

本コマンドは，マスタユニットのプロジェクトを最前面に表示している場合のみ，

実行できます。 

マスタユニットのプロジェクトを最前面に表示していない場合は，実行できません。 

 

(a) 基本操作 

① [File]→[Change Master Type]メニューを選択し，“Change Master Type”

ダイアログボックスを表示させます。 

② 変更するマスタユニットを選択します。 

③  OK ボタンをクリックし，プロジェクトの設定対象のマスタユニットと動

作モードを変更させます。 

④ 変更後の各パラメータで入出力データ交信させたときに，問題が発生しな

いか各パラメータを確認します。 
 

(b) 表示／設定画面 
 

 

図5-10 Change Master Typeダイアログボックス 

 

表5-11 Change Master Typeダイアログボックスの項目 

項  目 内  容 

CPU Series 

マスタユニットの対応シーケンサシリーズを選択します。 

Qn ：MELSEC-Qシリーズ  

QnA/A ：MELSEC-QnAシリーズまたはMELSEC-Aシリーズ 

FX ：MELSEC-F FXシリーズ 

“CPU Series”の選択後に，マスタユニットを選択します。 

MELSEC Device 

QJ71PB92D（PROFIBUS DP V0 Master） 

QJ71PB92V（PROFIBUS DP V1/V2 Master） 

QJ71PB92D - Mode 0（PROFIBUS-DP V0 Master）

A(1S)J71PB92D（PROFIBUS DP V0 Master） 

 

A(1S)J71PB92D - Mode 0（PROFIBUS DP V0 Master）

 

FX3U-64DP-M（PROFIBUS DP V1 Master）

：QJ71PB92D（拡張サービスモード(MODE E)） 

：QJ71PB92V 

：QJ71PB92D（通常サービスモード(MODE 0)） 

：A(1S)J71PB92D（拡張サービスモード（MODEスイ

ッチ：No.E）） 

：A(1S)J71PB92D（通常サービスモード（MODEスイ

ッチ：No.0）） 

：FX3U-64DP-M 
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(8) Printコマンド 

各パラメータの一覧を印刷します。 

印刷するパラメータは“Page Setup”コマンドで選択します。 

“Page Setup”コマンドについては，本節(9)を参照してください。 

 

備  考 

本コマンドは，マスタユニットのプロジェクトを最前面に表示している場合のみ，

実行できます。 

マスタユニットのプロジェクトを最前面に表示していない場合は，実行できません。 

 

(a) 基本操作 

① プロジェクトを保存します。 

プロジェクトの保存方法については，下記を参照してください。 

・上書き保存 ··································本節(4) 

・名前を付けて保存 ····························本節(5) 
 

② 下記いずれかを実行し，Webブラウザを起動して各パラメータの一覧を表

示させます。 

・[File]→[Print]メニュー（ ）をクリックします。 
 

・キーボードから Ctrl ＋ P キーを入力します。 
 

③ Webブラウザで，各パラメータの一覧を印刷させます。 

 
 

(b) 表示／設定画面 
 

 

図5-11 Webブラウザの表示例 
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(9) Page Setupコマンド 

印刷するパラメータを選択します。 

印刷については，本節(8)を参照してください。 

 

備  考 

本コマンドは，マスタユニットのプロジェクトを最前面に表示している場合のみ，

実行できます。 

マスタユニットのプロジェクトを最前面に表示していない場合は，実行できません。 

 

(a) 基本操作 

① [File]→[Page Setup]メニューを選択し，“Page Setup”ダイアログボッ

クスを表示させます。 

② 印刷するパラメータの選択と，ヘッダを設定します。 

パラメータの選択とヘッダの設定は，本節(9)(b)を参照してください。 

③  OK ボタンをクリックし，設定を終了させます。 

 

(b) 表示／設定画面 
 

 

図5-12 Page Setupダイアログボックス 

 

表5-12 Page Setupダイアログボックスの項目 

項  目 内  容 

Master Parameter， 

Bus Parameter， 

Slave Parameter 

印刷するパラメータを選択します。 

Print Header at 

下記の“Header Text”の設定内容を印刷するかしないか，または印刷位置を選択しま

す。 

Top ：“Header Text”をパラメータ一覧より上に印刷されます。 

Bottom ：“Header Text”をパラメータ一覧より下に印刷されます。 

No Header ：“Header Text”を印刷されません。 

Header Text ヘッダまたはフッタとして印刷する文字列を入力します。 
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(10) Recent Filesコマンド 

最近開いたプロジェクトファイルが4つ表示されます。 

この中からプロジェクトファイルを選択すると，選択したプロジェクトファイル

を開くことができます。 

 

(11) Exitコマンド 

GX Configurator-DPを終了します。 

 

備  考 

プロジェクトを保存していない場合は，下記ダイアログボックスが表示され，プロ

ジェクトを保存することができます。 

 
 

 

図5-13 プロジェクトの保存の確認 
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5.2 Setupメニュー 

Setupメニューは，マスタユニットとCPUユニット間のデータ交信設定，GSDデバイス

データベースの編集などを行う機能を含みます。 

 

  

図5-14 Setupメニュー 

 

表5-13 Setupメニューのコマンド 

コマンド 内  容 ショートカットキー

MXChange Support＊1 本コマンドは使用できません。 Ctrl  +  M キー

GSD 

Device-Database＊1 
GSDデバイスデータベースを操作します。 Ctrl  +  G キー

PLC and GX IEC 

Developer(GID) 

Settings＊2 

マスタユニットのバッファメモリとCPUユニット間のデータ交信について設

定します。 
⎯ 

Options 
GSDデバイスデータベースの選択，およびGSDデータの開き方／上書き保存に

ついて設定します。 
⎯ 

 
＊1 マスタユニットのプロジェクトを最前面に表示している場合，またはプロジェクトをす

べて閉じている場合に，表示されます。 

スレーブユニットのプロジェクトを表示している場合は，表示されません。 

＊2 マスタユニットのプロジェクトを最前面に表示している場合のみ，表示されます。 

マスタユニットのプロジェクトを最前面に表示していない場合は，表示されません。 

＊3 QJ71PB92□のプロジェクトを最前面に表示している場合のみ，表示されます。 

QJ71PB92□以外のプロジェクトを最前面に表示している場合は，表示されません。 

 

(1) MXChange Supportコマンド 

本コマンドは使用できません。 
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(2) GSD Device-Databaseコマンド 

GSDデバイスデータベースを編集します。 

 

備  考 

本コマンドは，プロジェクトを開いていない場合のみ，実行できます。 

プロジェクトを開いていると，実行できません。 

 

(a) 基本操作 

① 下記いずれかを実行し，“Device Database”ダイアログボックスを表示

させます。 

・[Setup]→[GSD Device-Database]メニュー（ ）をクリックします。 

・キーボードから Ctrl ＋ G キーを入力します。 

“Device Database”ダイアログボックスの各項目については，本節

(2)(b)を参照してください。 

② GSDデバイスデータベースに，下記の編集をします。 

・スレーブ局の画像変更 ··················本節(2)(a-1)参照 

・スレーブ局の登録追加 ··················本節(2)(a-2)参照 

・スレーブ局の登録削除 ··················本節(2)(a-3)参照 

・スレーブデバイスグループの変更 ········本節(2)(a-4)参照 

・GSDデバイスデータベースのインポート ···本節(2)(a-5)参照 

③  Leave ボタンをクリックし，GSDデバイスデータベースの編集を終了しま

す。 
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(a-1) スレーブ局の画像変更 

① “Available Slave Systems”で，画像を変更するスレーブ局を選択しま

す。 

 

 
② “Bitmap”で，“Normal”を選択します。 

 

 
③  Replace Bitmap ボタンをクリックし，“Select Bitmap File”ダイアロ

グボックスを表示させます。 

 

 
④ 新たにスレーブ局として表示にする画像ファイルを選択します。 

 
⑤  Open ボタンをクリックし，スレーブ局の画像を変更させます。 

 

(a-2) スレーブ局の登録追加 

①  Add ボタンをクリックし，“Load GSD-/DDB-File”ダイアログボックス

を表示させます。 

 

② 追加するスレーブ局のGSD(DDB)ファイルを選択し,  Open ボタンをク

リックします。 

③ 下記ダイアログボックスが表示された場合，PROFIBUS-DPV1機能のパラ

メータ形式の使用可否を選択できます。 

使用するなら Yes ボタンをクリックします。 

使用しないなら No ボタンをクリックします。 
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④ 下記ダイアログボックスが表示された場合，すでに同じ名前のスレーブ局

が登録されています。 

スレーブ局のリビジョンまたは名前を変更する場合は，“Revision”また

は“Model name”を変更して OK ボタンをクリックします。 

すでに登録されているスレーブ局と置き換える場合は， Replace ボタン

をクリックします。 

 

 

備  考 

スレーブ局の追加時にスレーブ局の画像ファイルを要求された場合は，メッセージ

に従って画像ファイルを選択してください。 

 

(a-3) スレーブ局の登録削除 

① “Available Slave Systems”で，削除するスレーブ局を選択します。 

②  Delete ボタンをクリックし，GSDデバイスデータベースからスレーブ局

を削除させます。 
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(a-4) スレーブデバイスグループの変更 

① “Available Slave Systems”で，スレーブデバイスグループを変更する

スレーブ局を選択します。 

②  Group ボタンをクリックし，“Select Slave Family”ダイアログボック

スを表示させます。 

 

③ “Slave Families”から，新たに割り当てるスレーブデバイスグループを

選択します。 

④  OK ボタンをクリックし，スレーブデバイスグループを変更させます。 

 

(a-5) GSDデバイスデータベースのインポート 

①  Import ボタンをクリックし，“Select Extract/DDB-File to import”

ダイアログボックスを表示させます。 

 

② インポートするGSDデバイスデータベースを含むファイルを選択します。 

③  Open ボタンをクリックし，GSDデバイスデータベースをインポートさせ

ます。 
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(b) 表示／設定画面 
 

 

図5-15 Device Databaseダイアログボックス 

 

表5-14 Device Databaseダイアログボックスの項目 

項  目 内  容 

GSD Database 

使用するGSDデバイスデータベースが表示されます。 

Global ：GX Configurator-DP内蔵のGSDデバイスデータベースが使用されます。 

Project ：本項目は選択できません。 

Slave Device Group “Available Slave Systems”に表示する，スレーブ局のグループを選択します。 

Available Slave Systems 
スレーブ局を選択すると，選択したスレーブ局の情報が表示され，情報の編集などがで

きます。 

Vendor スレーブ局のメーカが表示されます。 

Revision スレーブ局のリビジョンが表示されます。 

Ident-No. スレーブ局のアイデントNo.が表示されます。 

Bitmap 

GSDデバイスデータベースに登録された画像を，表示または変更します。 

Normal
＊1

 ：通常操作時の画像が表示されます。 

Diagnostics
＊1

 ：診断時の画像が表示されます。 

Special Function
＊1

 ：特殊機能時の画像が表示されます。 

 Replace Bitmap  ：表示されている画像を変更します。 

画像の仕様については，本節(2)(c)を参照してください。 

GSD-/DDB-File スレーブ局のGSD(DDB)ファイルが表示されます。 

Bitmap-File スレーブ局の画像ファイルが表示されます。 
 
 Add ボタン 
 

GSDデバイスデータベースにスレーブ局のGSD(DDB)ファイルが追加登録されます。 

 
 Delete ボタン 
 

GSDデバイスデータベースからスレーブ局を削除します。 

 
 Group ボタン 
 

スレーブ局のスレーブデバイスグループを変更します。 

 
 Import ボタン 
 

GSDデバイスデータベースをインポートします。 

 
 Leave ボタン 
 

GSDデバイスデータベースの編集を終了します。 

 
＊1 グラフィカルネットワークエディタには，“Normal”を選択したときの画像が表示されます。 

“Diagnostics”または“Special Function”を選択したときの画像は表示されません。 
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(c) スレーブ局として表示する画像の仕様 

スレーブ局として表示する画像の仕様は，下記仕様のビットマップファイル

を推奨します。 

    表5-15 画像の仕様 

項  目 内  容 

幅 70ピクセル 

高さ 40ピクセル 

色 16色 

拡張子 BMPまたはDIB 

 
上記仕様以外のビットマップファイルを使用できますが，警告メッセージを

表示する場合があります。 

 

(d) インポート可能なファイル 

GSDデバイスデータベースにインポートできるファイルを，下記に示します。 

 

表5-16 インポート可能なファイル 

ファイルの種類 内  容 

Database-File (*.mdb) 
GX Configurator-DPが内部に持っている，GSDデバイスデー

タベースのファイル。 

GSD-Extract-File (*.ext)
GX Configurator-DP Version6 以前で作成した，GSD抽出

ファイル。 

Project File (*.dp2) 
GX Configurator-DP Version7 以降で保存した，GSDデータ

を含んだプロジェクトファイル。 

 

(e) 注意事項 
 

(e-1) GSD(DDB)ファイルについては，各スレーブ局のメーカにお問い合わせくだ

さい。 
 

(e-2) 追加したスレーブ局のGSDファイルに，スレーブデバイスグループの記述が

ない場合は，“General”グループに割り付けられます。 
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(3) PLC and GX IEC Developer (GID) Settingsコマンド 

マスタユニットのバッファメモリとCPUユニット間のデータ交信について設定し

ます。 

データ交信は，FROM/TO/MOV命令を使用する方法か，自動リフレッシュを使用する

方法かを選択できます。 

 

備  考 

本項目は，マスタユニットのプロジェクトを最前面に表示している場合のみ，実行

できます。 

マスタユニットのプロジェクトを最前面に表示していない場合は，実行できません。 

 

(a) 基本操作 

① [Setup]→[PLC and GX IEC Developer (GID) Settings]メニューを選択し，

“PLC and GX IEC Developer (GID) Settings”ダイアログボックスを表

示させます。 

② “CPU Device Access”タブを開き，マスタユニットとCPUユニット間の交

信で使用するCPUユニットのデバイスを設定し，交信方法を選択します。 

“CPU Device Access”タブの詳細については，本節(3)(b)を参照してく

ださい。 

③ “Data Transfer using”で“AutoRefresh(Update of GID Project)”を

選択した場合は，“GX IEC Developer (GID) Settings”タブを開き，GX IEC 

Developerのプロジェクトファイルを設定します。 

 

④  OK ボタンをクリックし，設定を終了します。 
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(b) 表示／設定画面 
 

 

図5-16 CPU Device Accessダイアログボックス 

 

表5-17 CPU Device Accessダイアログボックスの項目 

項  目 内  容 

Buffer Devices マスタユニットとCPUユニット間の交信で使用するCPUユニットのデバイスを設定します。 

 
Slave Specific 

Transfer 

交信で使用するデバイスを，スレーブ局単位で設定する場合に選択します。 

デバイスの設定は，本項目選択後に“I/O Mapping”ダイアログボックスを開き，各スレーブ局

の“Buffer MIT-Address”で設定します。 

“I/O Mapping”ダイアログボックスについては，8章を参照してください。 

 Block Transfer 

交信で使用するデバイスを，全スレーブ局で同一のデバイスに設定する場合に設定します。 

デバイスの設定は，下記“Input”および“Output”に設定します。 

Input ：入力データの交信に使用するデバイスを設定します。 

ビットデバイスを設定する場合は，16点単位で設定してください。 

Output ：出力データの交信に使用するデバイスを設定します。 

ビットデバイスを設定する場合は，16点単位で設定してください。 

 Comm. Trouble Area 
通信障害情報エリアの交信に使用するデバイスを設定します。 

マスタユニットが，QJ71PB92□またはA(1S)J71PB92Dの場合に，設定可能になります。 

 
Extd. Comm. Trouble 

Area 

拡張通信障害情報エリアの交信に使用するデバイスを設定します。 

マスタユニットが，QJ71PB92□またはA(1S)J71PB92Dの場合に，設定可能になります。 

 Slave Status Aera 
スレーブステータスエリアの交信に使用するデバイスを設定します。 

マスタユニットが，QJ71PB92□またはA(1S)J71PB92Dの場合に，設定可能になります。 

Data Transfer using マスタユニットとCPUユニット間の交信方法を設定します。 

 Copy Instructions FROM/TO/MOV命令を使用して交信する場合に選択します。 

 
AutoRefresh 

(Update of CPU) 

自動リフレッシュを使用して交信する場合に選択します。 

本項目を選択した場合は，プロジェクトをダウンロードしたときに，自動リフレッシュパラメー

タをCPUユニットへ書き込みます。 

マスタユニットが，QJ71PB92□の場合に，設定可能になります。 

 

AutoRefresh 

(Update of GID 

Project) 

自動リフレッシュを使用して交信する場合に選択します。 

本項目を選択した場合は，自動リフレッシュパラメータを，GX IEC Developerのプロジェクト

ファイルへ書き込みます。 

CPUユニットへの書込みは，GX IEC Developerから行います。 

マスタユニットが，QJ71PB92□の場合に，設定可能になります。 
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(c) 自動リフレッシュパラメータの設定個数について 

CPUユニットに設定可能な自動リフレッシュパラメータの設定個数には，制限

があります。 

自動リフレッシュパラメータは，下記に示す設定個数を超えないように設定

してください。 
 

(c-1) 全インテリジェント機能ユニットの自動リフレッシュパラメータ設定個数 

複数のインテリジェント機能ユニットを装着した場合，下記の設定個数を

超えないように自動リフレッシュパラメータを設定してください。 

 

表5-18 最大自動リフレッシュパラメータ設定個数 

CPUタイプ 最大自動リフレッシュパラメータ設定個数 

Q00J/Q00/Q01CPU 256 

Q02/Q02H/Q06H/Q12H/Q25HCPU 256 

Q12PH/Q25PHCPU 256 

Q12PRH/Q25PRHCPU 256 

 

(c-2) QJ71PB92□の自動リフレッシュパラメータ設定個数 

QJ71PB92□の自動リフレッシュパラメータ設定個数は，入出力データの自

動リフレッシュ設定方法により，設定個数が異なります。 

・“Block Transfer”で設定した場合 

入出力データの自動リフレッシュ設定を“Block Transfer”で設定した

場合（全スレーブ局の入出力データを同一デバイスにリフレッシュさせ

る場合），QJ71PB92□1台あたり最大5個となります。 
 

最大5個の自動リフレッシュ
パラメータを設定

 

図5-17 QJ71PB92□の自動リフレッシュパラメータ設定個数（“Block Transfer”で設定時） 
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・“Slave Specific Transfer”で設定した場合 

入出力データの自動リフレッシュ設定を“Slave Specific Transfer”で

設定した場合（スレーブ局単位でリフレッシュ先デバイスを変更する場

合），QJ71PB92□1台あたり下記の個数となります。 
 

最大設定個数＝｛（スレーブ局の接続台数）×2｝＋3 
 

最大3個の自動リフレッシュ
パラメータを設定

QJ71PB92□に接続している
（スレーブ局数分×2）個
の自動リフレッシュパラ
メータを設定

合計数分の
自動リフレッシュ
パラメータを設定

 

図5-18 QJ71PB92□の自動リフレッシュパラメータ設定個数（“Slave Specific Transfer”で設定時）
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(4) Optionsコマンド 

GSDデバイスデータベースの選択，およびプロジェクトファイルを開くときに優先

して使用するGSDデータを設定します。 

 

(a) 基本操作 

① [Setup]→[Options]メニューを選択し，“Options”ダイアログボックス

を表示させます。 

“Options”ダイアログボックスについては，本節(4)(b)を参照してくだ

さい。 

② 下記の設定を行います。 

・GSDデバイスデータベースの選択 ·········本節(4)(a-1) 参照 

・プロジェクトファイル内のGSDデータの扱いを設定する場合は，“GSD 

database has priority”で設定します。 

“GSD database has priority”については，本節(4)(c)を参照してく

ださい。 

③  OK ボタンをクリックし，設定を終了します。 
 

(a-1) GSDデバイスデータベースの選択 

①  Browse ボタンをクリックし，“Select GSD Database File”ダイアログ

ボックスを表示させます。 

 

② 使用するGSDデバイスデータベースのファイルを選択します。 

③  Open ボタンをクリックし，GSDデバイスデータベースの選択を終了しま

す。 
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(b) 表示／設定画面 
 

 

図5-19 Optionsダイアログボックス 

 

表5-19 Optionsダイアログボックスの項目 

項  目 内  容 

Select Databese 

 
 
 Browse ボタン 
 

GX Configurator-DPが内部に持つGSDデバイスデータベースを選択します。 

GSD database has priority 

プロジェクトファイルを開くときに優先して使用するGSDデータを，下記いずれかに設

定します。 

・プロジェクトファイルに保存されているGSDデータ 

・GSDデバイスデータベースに登録されているGSDデータ 

本項目設定の詳細は，本節(4)(c)を参照してください。 
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(c) GSD database has priorityについて 

“GSD database has priority”の設定により，GSDデータを下記のように扱

います。 
 

(c-1) GSD database has priorityのチェックをはずした場合 

GSDデータの読み出し処理／保存処理の詳細を，下記に示します。 
 

プロジェクトファイル

GSDデバイスデータベース プロジェクト

①

②

③

GX Configurator-DP プロジェクトファイル

④

：読み出し
：保存

 

図5-20 GSDデータの読み出し処理／保存処理のイメージ 

 

表5-20 GSDデータの読み出し処理／保存処理 

読み出し／

保存区分 
No. GSDデータの状態 処  理 

① 

プロジェクトファイルとGSDデバイスデー

タベースの両方に，同一機種のGSDデータ

が保存されている場合 

プロジェクトファイルのGSDデータを読み出します。

② 
プロジェクトファイルのみにGSDデータが

保存されている場合 

プロジェクトファイルのGSDデータを読み出します。

③＊1 
GSDデバイスデータベースのみにGSDデー

タが保存されている場合 

GSDデバイスデータベースのGSDデータを読み出しま

す。 

読み出し 

－＊1 

プロジェクトファイルとGSDデバイスデー

タベースの両方とも，GSDデータベースが

保存されていない場合 

プロジェクトを開けません。 

必要な機種のGSD(DDB)ファイルをGSDデバイスデータ

ベースに追加し，プロジェクトを開いてください。 

詳細については，5.2節(2)を参照してください。 

保存 ④ － 
プロジェクトで使用しているすべてのGSDデータを，

プロジェクトファイルに保存します。 
 

＊1 GX Configurator-DP Version6 以前で保存したプロジェクトを開く場合は，

“③”または“－”の読み出し処理を行います。 

 

備  考 

プロジェクトから削除されて使われなくなったスレーブ局のGSDデータは，プロジェ

クトファイルから削除されます。 

 



 

 

 

5 - 31                                         5 - 31 

５ メニュー 
MELSOFT

 

(c-2) GSD database has priorityにチェックしている場合 

GSDデータの読み出し処理／保存処理の詳細を，下記に示します。 
 

プロジェクトファイル

GSDデバイスデータベース プロジェクト

①

②

③

GX Configurator-DP プロジェクトファイル

④

：読み出し
：保存

 

図5-21 GSDデータの読み出し処理／保存処理のイメージ 

 

表5-21 GSDデータの読み出し処理／保存処理 

読み出し／ 

保存区分 
No. GSDデータの状態 処  理 

① 

プロジェクトファイルとGSDデバイスデー

タベースの両方に，同一機種のGSDデータ

が保存されている場合 

GSDデバイスデータベースのGSDデータを読み出しま

す。 

② 
プロジェクトファイルのみにGSDデータが

保存されている場合 

プロジェクトファイルのGSDデータを読み出します。

③＊1 
GSDデバイスデータベースのみにGSDデー

タが保存されている場合 

GSDデバイスデータベースのGSDデータを読み出しま

す。 

読み出し 

－＊1 

プロジェクトファイルとGSDデバイスデー

タベースの両方とも，GSDデータベースが

保存されていない場合 

プロジェクトを開けません。 

必要な機種のGSD(DDB)ファイルをGSDデバイスデータ

ベースに追加し，プロジェクトを開いてください。 

詳細については，5.2節(2)を参照してください。 

保存 ④ － 
プロジェクトで使用しているすべてのGSDデータを，

プロジェクトファイルに保存します。 
 

＊1 GX Configurator-DP Version6 以前で保存したプロジェクトを開く場合は，

“③”または“－”の読み出し処理を行います。 
 

備  考 

プロジェクトから削除されて使われなくなったスレーブ局のGSDデータは，プロジェ

クトファイルから削除されます。 
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5.3 Onlineメニュー 

Onlineメニューは，接続先の設定，パラメータの書込み，PROFIBUS通信の開始／停

止などを行う機能を含みます。 

 

 

 
図5-22 Onlineメニュー 

 

表5-22 Onlineメニューのコマンド 

コマンド 内  容 

Transfer Setup パソコンとシーケンサCPUの接続を設定します。 

Transfer 
“Transfer Setup”ダイアログボックスで指定したユニットに対して，プロジェクトのダウ

ンロードなどを行います。 

 Download to Module 
プロジェクトをユニットにダウンロードします。 

プロジェクトの書込み中は，入出力データ交信を停止し，書込みが完了すると再開されます。

 Verify 

プロジェクトの設定内容と，ユニットにダウンロードされている設定内容を照合します。

A(1S)J71PB92DまたはQJ71PB92Dの場合，照合中は入出力データ交信を停止し，照合が終了す

ると再開されます。 

上記以外のマスタユニットの場合は，照合中に入出力データ交信は停止しません。 

照合結果については，本節(2)(b)を参照してください。 

 Upload Config. Image マスタユニット内の設定イメージファイルを，パソコンにアップロードします。 

 Download Config. Image パソコン内の設定イメージファイルを，マスタユニットにダウンロードします。 

Start/Stop PROFIBUS PROFIBUS-DPの入出力データ交信を起動／停止します。 

 

備  考 

本メニューは，マスタユニットのプロジェクトを最前面に表示している場合のみ，

実行できます。 

マスタユニットのプロジェクトを最前面に表示していない場合は，実行できません。 
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(1) Transfer Setupコマンド 

パソコンとシーケンサCPUの接続を設定します。 

詳細については，9章を参照してください。 

 

(2) Transferコマンド 

“Transfer Setup”ダイアログボックスで指定したユニットに対して，プロジェ

クトのダウンロードなどを行います。 

 

Transferコマンド内のコマンドを実行する前に，下記の操作を行ってください。 

① 接続しているマスタユニットと，プロジェクトのマスタユニットが同じ機

種か確認します。 

マスタユニットが違う機種の場合は，下記いずれかを行います。 

・接続しているマスタユニットを，プロジェクトのマスタユニットと同じ

機種に交換します。 

・“Change Master Type”コマンドで，プロジェクトのマスタユニットを

接続しているマスタユニットに変更します。 

“Change Master Type”コマンドについては，5.1節(7)を参照してくだ

さい。 

② シーケンサCPUとマスタユニット間が，交信していないことを確認します。

（FROM/TO/MOV命令の交信を含む。） 

③ パソコンとシーケンサCPU間を接続したケーブルが，正しく接続されてい

ることを確認します。 

④ パソコンとシーケンサCPU間の接続を設定します。 

接続の設定については，9章を参照してください。 

⑤ プロジェクトを保存します。 

プロジェクトの保存方法については，下記を参照してください。 

・上書き保存 5.1節(4) 

・名前を付けて保存 5.1節(5) 

⑥ [Online]→[Transfer]以下のメニューを選択し，プロジェクトのダウン

ロードなどを行います。 



 

 

 

5 - 34                                         5 - 34 

５ メニュー 
MELSOFT

 

(a) Download to Moduleコマンド 

プロジェクトをユニットにダウンロードします。 

プロジェクトの書込み中は，入出力データ交信を停止し，書込みが完了する

と再開されます。 
 

(a-1) 基本操作 

① 下記いずれかを実行し，確認のダイアログボックスを表示させます。 

・[Online]→[Transfer]→[Download to Module]メニューをクリックし

ます。 

・グラフィカルネットワークエディタのマスタ局の図上で右クリックし，

[Transfer]→[Download to Module]メニューをクリックします。 

②  Yes ボタンをクリックし，プロジェクトをユニットにダウンロードし

ます。 

自動リフレッシュパラメータを書き込むときに，QCPUがRUN状態の場合

は，下記ダイアログボックスが表示されます。 
 

 

図5-23 自動リフレッシュパラメータ書込み時にQCPUがRUN状態の場合 
 

 Yes ボタンをクリックするとQCPUがSTOP状態になり，自動リフレッ

シュパラメータがQCPUに書き込まれます。 
 

③ 自動リフレッシュパラメータを書き込んだ場合は，QCPUをリセットしま

す。 

 

(a-2) ダウンロード実行時の注意事項 

・接続したマスタユニットとプロジェクトの設定が違う場合 

接続したマスタユニットとプロジェクトのマスタユニットが違う場合は，

下記ダイアログボックスが表示されます。 
 

  

図5-24 マスタユニットが違う場合 
 

上記ダイアログボックスが表示された場合は，“Change Master Type”コマンドで，

マスタユニットのタイプを，接続しているマスタユニットと同じタイプに変更してく

ださい。（5.1節(7)参照） 
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・自動リフレッシュ設定の更新 

“PLC and GX IEC Developer (GID) Settings”ダイアログボックスで，

“AutoRefresh (Update of CPU)”を選択している場合は，ダウンロード時

に自動リフレッシュ設定がQCPUに書き込まれます。（5.2節(3)参照） 

“AutoRefresh (Update of GID Project)”を選択している場合は，GX IEC 

Developerのプロジェクトが更新されます。（自動リフレッシュ設定は，

QCPUに書き込まれません。） 

・A(1S)J71PB92Dの動作モード 

A(1S)J71PB92Dユニットを使用する場合は，ユニット正面のモード設定ス

イッチを1（パラメータ設定モード）に設定してください。 

モードの変更は，シーケンサCPUをリセットすると反映されます。 
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(a-3) 接続先が二重化システムの場合 

二重化CPUの運転モードにより，ダウンロード先が異なります。 

 

表5-23 運転モードによるダウンロード先 

ダウンロード先 

項  目 A系とB系の

両方 
片側の系 

内  容 

バックアップモード ○ × 

 

 
 OK ボタンをクリックすると，A系とB系の両方にダウンロードされます。

ダウンロード時は，二重化CPUの運転モードがセパレートモードに変更さ

れ，トラッキング転送が停止します。 

セパレートモード ○ ○＊1 

 

 
 Yes ボタンをクリックすると，A系とB系の両方にダウンロードされま

す。 

 No ボタンをクリックすると，片側の系＊1にダウンロードされます。 

ダウンロード時は，二重化CPUのトラッキング転送が停止します。 

デバッグモード × ○ 

 

 

 
 OK ボタンをクリックすると，ケーブル（RS-232ケーブル，USBケーブル

など）を接続した二重化CPUの系に，ダウンロードされます。 
 

○：ダウンロード可能 ×：ダウンロード不可能 

 

＊1 “Transfer Setup”ダイアログボックスの“Target system”で設定した二重化CPUの系

に，ダウンロードされます。 

ただし，“Target system”で“Not specified”に設定した場合は，ケーブル（RS-232

ケーブル，USBケーブルなど）を接続した二重化CPUの系に，ダウンロードされます。 

 

ポイント  

二重化CPUのトラッキングケーブルが接続されていない場合は，二重化CPUの運転

モードに関係なく，ケーブル（RS-232ケーブル，USBケーブルなど）を接続した二

重化CPUの系に，ダウンロードされます。 
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(b) Verifyコマンド 

プロジェクトの設定内容と，ユニットにダウンロードされている設定内容を

照合します。 

A(1S)J71PB92DまたはQJ71PB92Dの場合，照合中は入出力データ交信を停止し，

照合が終了すると再開されます。 

上記以外のマスタユニットの場合は，照合中に入出力データ交信は停止しま

せん。 
 

(b-1) 基本操作 

① 下記いずれかを実行すると，プロジェクトを照合します。 

・[Online]→[Transfer]→[Verify]メニューをクリックします。 

・グラフィカルネットワークエディタのマスタ局の図上で右クリックし，

[Transfer]→[Verify]メニューをクリックします。 

 

(b-2) 表示／設定画面 

照合結果は，下記のように表示されます。 
 

  

図5-25 一致した場合 

 

  

図5-26 不一致の場合 
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(b-3) 接続先が二重化システムの場合 

二重化CPUの運転モードにより，照合の対象が異なります。 

 

表5-24 運転モードによる照合の対象 

照合の対象 

項  目 A系とB系の

両方 
片側の系 

内  容 

バックアップモード ○ × 

 

 
 OK ボタンをクリックすると，A系とB系の両方に対して照合が行われま

す。 

照合時は，二重化CPUの運転モードがセパレートモードに変更され，ト

ラッキング転送が停止します。 

セパレートモード ○ ○＊1 

 

 
 Yes ボタンをクリックすると，A系とB系の両方に対して照合が行われま

す。 

 No ボタンをクリックすると，片側の系＊1に対して照合が行われます。

照合時は，二重化CPUのトラッキング転送が停止します。 

デバッグモード × ○ 

 

 
 OK ボタンをクリックすると，ケーブル（RS-232ケーブル，USBケーブル

など）を接続した二重化CPUのマスタユニットに対して，照合が行われま

す。 
 

○：照合可能 ×：照合不可能 

 

＊1 “Transfer Setup”ダイアログボックスの“Target system”で設定した二重化CPUの系

に対して，照合が行われます。 

ただし，“Target system”で“Not specified”に設定した場合は，ケーブル（RS-232

ケーブル，USBケーブルなど）を接続した二重化CPUのマスタユニットに対して，照合が

行われます。 

 

ポイント  

二重化CPUのトラッキングケーブルが接続されていない場合は，二重化CPUの運転

モードに関係なく，ケーブル（RS-232ケーブル，USBケーブルなど）を接続した二

重化CPUのマスタユニットに対して，照合が行われます。 
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(c) Upload Config. Imageコマンド 

マスタユニット内の設定イメージファイルを，パソコンにアップロードしま

す。 
 

(c-1) 基本操作 

① [Online]→[Transfer]→[Upload Config. Image]メニューをクリックし，

“Select file for configuration image”ダイアログボックスを表示

させます。 

“Select file for configuration image”ダイアログボックスについ

ては，本節(2)(c-2)を参照してください。 

② 設定イメージファイルを選択します。 

③  Save ボタンをクリックし，設定イメージファイルをパソコンにアップ

ロードします。 
 

(c-2) 表示／設定画面 

 

図5-27 Select file for configuration imageダイアログボックス 

 

表5-25 Select file for configuration imageダイアログボックスの項目 

項  目 内  容 

Save in 設定イメージファイルを保存するフォルダを選択します。 

File name 設定イメージファイルのファイル名を入力します。 
 
 Save ボタン 
 

入力されたファイル名で設定イメージファイルを保存します。 

 

(c-3) Upload Config. Imageコマンド実行時の注意事項 

本コマンドでは，マスタユニット内のパラメータがパソコンにアップロー

ドされます。 

シーケンサCPUに保存されるパラメータ（自動リフレッシュ設定など）は，

アップロードされません。（5.1節(6)(b-1)参照） 
 

(c-4) 接続先が二重化システムの場合 

ケーブル（RS-232ケーブル，USBケーブルなど）を接続した二重化CPUのマ

スタユニットが，アップロードの対象になります。 
 

備  考 

設定イメージファイルについての詳細は，5.1節(6)(b)を参照してください。 
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(d) Download Config. Imageコマンド 

パソコン内の設定イメージファイルを，マスタユニットにダウンロードしま

す。 
 

(d-1) 基本操作 

① [Online]→[Transfer]→[Download Config. Image]メニューをクリック

し，“Select file for configuration image”ダイアログボックスを

表示させます。 

“Select file for configuration image”ダイアログボックスについ

ては，本節(2)(d-2)を参照してください。 

② 設定イメージファイルのファイル名を入力します。 

③  Save ボタンをクリックし，設定イメージファイルをマスタユニットに

ダウンロードします。 
 

(d-2) 表示／設定画面 

 

図5-28 Select file for configuration imageダイアログボックス 

 

表5-26 Select file for configuration imageダイアログボックスの項目 

項  目 内  容 

Lock in 設定イメージファイルが格納されているフォルダを選択します。 

File name 選択した設定イメージファイルのファイル名が表示されます。 

Open as read-only 設定イメージファイルを，読み取り専用ファイルとして開く場合にチェックします。
 
 Open ボタン 
 

選択した設定イメージファイルをダウンロードします。 

 
(d-3) Download Config. Imageコマンド実行時の注意事項 

ダウンロードする設定イメージファイルには，下記のいずれかを選択して

ください。 

・Configuration Imageコマンドでエクスポートした設定イメージファイル

（5.1節(6)(b)参照） 

・Upload Config. Imageコマンドでアップロードした設定イメージファイ

ル（本節(2)(c)参照） 

 

また，プロジェクトのマスタユニットのタイプは，設定イメージファイル

のマスタユニットのタイプと同じタイプにしてください。 

マスタユニットのタイプが異なる場合は，ダウンロードができません。 
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(d-4) 接続先が二重化システムの場合 

二重化CPUの運転モードにより，ダウンロード先が異なります。（本節

(2)(a-3)参照） 

 

備  考 

設定イメージファイルについての詳細は，5.1節(6)(b)を参照してください。 

 

(3) Start/Stop PROFIBUSコマンド 

PROFIBUS-DPの入出力データ交信を起動／停止します。 

 

(a) 基本操作 

① [Online]→[Transfer]→[Start/Stop PROFIBUS]メニューをクリックし，

PROFIBUS-DPの入出力データ交信を起動／停 
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5.4 Toolsメニュー 

Toolsメニューは，Webベースオンラインアクセス機能のサーバ／クライアント，お

よびGX Configurator-STの起動などを行う機能を含みます。 
 

 

図5-29 Toolsメニュー 

 

表5-27 Toolsメニューのコマンド 

コマンド 内  容 

Server Administrator 

Webベースオンラインアクセス機能のサーバを起動／停止し

ます。 

Webベースオンラインアクセス機能については，10章を参照

してください。 

GX Configurator Client 
Webブラウザを起動し，Webベースオンラインアクセス機能の

サーバにアクセスします。 

GX Configurator-ST GX Configurator-STを起動します。 

 

(1) GX Configurator-STの起動 

GX Configurator-STを起動します。 

GX Configurator-STでは，MELSEC-STシステムの設定，モニタ，テストなどができ

ます。 

GX Configurator-STの詳細は，GX Configurator-ST Version1 オペレーティング

マニュアルを参照してください。 

 

備  考 

本コマンドは，GX Configurator-STがインストールされている場合のみ，実行でき

ます。 

GX Configurator-STがインストールされていない場合は，実行できません。 

 

(a) 基本操作 

[Tools]→[GX Configurator-ST]メニューを選択し，GX Configurator-STを起

動させます。 

 

ポイント  

GX Configurator-DPからGX Configurator-STを起動できますが，終了はできません。

GX Configurator-STを終了する場合は，GX Configurator-STを操作して終了してく

ださい。 
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5.5 Viewメニュー 

Viewメニューは，ツールバーやステータスバーの表示／非表示，またはグラフィカ

ルネットワークエディタの表示を拡大／縮小する機能を含みます。 
 

 

図5-30 Viewメニュー 

 

表5-28 Viewメニューのコマンド 

コマンド 内  容 

Toolbar ツールバーの表示／非表示を切り換えます。 

Statusbar ステータスバーの表示／非表示を切り換えます。 

Zoom In グラフィカルネットワークエディタの表示を拡大します。 

Zoom Out グラフィカルネットワークエディタの表示を縮小します。 

 

(1) Toolbarコマンド 

ツールバーの表示／非表示を切り換えます。 

ツールバーについては，5章(2)(b)を参照してください。 

 

(a) 基本操作 

[View]→[Toolbar]メニューを選択し，ツールバーの表示／非表示を切り換え

ます。 
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(2) Statusbarコマンド 

ステータスバーの表示／非表示を切り換えます。 

ステータスバーには，選択した項目の説明，GX Configurator-DPの状態などを表

示します。 
  

ステータスバー

 

図5-31 ステータスバー 

 

(a) 基本操作 

[View]→[Statusbar]メニューを選択し，ステータスバーの表示／非表示を切

り換えます。 

 

(b) 表示／設定画面 
 

① ② ③ ④

 

図5-32 ステータスバーの表示 

 

表5-29 ステータスバーの項目 

No. 項  目 内  容 

① 選択している項目の説明 選択している項目（メニューなど）の説明が表示されます。 

② 接続先の表示 “Transfer Setup”ダイアログボックスで設定した接続先が表示されます。

③ 自動リフレッシュの有効／無効 

自動リフレッシュの有効／無効が表示されます。 

TO/FROM ：自動リフレッシュ無効 

AutoRefresh ：自動リフレッシュ有効 

④ 
GX IEC Developerのプロジェク

トパス 

“PLC and GX IEC Developer (GID) Settings”ダイアログボックスで設定

した，GX IEC Developerのプロジェクトパスが表示されます。 
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(3) Zoom Inコマンド 

グラフィカルネットワークエディタの表示を拡大します。 

 

備  考 

本コマンドは，マスタユニットのプロジェクトを最前面に表示している場合のみ，

実行できます。 

マスタユニットのプロジェクトを最前面に表示していない場合は，実行できません。 

 

(a) 基本操作 

[View]→[Zoom In]メニューを選択し，グラフィカルネットワークエディタの

表示を拡大します。 

 

(4) Zoom Outコマンド 

グラフィカルネットワークエディタの表示を縮小します。 

 

備  考 

本コマンドは，マスタユニットのプロジェクトを最前面に表示している場合のみ，

実行できます。 

マスタユニットのプロジェクトを最前面に表示していない場合は，実行できません。 

 

(a) 基本操作 

[View]→[Zoom Out]メニューを選択し，グラフィカルネットワークエディタ

の表示を縮小します。 
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5.6 Windowメニュー 

Windowメニューには，ダイアログボックスの配置を操作する機能を含みます。 

 

 

図5-33 Windowメニュー 

 

表5-30 Windowメニューのコマンド 

コマンド 内  容 

Cascade 開いているダイアログボックスを，重ねて表示します。 

Arrange Icons 最小化されたダイアログボックスを整列します。 

1,2,3,… 選択されたプロジェクトのダイアログボックスを，最前面に表示します。 



 

 

 

5 - 47                                         5 - 47 

５ メニュー 
MELSOFT

 

5.7 Helpメニュー 

Helpメニューには，ヘルプを表示する機能，ソフトウェアバージョンを表示する機

能を含みます。 

 

 

図5-34 Helpメニュー 

 

表5-31 Helpメニューのコマンド 

コマンド 内  容 

Index GX Configurator-DPのヘルプを表示します。 

Using Help ヘルプの使い方を表示します。 

About ソフトウェアバージョンを表示します。 

 

(1) Indexコマンド 

GX Configurator-DPのヘルプを表示します。 

 

(a) 基本操作 

[Help]→[Index]メニューを選択すると，GX Configurator-DPのヘルプを表示

させます。 

 

ポイント  

キーボードから F1 キーを入力すると，キー入力時に使用していた機能のヘルプを

表示します。 

 

(2) Using Helpコマンド 

ヘルプの使い方を表示します。 

 

(a) 基本操作 

[Help]→[Using Help]メニューを選択し，ヘルプの使い方を表示させます。 
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(3) Aboutコマンド 

GX Configurator-DPのソフトフェアバージョンを表示します。 

 

(a) 基本操作 

① [Help]→[About]メニューを選択し，“About”ダイアログボックスを表示

させます。 
 

ソフトウェアバージョン

 

 
（GX Configurator-DP Version 7.00Aの場合） 

 

②  OK ボタンをクリックし，“About”ダイアログボックスを閉じます。 
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第６章 マスタユニットのパラメータ設定 

本章では，マスタユニットの各パラメータを設定し，保存する方法を説明します。 

 

(1) 概  要 

マスタユニットの各パラメータ設定は，グラフィカルネットワークエディタから，

各パラメータの設定用ダイアログボックスを表示させて行います。 

グラフィカルネットワークエディタについては，本章(2)を参照してください。 

 

各パラメータの設定後は，プロジェクトを保存します。 

保存方法については，下記を参照してください。 
 

・上書き保存··························· 5.1節(4) 

・名前を付けて保存····················· 5.1節(5) 

 

プロジェクトの保存後は，プロジェクトをマスタユニットに書き込みます。 

詳細については，下記を参照してください。 

・“Download to Module”コマンド······· 5.3節(2)(a) 

・“Module Configuration”ページ······· 10章(3)(d) 
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(2) グラフィカルネットワークエディタ 

グラフィカルネットワークエディタで，各パラメータの設定，スレーブ局の追加

などを行います。 

グラフィカルネットワークエディタは，下記いずれかを行い表示させます。 

・新規にマスタユニットのプロジェクトを作成············3.3.1項 

・既存のマスタユニットのプロジェクトファイルを開く····3.3.2項 
 

ポップアップメニュー

各スレーブユニットの名称，FDLアドレス，イメージ図

マスタユニットの名称，FDLアドレス，イメージ図

PROFIBUSケーブルの
イメージ図

 

 
図6-1 グラフィカルネットワークエディタ 

 

(a) 機能一覧 

グラフィカルネットワークエディタの機能を下記に示します。 

 

表6-1 グラフィカルネットワークエディタの機能一覧 

機  能 内  容 参照項 

マスタパラメータ設定 マスタ局の伝送速度，局番などを設定します。 本章(3)

バスパラメータ設定 PROFIBUS-DPのバスパラメータを設定します。 本章(4)

スレーブ局の追加 PROFIBUS-DPにスレーブ局を追加します。 本章(5)

スレーブ局のコピー PROFIBUS-DP上のスレーブ局をコピーします。 本章(6)

スレーブ局の削除 PROFIBUS-DPからスレーブ局を削除します。 本章(7)

スレーブパラメータの設定 各スレーブ局のパラメータを設定します。 本章(8)
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(b) ポップアップメニュー 

ポップアップメニューは，グラフィカルネットワークエディタ上で右クリッ

クし，表示させます。 
 

 

図6-2 ポップアップメニュー 

 

表6-2 ポップアップメニューの項目 

項  目 内  容 参照項 

Insert DP-Slave＊1 PROFIBUS-DPにスレーブ局を追加します。 本章(5) 

Delete DP-Slave＊2 PROFIBUS-DPからスレーブ局を削除します。 本章(7) 

Duplicate DP-Slave＊2 PROFIBUS-DP上のスレーブ局をコピーします。 本章(6) 

マスタパラメータ 本章(3) 

バスパラメータ 本章(4) Modify Settings＊3 

各パラメータを設定し

ます。 

スレーブパラメータ 本章(8) 

I/O Mapping I/O Mappingを設定します。 8章 

Download to Module 5.3節(2)(a)

Transfer＊4 

プロジェクトのダウン

ロードまたは照合を行

います。 

Verify 
5.3節(2)(b)

 
＊1 ケーブルの図上で右クリックした場合のみ，選択可能です。 

＊2 スレーブ局の図上で右クリックした場合のみ，選択可能です。 

＊3 マスタ局またはスレーブ局の図上で右クリックした場合のみ，選択可能です。 

＊4 マスタ局の図上で右クリックした場合のみ表示します。 
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(3) マスタパラメータ設定 

マスタ局の伝送速度，局番などを設定します。 

 

(a) 基本操作 

① グラフィカルネットワークエディタで下記いずれかを実行し，“Master 

Settings”ダイアログボックスを表示させます。 

・マスタ局の図をダブルクリックします。 

・マスタ局の図上で右クリックし，[ Modify Settings]メニューを選択し

ます。 

② マスタパラメータを設定します。 

マスタパラメータの設定については，本章(3)(b)を参照してください。 

③  OK ボタンをクリックし，マスタパラメータの設定を終了します。 

 

(b) 表示／設定画面 
 

 

図6-3 マスタパラメータ設定（A(1S)J71PB92DとQJ71PB92Vの場合） 

 

表6-3 Master Settingsダイアログボックスの項目 

項  目 内  容 

I/O Mode マスタユニットの動作モードが表示されます。 

Name 
マスタユニットの名称を設定します。 

設定範囲：英数字17文字まで 

Baudrate 
PROFIBUS-DPの伝送速度を設定します。 

設定範囲：9.6kbps～12Mbps（デフォルト：1.5Mbps） 

FDL address 
FDLアドレス（局番）を設定します。 

設定範囲：0～125（デフォルト：0） 

Starting I/O number 

マスタユニットの先頭入出力番号の上2桁を設定します。 

GX Configurator-DPの“POU for GX IEC Developer”コマンドを使用する場合に設定します。 

設定範囲：00H～＊1参照（デフォルト：00H） 
 
＊1 “Starting I/O number”の設定範囲の上限は，マスタユニットを装着しているCPUユニットにより変わります。 

詳細については，CPUユニットのマニュアルを参照してください。 

（次のページへつづく） 
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表6-3 Master Settingsダイアログボックスの項目（続き） 

項  目 内  容 

Error action flag 

マスタユニットから全スレーブ局に対してクリア要求を送信する場合にチェックします。 

1台でもスレーブ局に通信障害が発生すると，全スレーブ局に対してクリア要求が送信されます。

チェックなし：全スレーブ局にクリア要求を送信しない 

チェックあり：全スレーブ局にクリア要求を送信する 

Min. slave interval 

スレーブポーリングサイクルから，次のスレーブポーリングサイクルまでの必要最小時間を設定

します。 

本設定値は，接続しているすべてのスレーブ局に対して有効となります。 

必要時間が最も長いスレーブ局の値を設定してください。 

設定範囲：1～65535（単位：×100μs，デフォルト：＊2参照） 

Polling timeout 
マスタ局間通信時に，リクエスタが応答を受け取るのに要する最大時間を設定します。 

設定範囲：1～65535（単位：×1ms，デフォルト：50×1ms） 

Data control time  

マスタユニットがスレーブ局の動作状態を通知する時間を設定します。 

設定値は，スレーブ局のウォッチドグタイマの設定値に対し，6倍以上の値を設定してください。

設定範囲：1～65535（単位：×10ms，デフォルト：100×10ms） 

Watchdog 

全スレーブ局のウォッチドグタイマを一括で有効にする場合にチェックします。 

マスタパラメータの“Watchdog”をチェックすると，スレーブパラメータの“Watchdog”は設定

できなくなります。 

チェックなし：全スレーブ局のウォッチドグタイマ設定が無効 

チェックあり：全スレーブ局のウォッチドグタイマ設定が有効 

Slave Watchdog time 

全スレーブ局のウォッチドグタイマの値を一括で設定します。 

“Watchdog”をチェック時に，設定可能となります。 

設定範囲：1～65025（単位：×10ms，デフォルト：5×10ms） 

Estimated bus cycle 

time 

バスサイクルタイムの予測最小間隔が表示されます。 

他のマスタユニットとの通信および非周期データ通信などを行った場合，バスサイクルタイムは

表示される値より長くなります。 

本項目に表示される値を使用し，“Min. slave interval”や“Watchdog”を設定する場合は，他

のマスタユニットとの通信および非周期データ通信などの時間を考慮し，十分な時間を設定して

ください。 

バスサイクルタイムについては，マスタユニットのマニュアルを参照してください。 

Autom. Refresh 

自動リフレッシュの有効／無効が表示されます。 

自動リフレッシュの有効／無効は，“PLC and GX IEC Developer (GID) Settings”で設定します。

（5.2節(3)参照） 

チェックなし：自動リフレッシュ無効 

チェックあり：自動リフレッシュ有効 

（次のページへつづく） 
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表6-3 Master Settingsダイアログボックスの項目（続き） 

項  目 内  容 

Consistency 

自動リフレッシュ実行時に，泣き別れ防止機能を使用する場合にチェックします。 

“Autom. Refresh”が有効の場合に，チェック可能となります。 

泣き別れ防止機能については，QJ71PB92□のマニュアルを参照してください。 

チェックなし：泣き別れ防止機能無効 

チェックあり：泣き別れ防止機能有効 

Watchdog for time 

sync. 

タイムマスタからの時計データの送信間隔を監視する時間を設定します。 

マスタユニットがQJ71PB92Vの場合に設定可能になります。 

設定範囲：0～65535（単位：×10ms，デフォルト：0×10ms） 

 
 Bus Param. ボタン 
 

バスパラメータを設定します。 

バスパラメータの設定については，本章(4)を参照してください。 
 
＊2 “Min. slave interval”のデフォルトは，マスタユニットの種類によって下記の値になります。 

・A(1S)J71PB92D ：20×100μs 

・QJ71PB92D ：20×100μs 

・QJ71PB92V ：80×100μs 

・FX3U-64DP-M ：30×100μs 

 

 

ポイント  

伝送速度を変更する場合は，スレーブ局の電源をOFFしてください。 

電源をOFFしないと，スレーブ局は変更された伝送速度に同期できなくなる場合があ

ります。 
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(c) QJ71PB92□以外のユニットのインテリジェント機能ユニットパラメータを設

定する場合 
 

(c-1) GX Developerを使用している場合 

GX Configurator-DPで自動リフレッシュパラメータを書込み後に，GX 

Developerの“Read from PLC”でインテリジェント機能ユニットパラメー

タを読み出してください。 
 

 

図6-4 GX DeveloperのPC読出 
 

上記操作を行わずに，QJ71PB92□以外のユニットのインテリジェント機能

ユニットパラメータをQCPUに書き込むと，設定したQJ71PB92□の自動リフ

レッシュパラメータが削除されます。 

 

備  考 

(1) GX Developerのインテリジェント機能ユニットユーティリティでは，QJ71PB92

□の製品形名を“*”で表示します。 
 

 

図6-5 QJ71PB92□の表示 
 

(2) Webベースオンラインアクセス機能の“Auto Refresh Settings”ページで，自

動リフレッシュパラメータを確認できます。（10章(3)(e)参照） 
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(c-2) GX IEC Developerを使用している場合 

下記の手順で自動リフレッシュをQCPUに書き込んでください。 

下記の手順を行わずに，GX IEC Developerで自動リフレッシュ設定を編集

すると，QJ71PB92□の自動リフレッシュパラメータが削除されます。 
 

① “PLC and GX IEC Developer (GID) Settings”ダイアログボックスで

“AutoRefresh (Update of GID Project)”を選択します。（5.2節(3)

参照） 
 

選択します

 

 
②“PLC and GX IEC Developer (GID) Settings”ダイアログボックスで，

GX IEC Developerのプロジェクトファイルを設定します。（5.2節(3)

参照） 
 

 

 
③ “Download to Module”コマンドで，マスタユニットにパラメータを書

き込むと，GX IEC Developerのプロジェクトに，GX Configurator-DP

で設定した自動リフレッシュパラメータが追加されます。（5.3節(2)

参照） 
 

④ GX IEC Developerからインテリジェント機能ユニットユーティリティを

起動します。 
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⑤ インテリジェント機能ユニットユーティリティで自動リフレッシュを

編集します。 
 

⑥ インテリジェント機能ユニットパラメータを，QCPUに書き込みます。 
 

 

 

備  考 

(1) GX Developerのインテリジェント機能ユニットユーティリティでは，QJ71PB92

□の製品形名を“*”で表示します。 
 

 

図6-6 QJ71PB92□の表示 
 

(2) Webベースオンラインアクセス機能の“Auto Refresh Settings”ページで，自

動リフレッシュパラメータを確認できます。（10章(3)(e)参照） 
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(4) バスパラメータ 

PROFIBUS-DPのバスパラメータを設定します。 

バスパラメータは，通常はデフォルトでご使用ください。 

変更する場合は，PROFIBUS-DPの規格をご理解の上，本章(4)(c)を参照してから変

更してください。 

 

(a) 基本操作 

① “Master Settings”ダイアログボックスの Bus Param. ボタンをクリッ

クします。 

“Master Settings”ダイアログボックスについては，本章(3)を参照して

ください。 

② バスパラメータを設定します。 

バスパラメータの設定については，本章(4)(b)を参照してください。 

③  OK ボタンをクリックし，バスパラメータの設定を終了します。 
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(b) 表示／設定画面 
 

 

図6-7 バスパラメータ 

 

表6-4 バスパラメータダイアログボックスの項目 

項  目 内  容 

Select Baudrate 

PROFIBUS-DPの伝送速度を設定します。 

本ダイアログボックスで設定値を変更すると，“Master Settings”ダイアログボックスの

“Baudrate”の設定値も自動的に変更されます。 

設定範囲：9.6kbps～12Mbps（デフォルト：1.5Mbps） 

Slot Time (T_sl) 

スロット時間（レスポンスを待つ最大時間）を設定します。 

設定時間を超えるとエラーを検出します。 

設定範囲：37～16383（単位：×TBit，デフォルト：伝送速度により異なる） 

min T_sdr 
レスポンダの最小応答時間を設定します。 

設定範囲：11～1023（単位：×TBit，デフォルト：11×TBit） 

max T_sdr 
レスポンダの最大応答時間を設定します。 

設定範囲：37～1023（単位：×TBit，デフォルト：伝送速度により異なる） 

Quiet Time (T_qui) 

リピータ切換え時間（リピータの送信方向切換えに必要な時間）を設定します。 

リピータが存在しない場合は，0に設定してください。 

設定範囲：0～127（単位：×TBit，デフォルト：伝送速度により異なる） 

Setup Time (T_set) 
セットアップ時間を設定します。 

設定範囲：1～255（単位：×TBit，デフォルト：伝送速度により異なる） 

Target Rot. Time (T_tr) 
目標トークン巡回時間を設定します。 

設定範囲：256～16777215（単位：×TBit，デフォルト：50000×TBit） 

GAP factor 
GAPアップデート時間(T_gud)を制御する定数を設定します。 

設定範囲：1～100（デフォルト：10） 

HSA 
回線上に存在するスレーブ局の最大局番を設定します。 

設定範囲：2～126（デフォルト：126） 

Max retry limit 
各送信データの最大リトライ回数を設定します。 

設定範囲：1～7（デフォルト：伝送速度により異なる） 
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ポイント  

伝送速度を変更する場合は，スレーブ局の電源をOFFにしてください。 

電源をOFFにしないと，スレーブ局は変更した伝送速度に同期できない場合があり

ます。 

 

備  考 

単位[TBit]（Bit Time）は，1 ビットのデータを送信するために必要な時間を“1”

として表す単位です。 

実際の処理時間は伝送速度により下記のように異なります。 

・1.5Mbpsの場合 1[TBit] ＝ 1 ÷ (1.5 × 10
6
) ＝ 0.667 × 10

-6
[s] 

・12Mbpsの場合  1[TBit] ＝ 1 ÷ (12 × 10
6
)  ＝ 0.083 × 10

-6
[s] 

GX Configurator-DPでは，TBitからmsへの換算を自動で行います。 

msへの換算結果は，画面右側に表示されます。 

 

(c) 注意事項 

バスパラメータの設定値は，下記計算式を満たす値を設定してください。 

下記計算式を満たしていない場合は， OK ボタンをクリックしたときにエ

ラーメッセージを表示します。 

 

Quiet Time (T_qui) ＜ min T_sdr ＜ max T_sdr ＜ Slot Time (T_sl) 

 ＜ Target Rot. Time (T_tr) 
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(5) スレーブ局の追加 

PROFIBUS-DPにスレーブ局を追加します。 

 

ポイント  

すでに追加されているスレーブ局より局番が小さいスレーブ局を追加した場合，

バッファメモリの再割り付けが行われます。 

パラメータ修正後は，シーケンスプログラムおよび自動リフレッシュ設定の見直し

を行ってください。 

詳細については，マスタユニットのマニュアルを参照してください。 
 

追　加6144(1800H)～6156(180CH)

6157(180DH)～6160(1810H)

6144(1800H)～6150(1806H)

6151(1807H)～6163(1813H)

6164(1814H)～6167(1817H)

追加前 追加後

 

図6-8 バッファメモリの再割り付けイメージ（QJ71PB92Vの例） 

 

(a) 基本操作 

① グラフィカルネットワークエディタのケーブルの図上で右クリックし，

[Insert DP-Slave]メニューを選択して，“Device Database”ダイアログ

ボックスを表示させます。 

“Device Database”ダイアログボックスについては，本章(5)(b)を参照

してください。 

② PROFIBUS-DPに追加するスレーブ局を選択します。 

③  OK ボタンをクリックし，“Slave Parameter Settings”ダイアログボッ

クスを表示させます。 

“Slave Parameter Settings”ダイアログボックスについては，本章(8)

を参照してください。 

④ スレーブパラメータを設定します。 

⑤  OK ボタンをクリックし，グラフィカルネットワークエディタ上にスレー

ブ局を追加させます。 
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(b) 表示／設定画面 
 

 

図6-9 Device Databaseダイアログボックス 

 

表6-5 Device Databaseダイアログボックスの項目 

項  目 内  容 

GSD Database 

追加するスレーブ局のGSDデータが保存されている場所を選択します。 

Global ：GX Configurator-DP内部のGSDデバイスデータベース 

Project ：プロジェクトファイル 

Slave Device Group 

Available Slave Systems 

Vendor 

Revision 

Ident-No. 

Bitmap 

GSD-/DDB-File 

Bitmap-File 

 Replace Bitmap ボタン以外は，メニューバーから開いた“Device Database”ダイア

ログボックスと同じです。 

メニューバーから開いた“Device Database”ダイアログボックスについては，5.2節(2)

を参照してください。 

 Replace Bitmap ボタンは使用できません。 

 
 Add ボタン 
  
 Delete ボタン 
  
 Group ボタン 
 

使用できません。 
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(6) スレーブ局のコピー 

PROFIBUS-DPのスレーブ局をコピーします。 

同じ設定のスレーブ局を複数台使用する場合などに，スレーブ局をコピーすると

設定内容もコピーされるため，設定作業を減らすことができます。 

 

(a) 基本操作 

① コピーするスレーブ局の図上で右クリックし，[Duplicate DP-Slave]メ

ニューを選択して，スレーブ局をコピーさせます。 
 

 

 
② スレーブパラメータの“Name”および“FDL Address”を変更します。 

“Name”および“FDL Address”が他のスレーブ局と重複していると，プ

ロジェクトを保存できなくなります。 

スレーブパラメータの変更方法については，本章(8)を参照してください。 

 

ポイント  

スレーブ局をコピーしたときに，すでに追加されているスレーブ局より局番が小さ

いスレーブ局が増えた場合は，バッファメモリの再割り付けが行われます。 

パラメータ修正後は，シーケンスプログラムおよび自動リフレッシュ設定の見直し

を行ってください。 

詳細については，マスタユニットのマニュアルを参照してください。 
 

コピー6144(1800H)～6156(180CH)

6157(180DH)～6160(1810H)

6144(1800H)～6156(180CH)

6157(180DH)～6169(1819H)

6170(181AH)～6173(181DH)

コピー前 コピー後

 

図6-10 バッファメモリ再割り付けイメージ（QJ71PB92Vの例） 
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(7) スレーブ局の削除 

スレーブ局の削除は，グラフィカルネットワークエディタで行います。 

 

ポイント  

局番が一番大きいスレーブ局以外のスレーブ局を削除した場合，バッファメモリの

再割り付けが行われます。 

パラメータ修正後は，シーケンスプログラムの見直しを行ってください。 

詳細については，マスタユニットのマニュアルを参照してください。 
 

削　除 6144(1800H)～6156(180CH)

6157(180DH)～6160(1810H)

6144(1800H)～6150(1806H)

6151(1807H)～6163(1813H)

6164(1814H)～6167(1817H)

削除前 削除後

 

図6-11 バッファメモリの再割り付けイメージ（QJ71PB92Vの例） 

 

(a) 基本操作 

① 下記いずれかを行い，スレーブ局を削除します。 

・削除するスレーブ局の図上で右クリックし，[Delete DP-Slave]を選択

します。 

・削除するスレーブ局の図を選択し，キーボードから Delete キーを入力

します。 
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(8) スレーブパラメータの設定 

各スレーブ局のパラメータを設定します。 

 

(a) 基本操作 

① 下記いずれかを実行し，“Slave Parameter Settings”ダイアログボック

スを表示させます。 

・スレーブ局の図をダブルクリックします。 

・スレーブ局の図上で右クリックし，[Modify Settings]メニューを選択

します。 

② スレーブパラメータを設定します。 

スレーブパラメータの設定については，本項(8)(b)を参照してください。 

③  OK ボタンをクリックし，スレーブパラメータの設定を終了します。 

 

(b) 表示／設定画面 
 

 

図6-12 Slave Parameter Settingsダイアログボックス 

 

表6-6 Slave Parameter Settingsダイアログボックスの項目 

項  目 内  容 

Name 
スレーブ局の名称を設定します。 

設定範囲：英数字17文字まで 

FDL Address 
FDLアドレス（局番）を設定します。 

設定範囲：0～125 

Watchdog 

ウォッチドグタイマを使用する場合にチェックします。 

本設定を行うと，“Slave Watchdog time”で設定した時間内に，マスタユニットから

データを受信しないと通信異常を検出します。 

（設定を行わない場合は，マスタユニットからデータを受信しなくなっても通信異常を

検出しません。） 

マスタパラメータの“Watchdog”をチェックすると，スレーブパラメータの“Watchdog”

は設定できなくなります。 

チェックなし：ウォッチドグタイマ無効（デフォルト） 

チェックあり：ウォッチドグタイマ有効 

 

通信異常時の出力データが，スレーブ局から外部機器へ出力されるかは，スレーブ局の

設定により異なります。 

詳細については，スレーブ局のマニュアルを参照してください。 
 

（次のページへつづく） 
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表6-6 Slave Parameter Settingsダイアログボックスの項目(続き) 

項  目 内  容 

Slave Watchdog time 

ウォッチドグタイマの時間を設定します。 

“Watchdog”をチェック時に，設定可能となります。 

設定値は，下記を満たす範囲内で設定してください。 

 
バスサイクルタイム≦“Slave Watchdog time”の設定値≦(“Data control time”の設

定値)÷6 

 
設定範囲：1～65025（単位：×10msまたは×1ms，デフォルト：5×10ms） 

min T_sdr 

スレーブ局がマスタユニットへ応答フレームを送信するまでの最小応答時間を設定し

ます。 

通常はデフォルト値を使用してください。 

設定範囲：1～255（単位：×TBit，デフォルト：11×TBit） 

Group identification number

スレーブ局のグループNo.(Grp 1～Grp 8)を設定します。 

複数のグループNo.を設定することも可能です。 

チェックなし：該当グループNo.に未所属 

チェックあり：該当グループNo.に所属 

Slave is active 

スレーブ局を予約局として設定する場合にチェックをはずします。 

チェックなし：予約局に設定 

チェックあり：入出力データ交信を行う局に設定 

Sync (Output) 

初期化交信時に，スレーブ局がSync機能に対応しているか確認する場合にチェックしま

す。 

スレーブ局がSync機能に対応していない場合，マスタユニットの通信障害情報エリアに

障害情報が格納されます。 

スレーブ局が本機能に対応している場合に設定可能になります。 

チェックなし：機能チェックを行わない 

チェックあり：機能チェックを行う 

Freeze (Input) 

初期化交信時に，スレーブ局がFreeze機能に対応しているか確認する場合にチェックし

ます。 

スレーブ局がFreeze機能に対応していない場合，マスタユニットの通信障害情報エリア

に障害情報が格納されます。 

スレーブ局が本機能に対応している場合に設定可能になります。 

チェックなし：機能チェックを行わない 

チェックあり：機能チェックを行う 

Ignore AutoClear 

マスタパラメータの“Error action flag”の設定を有効にしたときに，このスレーブ

局の通信障害検出でクリア要求を送信したくない場合にチェックします。 

マスタパラメータの“Error action flag”の設定を有効にした場合に設定可能となり

ます。 

チェックなし：“Error action flag”の設定を有効にする 

チェックあり：“Error action flag”の設定を無効にする 

Initialize slave when failing 

to respond 

スレーブ局が通信異常から復帰するときに，マスタ局がスレーブ局にパラメータを再送

する場合にチェックします。 

チェックなし：スレーブ局にパラメータを再送しない 

チェックあり：スレーブ局にパラメータを再送する 

Swap I/O Bytes in Master 

スレーブ局の入出力データを，QJ71PB92□またはFX3U-64DP-Mのバッファメモリ上でス

ワップさせる場合にチェックします。 

マスタユニットがQJ71PB92□またはFX3U-64DP-Mの場合に，設定可能になります。 

チェックなし：スワップさせない 

チェックあり：スワップさせる 
 

（次のページへつづく） 
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表6-6 Slave Parameter Settingsダイアログボックスの項目（続き） 

項  目 内  容 

 

 DP V1/V2 Slave Parameters 

ボタン 

PROFIBUS-DPV1機能を使用する場合に設定します。 

下記の条件をすべて満たしている場合に，設定可能になります。 

・マスタユニットがQJ71PB92VまたはFX3U-64DP-Mの場合 

・スレーブ局がPROFIBUS-DPV1機能に対応している場合 

・スレーブ局のGSDファイルで，“DPV1_Slave”の項目に“1”が設定されている場合

“DP V1/V2 Slave Parameters”ダイアログボックスについては，本項(8)(b-1)を参照

してください。 

 
 User Param. ボタン 
 

スレーブ局独自のパラメータを設定します。 

スレーブ局が本機能に対応している場合に設定可能になります。 

詳細については，本項(8)(b-3)を参照してください。 

 
 Select Modules ボタン 
 

スレーブ局に装着されているユニットを設定します。 

スレーブ局が本機能に対応している場合に設定可能になります。 

詳細については，本項(8)(b-2)を参照してください。 
 



 

 

 
 

6 - 20                                         6 - 20 

 

６ マスタユニットのパラメータ設定 
MELSOFT

 

(b-1) DP V1/V2 Slave Parameters 

PROFIBUS-DPV1/V2機能のスレーブパラメータを設定します。 

 

“DP V1/V2 Slave Parameters”ダイアログボックスは，“Slave Parameter 

Settings”ダイアログボックスで， DP V1/V2 Slave Parameters ボタンを

クリックして表示させます。 
 

 

図6-13 DP V1/V2 Slave Parameters 

 

表6-7 DP V1/V2 Slave Parametersダイアログボックスの項目 

項  目 内  容 

DP V1 support enabled 

PROFIBUS-DPV1機能を使用する場合に設定します。 

チェックなし：PROFIBUS-DPV1機能を無効にする 

チェックあり：PROFIBUS-DPV1機能を有効にする 

Watchdog timebase 1ms 

“Slave Watchdog time”の単位を1msにする場合にチェックします。 

スレーブ局が本機能に対応している場合に設定可能となります。 

マスタパラメータの“Watchdog”のチェックをはずした場合に，設定可能となります。 

チェックなし：10ms単位 

チェックあり：1ms単位 

‘Fail Safe’ function 
enable 

マスタ局からのクリア要求の送信時に，スレーブ局を‘Fail Safe’状態にする場合にチェックし

ます。 

スレーブ局が本機能に対応している場合に設定可能となります。 

‘Fail Safe’状態の設定については，スレーブ局のマニュアルを参照してください。 

チェックなし：‘Fail Safe’状態にしない 

チェックあり：‘Fail Safe’状態にする 

Slave-specific check of 

cfg_data 

スレーブ局のパラメータチェックの方法が，PROFIBUS標準のパラメータチェック方法と異なる

場合にチェックします。 

スレーブ局が本機能に対応している場合に設定可能となります。 

パラメータチェックの方法については，スレーブ局のマニュアルを参照してください。 

チェックなし：PROFIBUS標準のパラメータチェックを行う 

チェックあり：スレーブ局特有の方法でパラメータチェックを行う 

（次のページへつづく） 
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表6-7 DP V1/V2 Slave Parametersダイアログボックスの項目（続き） 

項  目 内  容 

Update Alarm 

Update Alarmの送信を許可する場合にチェックします。 

スレーブ局が本機能に対応している場合に設定可能となります。 

チェックなし：Update Alarm送信禁止 

チェックあり：Update Alarm送信許可 

Status Alarm 

Status Alarmの送信を許可する場合にチェックします。 

スレーブ局が本機能に対応している場合に設定可能となります。 

チェックなし：Status Alarm送信禁止 

チェックあり：Status Alarm送信許可 

Manufacturer Specific 

Alarm 

Manufacturer Specific Alarmの送信を許可する場合にチェックします。 

スレーブ局が本機能に対応している場合に設定可能となります。 

チェックなし：Manufacturer Specific Alarm送信禁止 

チェックあり：Manufacturer Specific Alarm送信許可 

Diagnostic Alarm 

Diagnostic Alarmの送信を許可する場合にチェックします。 

スレーブ局が本機能に対応している場合に設定可能となります。 

チェックなし：Diagnostic Alarm送信禁止 

チェックあり：Diagnostic Alarm送信許可 

Process Alarm 

Process Alarmの送信を許可する場合にチェックします。 

スレーブ局が本機能に対応している場合に設定可能となります。 

チェックなし：Process Alarm送信禁止 

チェックあり：Process Alarm送信許可 

Pull/Plug Alarm 

Pull/Plug Alarmの送信を許可する場合にチェックします。 

スレーブ局が本機能に対応している場合に設定可能となります。 

チェックなし：Pull/Plug Alarm送信禁止 

チェックあり：Pull/Plug Alarm送信許可 

Allow max. one alarm of 

each type 

スレーブ局が複数タイプのアラームを検出したときに，アラームをタイプごとに1件ずつ取得

する場合にチェックします。 

チェックなし：発生したアラームを順に取得する（最大8件） 

チェックあり：発生したアラームをタイプごとに1件ずつ取得する（最大6件） 
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(b-2) Slave Modules 

スレーブ局に装着されているユニットを設定します。 

 

“Slave Modules”ダイアログボックスは，“Slave Parameter Settings”

ダイアログボックスで Select Modules ボタンをクリックして表示させま

す。 

 

ポイント  

“Slave Modules”ダイアログボックスでユニットの構成を変更した場合，バッファ

メモリの再割り付けが行われます。 

変更後は，シーケンスプログラムおよび自動リフレッシュ設定の見直しを行ってく

ださい。 

詳細については，スレーブユニットのマニュアルを参照してください。 
 

例：7ワードの入力ユニットを追加した場合 
 

追　加6144(1800H)～6156(180CH)

6157(180DH)～6160(1810H)

6144(1800H)～6150(1806H)

6151(1807H)～6163(1813H)

6164(1814H)～6167(1817H)

追加前 追加後

 

図6-14 バッファメモリの再割り付けイメージ（QJ71PB92Vの例） 

 

 

■ 基本操作 

① スレーブ局に装着しているユニットを，“Installed Module”に追加

／削除します。 
 

①-1 Installed Moduleの追加操作 

①-1-1 “Available Modules”で追加するユニットを選択します。 

①-1-2 “Installed Module”でユニットの追加位置を選択しま

す。 

①-1-3 下記いずれかを行うと，“Installed Module”にユニッ

トを追加します。 

・ Add before ボタンをクリックし，①-1-2で選択した位

置の前にユニットを追加します。 

・ Add after ボタンをクリックし，①-1-2で選択した位

置の後にユニットを追加します。 
 

①-2 Installed Moduleの削除操作 

①-2-1 “Installed Module”で，削除するユニットを選択しま

す。 

①-2-2  Remove ボタンをクリックし，①-2-1で選択したユニッ

トを削除します。 
 

②  OK ボタンをクリックすると，設定を終了します。 
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■ 表示／設定画面 
 

 

図6-15 Slave Modulesダイアログボックス 

 

 

表6-8 Slave Modulesダイアログボックスの項目 

項  目 内  容 

Info 設定内容に合わせて，スレーブ局の情報を自動で計算して表示されます。 

 Modules installed “Installed Module”に追加されたユニット数が表示されます。 

 are possible “Installed Module”に追加可能な最大ユニット数が表示されます。 

 Max. Data size スレーブ局の最大データ容量が表示されます。 

 I/O usage “Installed Module”に追加されたユニットの，合計入出力点数が表示されます。 

 Max. I/O sizes スレーブ局の最大入出力点数が表示されます。 

 
User_Prm_Data usage 

“Installed Module”に追加されたユニットの，ユーザパラメータのデータサイズの合

計が表示されます。 

 Max. User_Prm_Data size スレーブ局の最大ユーザパラメータ容量が表示されます。 

Module Configuration スレーブ局に追加するユニットを選択します。 

 

Available Modules 

追加可能なユニットの一覧を表示します。 

GSD(GDD)ファイルにユニットの記述がない場合は，“Universal”と表示します。 

“Universal”と表示された場合については，本項(8)(b-2-1)を参照してください。 

 
 Add before ボタン 

“Installed Module”で選択した位置（＊1）の前に，“Available Modules”で選択した

ユニットを追加します。 

 
 Add after ボタン 

“Installed Module”で選択した位置（＊2）の後に，“Available Modules”で選択した

ユニットを追加します。 

 
 Remove ボタン “Installed Module”で選択したユニットを削除します。 

 

Installed Module 

スレーブ局に追加するユニットの，スロット番号とユニット名の一覧が表示されます。

GSD(GDD)ファイルにユニットの記述がない場合は，“Universal”と表示されます。 

“Universal”と表示された場合については，本項(8)(b-2-1)を参照してください。 
 
＊1 “Installed Module”で位置を選択していない場合は，“Installed Module”の先頭にユニットが追加されます。 

＊2 “Installed Module”で位置を選択していない場合は，“Installed Module”の最後にユニットが追加されます。 
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■ Slave Modulesダイアログボックスの注意事項 

・マスタユニットが，A(1S)J71PB92DまたはQJ71PB92Dの通常サービスモー

ド(MODE 0)の場合，“I/O usage”は“32 / 32”まで設定できます。 

・“I/O usage”と“User_Prm_Data size”がそれぞれの最大値を超えた

場合は，エラーメッセージが表示されます。 

“Installed Module”へ追加したユニットを見直してください。 
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(b-2-1) Universalのユニットについて 

GSD(DDB)ファイルにユニットの記述がない場合，ユニット名は

“Universal”と表示されます。 
 

 

図6-16 Slave Modulesダイアログボックス（ユニットがUniversalの場合） 

 

“Universal”と表示されたユニットには，入出力点数を設定できます。 

 

■ 基本操作 

① “Installed Module”のユニットをダブルクリックし，

“Universal Module Settings”ダイアログボックスを表示させ

ます。 

② ユニットの入出力点数を設定して OK ボタンをクリックし，設

定を終了します。 

 

ポイント  

“Universal”と表示されたユニットの入出力点数を設定した場合は，ユニットの

マニュアルを参照して，設定が間違っていないことを確認してください。 

設定が間違っていると，正常に動作しない場合があります。 
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■ 表示／設定画面 
 

 

図6-17 Universal Module Settingsダイアログボックス 

 

表6-9 Universal Module Settingsダイアログボックスの項目 

項  目 内  容 

Consistency 

泣き別れを防止する入出力データの単位を選択します。 

泣き別れ防止機能は，“Master Settings”ダイアログボックスで有効にできます。 

“Master Settings”ダイアログボックスについては，6章(3)(b)を参照してください。 

Byte/Word ：ByteまたはWord単位で，泣き別れを防止します。 

Complete ：本ユニットの入出力データ全体で，泣き別れを防止します。 

Input/Output 

ユニットで扱う入出力データの種類を選択します。 

Inputs only ：入力データのみを扱います。 

Outputs only ：出力データのみを扱います。 

In- and Outputs ：入力データと出力データを扱います。 

Data Size Unit “Input Length”および“Output Length”で設定する，入出力データの単位を選択します。

Input Length 

入力データのサイズを設定します。 

“Input/Output”で“Inputs only”または“In- and Outputs”を選択している場合に，設

定可能になります。 

設定範囲：0～16（単位は“Data Size Unit”の選択により異なる） 

Output Length 

出力データのサイズを設定します。 

“Input/Output”で“Outputs only”または“In- and Outputs”を選択している場合に，設

定可能になります。 

設定範囲：0～16（単位は“Data Size Unit”の選択により異なる） 
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(b-3) Extended User Parameters 

スレーブ局のユーザパラメータを設定します。 

 

“Extended User Parameters”ダイアログボックスは，“Slave Parameter 

Settings”ダイアログボックスで User Param. ボタンをクリックして表示

させます。 

 

設定するユーザパラメータの種類は，スレーブ局により変わります。 

設定するユーザパラメータについては，スレーブ局のマニュアルを参照し

てください。 

 

備  考 

ユーザパラメータは，プロジェクトのダウンロード時にマスタユニットへ書き込み，

入出力データ交信を開始すると，各スレーブ局に送信します。 

 

■基本操作 

① “Parametrize DP Slave/Module”のタブでユーザパラメータを設定す

るユニットを選択します。 

 

② ユーザパラメータを“Value Settings”のメニューから選択して設定

します。 

 

パラメータの名称などが隠れて表示されない場合は，タイトル行を操

作して表示幅を変更してください。 
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■表示／設定画面 

 

図6-18 Extended User Parametersダイアログボックス 

 

表6-10 Extended User Parametersダイアログボックスの項目 

項  目 内  容 

Parameter Location “Parameter DP Slave/Module”に表示しているユニットの情報が表示されます。 

 Module Slot Number 

“Parametrize DP Slave/Module”に表示しているユニットの，スロット番号が表示されます。

“Parametrize DP Slave/Module”に表示しているユニットが，スロット番号を持たない場合

は，“--”が表示されます。 

 
User_Prm_Data 

Offset 

“Parametrize DP Slave/Module”に表示しているユーザパラメータについて，ユーザパラメー

タ全体に対する位置が，オフセット値で表示されます。 

 
User_Prm 

_Data_Size 
ユーザパラメータの容量がバイト単位で表示されます。 

 
Edit Unsigned as 

hex 

“Hex Editor”使用時に，符号なし16進数でユーザパラメータを編集する場合に，チェック

します。 

チェックなし：符号付き16進数でユーザパラメータを編集 

チェックあり：符号なし16進数でユーザパラメータを編集 

Parametrize DP 

Slave/Module 
ユーザパラメータを設定します。 

 
 Edit Hex ボタン 
 

“Slave User Parameters”ダイアログボックスの“Hex Editor”を使用して，ユーザパラメー

タを数値入力して直接編集します。 

“Hex Editor”については，本項(8)(b-3-1)を参照してください。 
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(b-3-1) Slave User Parameters 

ユーザパラメータを数値入力して直接編集します。 

 

“Slave User Parameters”ダイアログボックスは，“Extended User 

Parameters”ダイアログボックスで Edit Hex ボタンをクリックし

て表示させます。 

 

ポイント  

“Hex Editor”でユーザパラメータを編集する場合は，ユーザパラメータをご理解

の上，編集してください。 

間違った編集を行うと，正常に動作しなくなる場合があります。 

ユーザパラメータの構造については，各スレーブ局のメーカにお問い合わせくださ

い。 
 

“Extended User Parameter”ダイアログボックスで
選択していたユニットのユーザパラメータが，
緑色で表示されます。

マウスカーソルを重ねた場所の，
アドレスとパラメータの値が表示されます。

カーソルの位置を示す印が
表示されます。

 

図6-19 Slave User Parametersダイアログボックス 
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(9) プロジェクト保存 

各パラメータの設定後，プロジェクトを保存します。 

保存方法については，下記を参照してください。 
 

・上書き保存··························· 5.1節(4) 

・名前を付けて保存····················· 5.1節(5) 
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第７章 スレーブユニットのパラメータ設定 

本章では，スレーブユニットの各パラメータを設定し，保存する方法を説明します。 

 

(1) 概要 

スレーブユニットのパラメータ設定は，スレーブパラメータ設定用ダイアログ

ボックスで行います。 

パラメータ設定については，本章(2)を参照してください。 

 

パラメータの設定後は，プロジェクトを保存します。 

プロジェクトの保存については，5.1節(4)，5.1節(5)を参照してください。 

 

プロジェクトの保存後は，プロジェクトをスレーブユニットに書き込みます。 

詳細については，10章(3)(h)を参照してください。 

 

(2) パラメータ設定 

スレーブパラメータ設定用ダイアログボックスで，スレーブパラメータの設定を

行います。 

 

備  考 

スレーブパラメータ設定用ダイアログボックスは，下記のいずれかを行うと表示さ

せることができます。 

・新規にスレーブユニットのプロジェクトを作成················5.1節(1)  

・既存のスレーブユニットのプロジェクトファイルを開く········5.1節(2) 
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(a) 表示／設定画面 
 

 

図7-1 スレーブパラメータ設定用ダイアログボックス 

 

表7-1 スレーブパラメータ設定用ダイアログボックスの項目 

項  目 目  的 

FDL_address 
FDLアドレス（局番）を設定します。 

設定範囲：0～125 

Enable 

QCPUのデバイスとスレーブユニットのバッファメモリを自動リフレッシュする場合にチェッ

クします。 

自動リフレッシュについては，PROFIBUS-DPスレーブユニットユーザーズマニュアル（詳細編）

を参照してください。 

チェックなし：自動リフレッシュ無効 

チェックあり：自動リフレッシュ有効 

Consistency 

自動リフレッシュ実行時に，泣き別れ防止機能を使用する場合にチェックします。 

“Enable”をチェック時に，チェック可能となります。 

泣き別れ防止機能については，PROFIBUS-DPスレーブユニットユーザーズマニュアル（詳細編）

を参照してください。 

チェックなし：泣き別れ防止機能無効 

チェックあり：泣き別れ防止機能有効 

Input Size スレーブユニットからCPUユニットに転送するデータのワード数を設定します。 

Output Size CPUユニットからスレーブユニットに転送するデータのワード数を設定します。 

Input CPU Device 
スレーブユニットの出力受信エリアのデータを，CPUユニットに転送する場合のデータ格納先

デバイスを設定します。 

Output CPU Device 
CPUユニットのデータを，スレーブユニットの入力送信エリアに転送する場合のデータ格納先

デバイスを設定します。 
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(a-1) Autom. Refresh 

自動リフレッシュパラメータは，プロジェクトをスレーブユニットへダウ

ンロードするときに，QCPUに書き込みます。 

GX Configurator-DPで自動リフレッシュパラメータの設定後に，GX 

Developer/GX IEC Developerで他のインテリジェント機能ユニットの自動

リフレッシュパラメータを設定できます。 

詳細については，本章(2)(c)を参照してください。 

 

(b) 自動リフレッシュパラメータの設定個数について 

QCPUに設定可能な自動リフレッシュパラメータの設定個数には，制限があり

ます。 

自動リフレッシュパラメータは，下記に示す設定個数を超えないように設定

してください。 
 

(b-1) 全インテリジェント機能ユニットの自動リフレッシュパラメータ設定個数 

複数のインテリジェント機能ユニットを装着した場合，下記の設定個数を

超えないように自動リフレッシュパラメータを設定してください。 
 

表7-2 最大自動リフレッシュパラメータ設定個数 

CPUタイプ 最大自動リフレッシュパラメータ設定個数 

Q00J/Q00/Q01CPU 256 

Q02/Q02H/Q06H/Q12H/Q25HCPU 256 

Q12PH/Q25PHCPU 256 

Q12PRH/Q25PRHCPU 256 

 
(b-2) QJ71PB93Dの自動リフレッシュパラメータ設定個数 

QJ71PB93Dの自動リフレッシュパラメータ設定個数は，1ユニットあたり下

記のとおりです。 
 

表7-3 QJ71PB93Dの自動リフレッシュパラメータ設定個数 

対象ユニット 自動リフレッシュ設定 

QJ71PB93D 2（最大設定数） 
 

 

この1行で設定個数を1個と数えます。
デバイスが未設定の場合は，個数に数えません。

 

図7-2 QJ71PB93Dの自動リフレッシュパラメータ設定個数 
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(c) QJ71PB93D以外のユニットのインテリジェント機能ユニットパラメータを設定

する場合 
 

(c-1) GX Developerを使用している場合 

GX Configurator-DPで自動リフレッシュパラメータを書込み後に，GX 

Developerの“Read from PLC”でインテリジェント機能ユニットパラメー

タを読み出してください。 
 

 

図7-3 GX DeveloperのPC読出 
 

上記操作を行わずに，QJ71PB93D以外のユニットのインテリジェント機能ユ

ニットパラメータをQCPUに書き込むと，設定したQJ71PB93Dの自動リフレッ

シュパラメータが削除されます。 

 

備  考 

(1) GX Developerのインテリジェント機能ユニットユーティリティでは，QJ71PB93D

の製品形名を“*”で表示します。 
 

 

図7-4 QJ71PB93Dの表示 
 

(2) Webベースオンラインアクセス機能の“Auto Refresh Settings”ページで，自

動リフレッシュパラメータを確認できます。（10章(3)(e)参照） 
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(c-2) GX IEC Developerを使用している場合 

下記の手順で自動リフレッシュをQCPUに書き込んでください。 

下記の手順を行わずに，GX IEC Developerで自動リフレッシュ設定を編集

すると，QJ71PB93Dの自動リフレッシュパラメータが削除されます。 
 

① “PLC and GX IEC Developer (GID) Settings”ダイアログボックスで

“AutoRefresh (Update of GID Project)”を選択します。（5.2節(3)参

照） 
 

選択します

 

 
② “PLC and GX IEC Developer (GID) Settings”ダイアログボックスで，

GX IEC Developerのプロジェクトファイルを設定します。（5.2節(3)参照） 
 

 

 
③ “Download to Module”コマンドで，マスタユニットにパラメータを書き

込むと，GX IEC Developerのプロジェクトに，GX Configurator-DPで設定

した自動リフレッシュパラメータが追加されます。（5.3節(2)参照） 
 

④ GX IEC Developerからインテリジェント機能ユニットユーティリティを起

動します。 
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⑤ インテリジェント機能ユニットユーティリティで自動リフレッシュを編

集します。 
 

⑥ インテリジェント機能ユニットパラメータを，QCPUに書き込みます。 
 

 

 

備  考 

(1) GX Developerのインテリジェント機能ユニットユーティリティでは，QJ71PB93D

の製品形名を“*”で表示します。 
 

 

図7-5 QJ71PB93Dの表示 
 

(2) Webベースオンラインアクセス機能の“Auto Refresh Settings”ページで，自

動リフレッシュパラメータを確認できます。（10章(3)(e)参照） 
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第８章 I/O Mapping 

I/O Mappingは，入出力データへアクセスするプログラミング作成を容易にします。 

 

I/O Mappingを使用すると，GX IEC Developerのプログラムで下記を実施できるよう

になります。 

・ CPUユニットの出力(Y)をマスタユニットのバッファメモリに，データの転送がで

きます。 

・ マスタユニットのバッファメモリからCPUユニットの入力(X)へ，データの転送が

できます。 

・ スレーブ局の各ユニットのDUT(Data Unit Types)を作成できます。 

・ ユーザが定義した任意のデバイスを使用して，入出力データにアクセスできます。 

・ 入出力データ交信を開始できます。 

・ 通信障害情報エリア，拡張通信障害情報エリア，およびスレーブステータスエリ

アの情報を，任意のデバイスにコピーできます。 

・ グローバル変数で入出力データを参照できます。 

マスタユニットの入力データエリア／出力データエリアにおける，スレーブ局の

入出力データのオフセットを計算する必要がありません。 

 

備  考 

I/O Mappingは，下記ユニット（モード）でのみ使用可能です。 

・ QJ71PB92V 

・ QJ71PB92D（拡張サービスモード(MODE E)） 

・ A(1S)J71PB92D（拡張サービスモード（MODEスイッチ：No.E）） 

・ FX3U-64DP-M（FX3U-64DP-Mの場合はCopy POUを作成します。 

Copy POUについてはFX3U-64DP-Mのマニュアルを参照してください。） 

上記以外のユニット（モード）については，I/O Mappingを使用できません。 

 

 

(1) 基本操作 

① グラフィカルネットワークエディタのスレーブ局の図上で右クリックし，

[I/O Mapping]メニューを選択して，“I/O Mapping”ダイアログボックス

を表示させます。 

② ツリー表示で設定するユニットを選択し，一覧表示に表示されたDUTを設

定します。 

ツリー表示および一覧表示については，本章(2)を参照してください。 

③  OK ボタンをクリックし，“I/O Mapping”ダイアログボックスを閉じま

す。 

④ [File]→[Export]→[POU for GX IEC Developer]メニューをクリックして

POUをエクスポートすると，一緒にユーザライブラリをエクスポートしま

す。 

⑤ GX IEC Developerでユーザライブラリをインポートすると，機能が追加さ

れます。 
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８ I/O Mapping 
MELSOFT

 

(2) 表示／設定画面 
 

ツリー表示 一覧表示

 

図8-1 I/O Mappingダイアログボックス 

 

(a) ツリー表示 

 

最上位階層には，マスタユニットの
ユニット形名が表示されます。

第3階層には，スレーブ局に装着された
各ユニットのユニット形名が表示されます。

第2階層には，スレーブ局について
下記情報が表示されます。
・FDLアドレス
・“Slave Parameter Settings”
　ダイアログボックスで設定した
　スレーブ局の名称
・ユニット形名  

図8-2 ツリー表示 

 

(b) 一覧表示 

ツリー表示でスレーブ局のユニットを選択すると，一覧表示に下記DUTの要素

が表示されます。 

 

表8-1 一覧表示の項目 

項  目 内  容 

DUT Var. Identifier DUTのグローバル変数インスタンスの名称が，自動的に作成されて表示されます。 

Identifier DUTの要素の名前が表示されます。 

DUT Type DUTの要素またはグローバル変数のデータタイプが表示されます。 

Number Elements 
要素の数が表示されます。 

本項目が2以上の場合は，要素が配列であることを意味します。 

（次のページへつづく） 
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表8-1 一覧表示の項目（続き） 

項  目 内  容 

Class 

扱うデータについて，入力データか出力データかが表示されます。 

 input：入力データ 

 output：出力データ 

Global Var.  

Identifier  

任意のグローバル変数名を設定します。 

設定すると，プログラミング時に任意のグローバル変数名を使用できます。 

本項目は，ツリー表示でスレーブ局のユニットを選択した場合に，設定できます。 

User MIT-Address  

GX IEC Developerのプログラムで，入出力データをアクセスするときに中継するデバイスを設定

します。 

設定するデバイスは他のユニットと重複できません。 

重複しないように設定してください。 

“User MIT-Address”の詳細については，本章(3)を参照してください。 

本項目は，ツリー表示でスレーブ局のユニットを選択した場合に，設定できます。 

Buffer MIT-Address 

マスタユニットとCPUユニット間の交信で使用するCPUユニットのデバイスを表示または設定しま

す。 

本項目は，“PLC and GX IEC Developer (GID) Settings”ダイアログボックスで“Slave Specific 

Transfer”を選択していて，ツリー表示でスレーブ局を選択した場合に設定できます。 

 

(3) User MIT-Addressについて 

GX IEC Developerのプログラムで，“User MIT-Address”に設定したデバイスへ

アクセスすると，入出力データにアクセスできます。 

ユニットの増減などにより入出力データのアドレスが変更された場合，I/O 

Mappingによりアドレスが再計算されます。 

このため，ユーザライブラリをエクスポートして組み込み直すと，ユニットの増

減前と同様に入出力データをアクセスできます。 

プログラムの修正は必要ありません。 
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第９章 接続先設定 

(1) はじめに 

本章では，GX Configurator-DPの転送設定について説明します。 

転送設定を行うと，マスタユニットのプロジェクトをマスタユニットへダウン

ロードできるようになります。 

 

ポイント  

① スレーブユニットのプロジェクトをスレーブユニットへダウンロードする場合

は，Webベースオンラインアクセス機能の“Module Configuration”ページで，

“Project”を操作して行います。 

詳細については，10章(3)(h)を参照してください。 

② マスタユニットのプロジェクトは，Webベースオンラインアクセス機能でもダウ

ンロードできます。 

詳細については，10章(3)(d)を参照してください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9 

 

 

 



 

 

 

9 - 2                                         9 - 2 

９ 接続先設定 
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(2) 接続の注意事項 

転送設定の注意事項を下記に示します。 
 

(a) 転送設定は，マスタユニットのプロジェクトを最前面に表示している場合の

み実行できます。 

スレーブユニットのプロジェクトを最前面に表示している場合は，実行でき

ません。 
 

(b) MELSECNET/H（リモートI/Oネット）は，下記制約を満たしている場合のみ使

用可能です。 

・リモートI/O局にはQJ71PB92Vのみ装着可能です。 

・接続は，パソコンのRS-232コネクタとQJ72LP25-25，QJ72LP25G，または

QJ72BR15のRS-232コネクタとの接続をサポートします。 

・QJ71PB92VをMELSECNET/HリモートI/O局に装着している場合は，自動リフ

レッシュは使用できません。 

自動リフレッシュを使用したい場合は，QJ71PB92Vをリモートマスタ局

（QCPU）へ装着してください。 
 

(c) MELSECNET/H（PC間ネット）またはMELSECNET/10（PC間ネット）で，GX 

Configurator-DPと接続したQnACPUからAnUCPUへアクセスする場合は，QnACPU

のシステム設定スイッチ2（＊1）をONしてください。 
 

＊1 システム設定スイッチ2は，アクセスするシーケンサCPUの機種を設定す

るスイッチです。 
 

(d) MACを経由してQCPUまたはQnACPUに接続する場合の設定 

MACを経由してQCPUまたはQnACPUに接続する場合は，MACとパソコンのシリア

ルポートの設定を合わせる必要があります。 

パソコンと接続したMACの通信設定を，E-Designer（＊1）を使用して下記のよ

うに設定してください。 
 

＊1 E-DesignerはMAC用のソフトウェアです。 

E-Designerについては，E-Designerのマニュアルを参照してください。 

 

表9-1 MACを経由してQCPUまたはQnACPUに接続する場合の設定 

項  目 内  容 

データ長 8ビット 

ストップビット 1ビット 

パリティ 奇数パリティ(Odd) 

伝送速度 
“Transfer Setup”ダイアログボックスで設

定した伝送速度と，同じ値に設定します。 
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(3) 基本操作 

(a) 接続先設定の新規追加 

① [Online]→[Transfer Setup]メニュー（ ）をクリックし，“Transfer 

Setup List”ダイアログボックスを表示させます。 

②  New ボタンをクリックし，“PLC Type Selection”ダイアログボックス

を表示させます。 

③ 接続先CPUユニットの機種を選択して Transfer Setup ボタンをクリック

し，“Transfer Setup”ダイアログボックスを表示させます。 

 

④ 接続方法を設定して OK ボタンをクリックし，“Transfer Setup”ダイア

ログを閉じます。 

“Transfer Setup”ダイアログボックスの詳細については，本章(4)(b)

を参照してください。 

⑤ 接続先設定の名前とマスタユニットの装着位置を設定して Apply ボタン

をクリックすると，接続方法の設定を終了します。 

 

備  考 

接続方法を新規に設定すると，接続先設定の名前は“TransferSetup*”（*は1以上

の連番）に自動で設定されます。 

他の名前に変更する方法については，本章(3)(d)を参照してください。 
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(b) 接続先設定の修正 

① [Online]→[Transfer Setup]メニュー（ ）をクリックし，“Transfer 

Setup List”ダイアログボックスを表示させます。 

② “Transfer Setup Names”で修正する接続先設定を選択して Configure ボ

タンをクリックし，“PLC Type Selection”ダイアログボックスを表示さ

せます。 

③ 接続先CPUユニットの機種を選択して Transfer Setup ボタンをクリック

し，“Transfer Setup”ダイアログボックスを表示させます。 

 

④ 接続方法を設定して OK ボタンをクリックすると，“Transfer Setup”ダ

イアログを閉じます。 

“Transfer Setup”ダイアログボックスの詳細については，本章(4)(b)

を参照してください。 

⑤ 接続先設定の名前とマスタユニットの装着位置を設定して Apply ボタン

をクリックすると，接続方法の設定を終了します。 

 

(c) 接続先設定の削除 

① [Online]→[Transfer Setup]メニュー（ ）をクリックし，“Transfer 

Setup List”ダイアログボックスを表示させます。 

② “Transfer Setup Names”で削除する接続先設定を選択して Delete ボタ

ンをクリックし，確認のダイアログボックスを表示させます。 

③  Yes ボタンをクリックし，接続先設定を削除します。 

 

(d) 接続先設定の名前，またはマスタユニットの装着位置の修正 

① [Online]→[Transfer Setup]メニュー（ ）をクリックし，“Transfer 

Setup List”ダイアログボックスを表示させます。 

② “Transfer Setup Names”で修正する接続先設定を選択します。 

③ 接続先設定の名前を修正する場合は，“Transfer Setup Names”の名前を

修正します。 

マスタユニットの装着位置を修正する場合は，“Target PLC”の“Module 

Slot”修正します。 

④  Apply ボタンをクリックし，修正を終了します。 

 

備  考 

① 接続先設定の名前は，下記半角文字を使用できます。 

ただし，先頭は英字を使用してください。数字または記号は使用できません。 

（使用可能文字：英数字，“_”，“-”，“ ”（スペース），“(”，“)”） 

② 接続先設定の名前は，他の接続先設定の名前と重複できません。 

他の接続先設定と重複しない名前に設定してください。 
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(e) 接続先CPUユニットとマスタユニットへのアクセス可否テスト 

① [Online]→[Transfer Setup]メニュー（ ）をクリックし，“Transfer 

Setup List”ダイアログボックスを表示させます。 

② “Transfer Setup Names”でテストする接続先設定を選択します。 

③  Test ボタンをクリックし，テストを開始させます。 

④ 下記のように，テスト結果が表示されます。 

④-1 CPUユニットのアクセス結果 

CPUユニットのアクセスに成功した場合は， OK ボタンをクリックし，

マスタユニットのアクセス結果を表示させます。 

 

 

CPUユニットのアクセスに失敗した場合は，パソコンとCPUユニット

間の接続設定の内容とケーブルの接続を確認し， OK ボタンをク

リックしてテストを終了します。 

 

 

④-2 マスタユニットのアクセス結果 

マスタユニットのアクセスに成功した場合は， OK ボタンをクリッ

クしてテストを終了します。 

 

 

マスタユニットのアクセスに失敗した場合は， OK ボタンをクリッ

クしてテストを終了し，“Module Slot”を修正してください。 
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(4) 表示／設定画面  

(a) Transfer Setup Listダイアログボックス 

 

図9-1 Transfer Setup Listダイアログボックス 

 

表9-1 Transfer Setup Listダイアログボックスの項目 

項  目 内  容 

Transfer Setup Name 他の接続先設定への変更，または接続先設定の名前を変更します。 

Target PLC 接続先シーケンサについて，情報の表示と設定を行います。 

 PLC Series 接続先シーケンサのシリーズを表示します。 

 PLC Type 接続先シーケンサの製品形名を表示します。 

 Module Slot マスタユニットの装着位置を設定します。 
 
  New ボタン 
 

新規に接続先設定を行います。 

 
  Configure ボタン 
 

“Transfer Setup Name”で選択した，接続先設定の設定内容を変更します。 

 
  Delete ボタン 
 

“Transfer Setup Name”で選択した接続先設定を削除します。 

 
  Apply ボタン 
 

接続先設定の名前または“Module Slot”の設定を変更する場合，各入力欄を修正後に本ボタン

をクリックします。 
 
  Test ボタン 
 

接続先のCPUユニットおよびマスタユニットに対して，正常にアクセスできるかをテストします。
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(b) Transfer Setupダイアログボックス 

“Transfer Setup”ダイアログボックスでの設定方法は，下記ソフトウェア

の画面と同じです。 

設定方法の詳細については，各ソフトウェアのマニュアルを参照してくださ

い。 

・GX IEC Developerの“Transfer Setup”ダイアログボックス 

・GX Developerの“Transfer Setup”ダイアログボックス 

 

本マニュアルでは下記の設定例を紹介します。 

 

【自局にアクセスする場合の設定例】 

● システムのイメージ図 
GX Configurator-DP

USB

CPUユニット：Q06HCPU

マスタユニット：QJ71PB92V

 

図9-2 システムのイメージ図 

 

● 設定例 

USBを選択します。

PLC moduleを選択します。

No specificationを
選択します。

 

図9-3 設定例 
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【1種類のネットワークを経由して他局にアクセスする場合の設定例】 

● システムのイメージ図 
GX Configurator-DP CPUユニット：Q06HCPU

RS-232
伝送速度：115.2Kbps

CPUユニット　 ：Q25HCPU
マスタユニット：QJ71PB92D
MELSECNET/H
ネットワークユニット
　　　　　　　：QJ71LP21-25
　　　　　　　　局番2

MELSECNET/H（PC間ネット）
ネットワークNo.：1

 

図9-4 システムのイメージ図 

 

● 設定例 

Serial USBを選択して
下記を設定します。
・RS-232Cを選択
・Transmission speed
　：115.2Kbps

PLC moduleを選択します。

Other station
(Single network)を
選択します。

NET/10(H)を選択して
下記を設定します。
・Network No.：1
・Station No.：2

 

図9-5 設定例 
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第１０章 Webベースオンラインアクセス機能 

Webベースオンラインアクセス機能はWebブラウザを使用し，ユニットと直接接続し

たサーバを経由してアクセスできます。 

Webベースオンラインアクセス機能でアクセスすると，マスタユニット／スレーブユ

ニットへのプロジェクトの書き込みや，動作モードの設定などを行えます。 

 

終端抵抗

サーバ＊1 

マスタ局

スレーブ局スレーブ局スレーブ局

終端抵抗

RESET

RELEASE

PROFIBUS I/F

ST1 H-PB R U N

A U X

E R R

S T 1 P S D

S Y S

R U N E R R R U N E R R

イントラネットまたは
インターネット

クライアント（Webブラウザ）＊1

＊1 サーバのパソコンのWebブラウザを，クライアントとして使用することもできます。

 

図10-1 Webベースオンラインアクセス機能のイメージ 

 

ポイント  

Webベースオンラインアクセス機能のサーバとシーケンサCPUとの接続は，さまざま

な種類があります。 

詳細は，本章(1)(d)を参照してください。 
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(1) システムの要件 

(a) 動作環境 

Webベースオンラインアクセス機能の動作環境を，下記に示します。 

 

表10-1 Webベースオンラインアクセス機能の動作環境 

項  目 内  容 

サーバ 
GX Configurator-DPの動作環境と同じです。 

詳細については，2.1節(1)を参照してください。 

クライアント － 

 基本ソフトウェア(OS) 下記Webブラウザが動作する基本ソフトウェア。 

 Webブラウザ 

HTML3およびJava2に対応したWebブラウザ。 

例： ・Microsoft R Internet Explorer 6 

 ・Netscape R 7.1 

 ・Konqueror 3.4 

 

(b) マスタユニット／スレーブユニットの制約事項 

制約事項のあるマスタユニット／スレーブユニットを，下記に示します。 

記載されていないマスタユニット／スレーブユニットについては，初回出荷

品から制約事項がありません。 

 

表10-2 マスタユニット／スレーブユニットの制約事項 

ユニット形名 
ソフトウェア

バージョン 
制約事項 

AJ71PB92D A 

A1SJ71PB92D E以前 

GX Configurator-DP Version 7は，CPUユニット経由で

A(1S)J71PB92Dと接続できません。 

この場合は，最寄りの支社または代理店に症状を説明，ご

相談ください。 

 

(c) 対応シーケンサCPU 

Webベースオンラインアクセス機能は，マスタユニットが対応しているすべて

のシーケンサCPUに対応しています。 

マスタユニットの対応シーケンサCPUについては，各マスタユニットのマニュ

アルを参照してください。 
 

(d) 対応する接続方法 

Webベースオンラインアクセス機能のサーバとシーケンサCPU間は，下記の接

続ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10 
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(d-1) パソコンとマスタ局の接続 
 

GX Configurator-DP マスタ局

 

図10-2 接続イメージ 
 

パソコンとマスタ局間は下記の接続ができます。 
 

・RS-232でQCPUと接続します。 

・USBでQCPUと接続します。 

・RS-422でQnACPUと接続します。 

・RS-422でACPUと接続します。 

・MAC（＊1）を経由してQCPU，QnACPUまたはACPUと接続します。 

・Qシリーズ対応E71を経由してQCPUと接続します。 

・QE71またはE71を経由してQnACPUと接続します。 

・FX3U-64DP-MとRS-422で接続します。 
 

＊1 MACはBeijer Electronics社製のHMI（Human Machine Interface）です。 
 

(d-2) MELSECNET/H（PC間ネット），MELSECNET/10（PC間ネット）を経由したパソ

コンとマスタ局の接続 
 

MELSECNET/H（PC間ネット），
MELSECNET/10（PC間ネット）

GX Configurator-DP マスタ局シーケンサCPU

 

         図10-3 接続イメージ 
 

MELSECNET/H（PC間ネット），MELSECNET/10（PC間ネット）を経由する場合，

パソコンとシーケンサCPU間は下記の接続ができます。 
 

・RS-232でQCPUと接続します。 

・USBでQCPUと接続します。 

・RS-422でQnACPUと接続します。 

・MAC（＊1）を経由してQCPUまたはQnACPUと接続します。 

・Qシリーズ対応E71を経由してQCPUと接続します。 

・QE71またはE71を経由してQnACPUと接続します。 
 

＊1 MACはBeijer Electronics社製のHMI（Human Machine Interface）です。
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(2) サーバ 

サーバは，クライアントの要求（＊1）に従って各ユニットの設定などを行います。 
 

＊1 クライアントの要求はWebブラウザで行います。 

詳細については，本章(3)を参照してください。 
 

(a) 基本操作 
 

(a-1) サーバの起動操作 

① 下記いずれかを実行し，“GX Configurator-DP Server Administrator”

ダイアログボックスを表示させます。 

・[Tools]→[Server Administrator]メニューをクリックします。 

・スタートメニューから[Programs（＊1）]→[MELSOFT Application]→[GX 

Configurator-DP]→[GX Configurator-DP Server Administrator]（＊2）

をクリックします。 
 

＊1 下記OS使用時は，[All Programs]と表示されます。 

・Microsoft R Windows R XP Professional Operating System 

・Microsoft R Windows R XP Home Edition Operating System 
 

＊2 GX Configurator-DPのアイコンを，プログラムフォルダの“MELSOFT 

Application\GX Configurator-DP”にインストールした場合です。 
 

②  Start Server ボタンをクリックし，サーバを起動させます。 
 

(a-2) サーバの終了操作 

① “GX Configurator-DP Server Administrator”ダイアログボックスで 

 Stop Server ボタンをクリックし，サーバを停止させます。 
 

②   Leave ボ タ ン を ク リ ッ ク し ， “ GX Configurator-DP Server 

Administrator”ダイアログボックスを閉じて終了します。 
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(b) 表示／設定画面 
 

 

図10-4 GX Configurator-DP Server Administratorダイアログボックス 

（メニューバーから表示した場合） 

 

表10-3 GX Configurator-DP Server Administratorダイアログボックスの項目 

項  目 内  容 

This computer is the 

server 

“GX Configurator Client”コマンドで接続するサーバを変更する場合に，チェックをはず

します。 

本ダイアログボックスをメニューバーから表示した場合に，変更可能になります。 

チェックなし：他のパソコンで起動したサーバを使用する 

チェックあり：本ダイアログボックスを表示したパソコンのサーバを使用する 

Server Computer Name 

“GX Configurator Client”コマンドで接続するサーバを変更する場合に，サーバのホスト

名またはIPアドレスを設定します。 

本ダイアログボックスをメニューバーから表示し，“This computer is the server”のチェッ

クをはずすと，設定可能になります。 

Server IP Address 
サーバのIPアドレスを表示します。 

サーバに接続できない場合は，“<not found>”を表示します。 

Server TCP Port サーバが使用するポート番号を表示します。 

URL(local) サーバと同じパソコンでWebブラウザを使用する場合の，サーバのURLを表示します。 

URL(remote) サーバと違うパソコンでWebブラウザを使用する場合の，サーバのURLを表示します。 

Local Server Status 

サーバの動作状態が表示されます。 

Stopped：停止中 

Started：起動中 

 
 Start Server ボタン 
 

サーバを起動します。 

“This computer is the server”にチェックした場合に，操作可能になります。 

 
 Stop Server ボタン 
 

サーバを停止します。 

“This computer is the server”にチェックした場合に，操作可能になります。 

 
 Save ボタン 
 

本ダイアログボックスの表示／設定内容を，保存します。 

メニューバーから起動した場合に，操作可能になります。 

 

(c) 注意事項 

サーバのパソコンでは，Webベースオンラインアクセス機能使用中に他のアプ

リケーションから，ポート番号の8080番を使用しないでください。 

他のアプリケーションでポート番号の8080番を使用すると，Webブラウザで

ページを正常に表示できなくなる場合があります。 
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(3) クライアント 

クライアントは，Webブラウザを使用してサーバにアクセスし，各ユニットの設定

などを行います。 
 

(a) 機能一覧 

クライアントから実行可能な機能の一覧を，下記に示します。 

 

表10-4 クライアントの機能一覧 

機能名 内  容 参照項 

Authentication 
サーバに登録されたユーザのみが，Webベースオンラインアクセス機能を使用で

きるように制限します。 
本章(3)(a)

Network Path Selection サーバとシーケンサCPUを接続します。 本章(3)(b)

Rack Configuration シーケンサCPUのベースユニットに装着された，ユニットの一覧が表示されます。 本章(3)(c)

マスタユニット 本章(3)(d)
Module Configuration 

マスタユニットまたはスレーブユニットの，動作モード

の変更やプロジェクトの書き込みなどを行います。 スレーブユニット 本章(3)(h)

Auto Refresh Settings 自動リフレッシュパラメータの一覧が表示されます。 本章(3)(e)

Slave List 
マスタユニットに書き込まれているプロジェクトに追加された，全スレーブユ

ニットの情報が一覧表示されます。 
本章(3)(f)

Current Module 

Settings 

マスタユニットに書き込まれている各パラメータが表示されます。 
本章(3)(g)

 

(b) 基本操作 
 

(b-1) サーバと同じパソコンでWebブラウザを使用する場合 

① [Tools]→[GX Configurator Client]メニューを選択し，Webブラウザを起

動させます。 

② Webブラウザには，自動的に“Network Path Selection”ページを表示さ

れます。 

“Network Path Selection”ページについては，本章(3)(b)を参照してく

ださい。 
 

(b-2) サーバと違うパソコンでWebブラウザを使用する場合 

① Webブラウザを起動します。 

② サーバのパソコンの“GX Configurator-DP Server Administrator”ダイ

アログボックスを参照し，“URL(remote)”に表示されているURLを，クラ

イアントのパソコンのWebブラウザに指定します。 

“GX Configurator-DP Server Administrator”ダイアログボックスにつ

いては，本章(2)を参照してください。 

③ Webブラウザには“Authentication”ページが表示されます。 

“Authentication”ページについては，本章(3)(a)を参照してください。 

 

 

 

 

 

 

 



 

 

 

10 - 7                                         10 - 7 

１０ Webベースオンラインアクセス機能 
MELSOFT

(a) Authentication 

サーバに登録されたユーザのみが，Webベースオンラインアクセス機能を使用

できるように制限します。 
 

ユーザをサーバに登録するためには，ファイル“users”を編集します。 

詳細については，本章(3)(a-1)を参照してください。 
 

(a-1) 基本操作 

① ユーザ名とパスワードを入力し， Login ボタンをクリックします。 
 

 

 
② 認証に成功すると，サーバにログインして“Network Path Selection”ペー

ジを表示します。 
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(a-2) usersファイルについて 

・usersファイルの保存先 

“users”ファイルは“C:\MELSEC\GX Configurator-DP\Server\gxmonitor\ 

Admin”フォルダに保存されています。＊1 

＊1 GX Configurator-DPを“C:\MELSEC\GX Configurator-DP”にインストール

した場合です。 
 

・usersファイルの仕様 

“users”ファイルは，メモ帳などで編集可能なテキストファイルです。 

“users”ファイルに使用可能な文字コードは，ASCIIコードのみです。 

他の文字コードは使用しないでください。 
 

・usersファイルの書式 

“users”ファイルは，1行につき1ユーザ分の情報を記述します。 

1ユーザ分の情報は，下記の情報を“:”（コロン）区切りで記述します。 

① ユーザ名 

② パスワード 

③ 属性（省略可能） 

“read+write”を記述すると，ログイン後に下記の処理を行えるよう

になります。 
 

表10-5 read+writeの記述が必要な処理 

処  理 ページ名称 参照項 

Rack Configuration 本章(3)(c)

マスタユニット 本章(3)(d)

CPUユニットの動作状態の

表示および変更 
Module Configuration

スレーブユニット 本章(3)(h)

各ユニットの動作モードの

変更 マスタユニット 本章(3)(d)

プロジェクトを各ユニット

へ書込む 

入出力データ交信の開始／

停止 

Module Configuration

スレーブユニット 本章(3)(h)

 

“read+write”以外を記述するか省略した場合は，上記の処理は行え

ません。 

 
 

・usersファイルの例 
 

profibus:gxmonitor
gxinet:super:read+write

①

②
 

 
①のユーザの場合 

ユーザ名  ：profibus 

パスワード ：gxmonitor 

属性  ：読込みのみ可能 
 

②のユーザの場合 

ユーザ名  ：gxinet 

パスワード ：super 

属性  ：読込み／書込み可能 
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(b) Network Path Selection 

サーバのパソコンとシーケンサCPUを接続します。 
 

(b-1) 基本操作 

① プルダウンメニューから接続方法を選択します。（＊1） 

プルダウンメニューの接続方法については，本章(3)(b-3)を参照してくだ

さい。 
 

＊1 プルダウンメニューに接続方法がない場合は，ネットワーク設定ファ

イルに接続方法を記述してサーバにアップロードすると，プルダウン

メニューに接続方法を追加できます。 

詳細については，本章(3)(b-4)を参照してください。 
 

②  Connect ボタンをクリックし，サーバのパソコンとシーケンサCPUを接続

させます。 
 

③ 接続に成功すると，“Rack Configuration”ページを表示します。 
 

(a) 接続方法を“Transfer Setup”ダイアログボックスから流用する方法 

① “Transfer Setup”ダイアログボックスでXMLファイルを出力します。 

“Transfer Setup”ダイアログボックスについては，9章を参照してくだ

さい。 
 

② Webブラウザで Browse ボタンをクリックし，XMLファイルを選択します。 
 

③  Upload ボタンをクリックし，XMLファイルをサーバのパソコンにアップ

ロードさせます。 
 

④ アップロードに成功すると，“Transfer Setup”ダイアログボックスで設

定した接続方法が，プルダウンメニューに追加されます。 
 

(b-2) 表示／設定画面 
 

 

図10-5 Network Path Selectionページ 

 

表10-6 Network Path Selectionページの項目 

項  目 内  容 
 
 Connect ボタン 
 

プルダウンメニューから選択した方法で，サーバとシーケンサCPUを接続します。 

 
 Browse ボタン 
 

接続方法を“Transfer Setup”ダイアログボックスから流用する場合に，XMLファイルを選択

します。 

 
 Upload ボタン 
 

 
 Browse ボタンで選択したXMLファイルをサーバにアップロードし，接続方法をプルダウンメ

ニューに追加します。 
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(b-3) プルダウンメニューの接続方法 

デフォルトで選択できるプルダウンメニューの接続方法を，下記に示しま

す。 

 

表10-7 サーバとシーケンサCPUの接続方法一覧 

項  目 内  容 

netwpath_config.xml<PC serial Q-CPU> RS-232でQCPUと接続します。 

netwpath_config.xml<PC serial MAC serial Q-CPU> MAC（＊1）を経由してQCPUと接続します。 

netwpath_config.xml<PC USB Q-CPU> USBでQCPUと接続します。 

netwpath_config.xml<PC ethernet Q-CPU> EthernetでQCPUと接続します。 

netwpath_config.xml<PC serial Q-CPU MELSECNET/H 

Q-CPU> 

MELSECNET/H（PC間ネット），MELSECNET/10（PC間ネット）でQCPU

と接続します。 

netwpath_config.xml<PC ethernet Q-CPU 

MELSECNET/H Q-CPU> 

EthernetとMELSECNET/H（PC間ネット），MELSECNET/10（PC間ネッ

ト）で，QCPUと接続します。 

netwpath_config.xml<PC serial QnA-CPU> RS-422でQnACPUと接続します。 

netwpath_config.xml<PC ethernet QnA-CPU> EthernetでQnACPUと接続します。 

netwpath_config.xml<PC ethernet QnA-CPU 

MELSECNET/H QnA-CPU> 

EthernetとMELSECNET/H（PC間ネット），MELSECNET/10（PC間ネッ

ト）で，QnACPUと接続します。 

netwpath_config.xml<PC serial A-CPU> RS-422でACPUと接続します。 

netwpath_config.xml<PC serial MAC serial A-CPU> MAC（＊1）を経由してACPUと接続します。 

netwpath_config.xml<PC serial QnA-CPU 

MELSECNET/H QnA-CPU> 

RS-422とMELSECNET/H（PC間ネット），MELSECNET/10（PC間ネット）

で，QnACPUと接続します。 

netwpath_config.xml<PC serial Q-CPU MELSECNET/H 

QnA-CPU> 

MELSECNET/H（PC間ネット），MELSECNET/10（PC間ネット）でQnACPU

と接続します。 

netwpath_config.xml<PC ethernet Q-CPU 

MELSECNET/H QnA-CPU> 

EthernetとMELSECNET/H（PC間ネット），MELSECNET/10（PC間ネッ

ト）で，QnACPUと接続します。 

netwpath_config.xml<PC serial FX-CPU> RS-422でFX3U-64DP-Mと接続します。 
 

＊1 MACはBeijer Electronics社製のHMI(Human Machine Interface)です。 
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(b-4) ネットワーク設定ファイルについて 

ネットワーク設定ファイルは，“Network Path Selection”ページで選択

する接続方法を，XMLで記述したファイルです。 

“Network Path Selection”ページの接続方法以外で接続する場合に，ネッ

トワーク設定ファイルに接続方法を記述してサーバにアップロードすると，

選択できるようになります。 

 

ポイント  

接続方法を追加するためには，XMLの知識が必要です。 

 

(b-4-1) 接続方法の追加操作 

① 本章(3)(b-4-2)を参照して，追加する接続方法を記述したネットワーク設

定ファイルを作成します。 

ネットワーク設定ファイルの作成は，間違いを減らすために，追加する接

続方法と似た接続方法を，下記ファイルから流用して修正することを推奨

します。 

【流用ファイル】 

C:\MELSEC\GX Configurator-DP\Server\gxmonitor\WebApps\config\ 

netwpath_config.xml 

（GX Configurator-DPを“C:\MELSEC\GX Configurator-DP”にインストー

ルした場合です。） 

② “Network Path Selection”ページで Browse ボタンをクリックし，作成

したネットワーク設定ファイルをサーバにアップロードします。 

③ アップロードに成功すると，①でネットワーク設定ファイルに記述した接

続方法が，プルダウンメニューに追加されます。 
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(b-4-2) ネットワーク設定ファイルの書式仕様 
 

<Root xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
  xsi:schemaLocation="netwpath_config.xsd">
  
  ・・・
    
  <NetworkPath name="PC ethernet Q-CPU MELSECNET/H Q-CPU">
    <PCNode commType="ethernet" stationNumber="1"> </PCNode>
    <PLCModule boardType="ethernet" plcFamily="q"
      networkAddress="10.226.126.220" networkNumber="1"
      stationNumber="2" > </PLCModule>    
    <PLCModule boardType="melsecnetH" plcFamily="q"
      networkNumber="10" stationNumber="2"> </PLCModule>    
  </NetworkPath>
  
  <NetworkPath name="PC serial QnA-CPU">
    ・・・
  </NetworkPath>
  
  ・・・
  
</Root>

②
③

④

①

 

図10-6 ネットワーク設定ファイル 

 

① すべての接続方法を，“Root”要素の子要素として記述します。 

“Root”要素に記述する属性を，下記に示します。 
 

表10-8 Root要素の属性一覧 

属  性 内  容 

xmlns:xsi 
下記URIを記述し，名前空間宣言を行います。 

設定範囲：xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"（固定） 

xsi:schemaLocation 
下記ファイル名を記述し，スキーマ文書を特定します。 

設定範囲：netwpath_config.xsd（固定） 

 

② 1種類の接続方法を，1つの“NetworkPath”要素に記述します。 

“NetworkPath”要素は，“Root”要素の子要素として記述します。 

“NetworkPath”要素に記述する属性を，下記に示します。 
 

表10-9  NetworkPath要素の属性一覧 

属  性 内  容 

name 

接続方法の名前を記述します。 

本属性値が，“Network Path Selection”ページのプルダウンメニューに表示されます。 

設定範囲：半角英数字，半角スペース，一部半角記号（“/”，“-”） 
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③ パソコン側の接続方法を，“PCNode”要素に記述します。 

“PCNode”要素は，“NetworkPath”要素の子要素として記述します。 

“PCNode”要素に記述する属性を，下記に示します。 
 

表10-10 PCNode要素の属性一覧 

属  性 内  容 

baudRate 
RS-232またはRS-422で接続する場合に，伝送速度を記述します。 

設定範囲：9600，19200，38400，57600，115200 

commPort 
RS-232またはRS-422で接続する場合に，接続するCOMポートの番号を記述します。 

設定範囲：1～10 

commType 
接続するインタフェースの種類を記述します。 

設定範囲：“serial”，“usb”，“ethernet” 

portNumber 
Ethernetで接続する場合に，ポート番号を記述します。 

設定範囲：1～65535 

stationNumber 
パソコンの局番を記述します。 

設定範囲：0～64 

 
④ シーケンサCPU1台分の接続方法を，“PLCModule”要素に記述します。 

“PLCModule”要素は，“NetworkPath”要素の子要素として記述します。 

MELSECNET/H（PC間ネット），MELSECNET/10（PC間ネット）を使用する場

合は，シーケンサCPUを2台使用するため，“PLCModule”要素を2つ記述し

ます。 

“PLCModule”要素に記述する属性を，下記に示します。 
 

表10-11 PLCModule要素の属性一覧 

属  性 内  容 

boardType 

パソコンと直接接続する場合は，パソコンと接続するユニットを記述します。 

他シーケンサCPUを中継する場合は，中継するシーケンサCPUと接続するユニットを記述します。

MAC(＊1)と接続するシーケンサCPUの場合は，“mac”を記述します 

設定範囲：“CPU”（CPUユニット）， 

“melsecnetH”（MELSECNET/H（PC間ネット），MELSECNET/H（リモートI/Oネット）

またはMELSECNET/10（PC間ネット））， 

“ethernet”（Ethernetユニット），“mac” 

networkAddress 
“boardType”に“ethernet”を記述した場合に，そのユニットのIPアドレスまたはホスト名を

記述します。 

networkNumber 

“boardType”に“melsecnetH”または“ethernet”を記述した場合に，そのユニットが接続す

るネットワークのネットワークNo.を記述します。 

設定範囲：1～239 

plcFamily 

設定対象シーケンサCPUのシリーズを記述します。 

設定範囲：“q”（MELSEC-Qシリーズ），“qna”（MELSEC-QnAシリーズ）， 

“a”（MELSEC-Aシリーズ），“fx”（MELSEC-F FXシリーズ） 

protocol 

“boardType”に“ethernet”を記述した場合に，そのユニットが接続するネットワークで使用

するプロトコルを記述します。 

設定範囲：“udp”，“tcp” 

stationNumber 

“boardType”に“melsecnetH”または“ethernet”を記述した場合に，そのユニットの局番を

記述します。 

設定範囲：0～64 
 

＊1 MACはBeijer Electronics社製のHMI(Human Machine Interface)です。 
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(b-4-3) ネットワーク設定ファイルの例 

【RS-232とMELSECNET/Hを使用した場合】 

 

ネットワークNo.：3

<Root xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
  xsi:schemaLocation="netwpath_config.xsd">
  <NetworkPath name="PC serial Q-CPU MELSECNET/H Q-CPU">
    <PCNode commType="serial" baudRate="9600" commPort="1">
      </PCNode>
    <PLCModule boardType="cpu" plcFamily="q"> </PLCModule>    
    <PLCModule boardType="melsecnetH" plcFamily="q"
      networkNumber="3" stationNumber="2"> </PLCModule>    
  </NetworkPath>
</Root>

CPUユニット　 ：Q25HCPU
マスタユニット：QJ71PB92V
MELSECNET/H
ネットワークユニット
　　　　　局番：2

MELSECNET/H
（PC間ネット）

CPUユニット：Q06HCPU

COMポート番号：1
伝送速度　　 ：9600bps

RS-232

 

図10-7 RS-232とMELSECNET/Hを使用した場合 

 

【EthernetとMELSECNET/Hを使用した場合】 

 

ネットワークNo.：10

<Root xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
  xsi:schemaLocation="netwpath_config.xsd">
  <NetworkPath name="PC ethernet Q-CPU MELSECNET/H Q-CPU">
    <PCNode commType="ethernet" stationNumber="1">
      </PCNode>
    <PLCModule boardType="ethernet" plcFamily="q"
      networkAddress="10.226.126.220" networkNumber="1"
      stationNumber="2" > </PLCModule>    
    <PLCModule boardType="melsecnetH" plcFamily="q"
      networkNumber="10" stationNumber="2"> </PLCModule>    
  </NetworkPath>
</Root>

CPUユニット　 ：Q25HCPU
マスタユニット：QJ71PB92V
MELSECNET/H
ネットワークユニット
　局番　　　　：2

MELSECNET/H
（PC間ネット）

局番：1

Ethernet

ネットワークNo.：1

CPUユニット：Q06HCPU
Ethernetユニット
  IPアドレス：10.226.126.220
  局番　　　：2

 

図10-8 EthernetとMELSECNET/Hを使用した場合 
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(c) Rack Configuration 

シーケンサCPUのベースユニットに装着された，ユニットの一覧が表示されま

す。 
 

(c-1) 表示／設定操作 
 

 

図10-9 Rack Configurationページ 

 

表10-12 Rack Configurationページの項目 

項  目 内  容 

Slot Nr スロット番号が表示されます。 

Head Addr 先頭入出力番号が表示されます。（単位：× 10H） 

Module Name 

ベースユニットに装着されたユニットの，ユニット形名が表示されます。 

ユニットがマスタユニットまたはスレーブユニットの場合は，クリックすると“Module 

Configuration”ページが表示されます。 

“Module Configuration”ページについては，下記を参照してください。 

・マスタユニット ·············································· 本章(3)(d) 

・スレーブユニット ············································ 本章(3)(h) 

CPU Settings 

CPUユニットの動作状態が表示されます。 

動作状態を変更する場合は，プルダウンメニューから変更する動作状態を選択し， Set ボタ

ンをクリックすると，変更できます。 

CPUユニットの状態によっては，操作が有効にならない場合もあります。（たとえば，CPUユ

ニットがRUN中にRESETは実行できません。） 

詳細については，ご使用のCPUユニットのマニュアルを参照してください。 

Current Autorefresh 

Settings 

“Auto Refresh Settings”ページが表示されます。 

CPUユニットに自動リフレッシュパラメータが書き込まれている場合に，操作可能になりま

す。 

“Auto Refresh Settings”ページについては，本章(3)(e)を参照してください。 

Delete IPARAM File on 

CPU Module 

CPUユニットに書き込まれている自動リフレッシュパラメータを削除します。 

CPUユニットに自動リフレッシュパラメータが書き込まれていて， CPUユニットがSTOP状態の

場合に操作可能になります。 
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(d) Module Configuration（マスタユニットの場合） 

“Rack Configuration”ページで選択したマスタユニットの情報が表示され

ます。 

動作モードの変更やプロジェクトの書込みなどを行います。 
 

(d-1) 表示／設定画面 
 

 

図10-10 Module Configurationページ 

 

表10-13 Module Configurationページの項目 

項  目 内  容 

Board Type マスタユニットのユニット形名が表示されます。 

FDL Address 
マスタユニットのFDLアドレスが表示されます。 

QJ71PB92□またはFX3U-64DP-Mの場合のみ，表示されます。 

Mode 

マスタユニットの動作モードを表示および変更します。 

動作モードを変更する場合は，プルダウンメニューから変更する動作モードを選択し， 

 Set Mode ボタンをクリックすると，変更できます。 

QJ71PB92□の場合は，動作モードの表示および変更ができます。 

A(1S)J71PB92Dの場合は，動作モードの表示のみできます。 

FX3U-64DP-Mの場合は，動作モードの表示および変更ができません。 

プルダウンメニューに表示される動作モードについては，本章(3)(d-2)を参照してください。

Project 

下記の操作を行い，GX Configurator-DPで作成したマスタユニットのプロジェクトを書き込

みます。 

プロジェクトの書き込み中は入出力データ交信を停止し，書き込みが終了すると再開します。

①  Browse ボタンをクリックし，マスタユニットのプロジェクトを選択します。 

② 自動リフレッシュパラメータをシーケンサCPUに書込む場合は，“Update Autorefresh 

in CPU”をチェックします。（シーケンサCPUがSTOP状態の場合に，チェックできます。）

③  WriteToPLC ボタンをクリックし，プロジェクトを書き込みます。 
 

（次のページへつづく） 
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表10-13 Module Configurationページの項目（続き） 

項  目 内  容 

CPU Mode 

CPUユニットの動作状態を表示および変更します。 

動作状態を変更する場合は，プルダウンメニューから変更する動作状態を選択し， Set ボタ

ンをクリックすると，変更できます。 

CPUユニットの状態によっては，操作が有効にならない場合があります。 

（例：CPUユニットがRUN中にRESETは実行できません。） 

詳細については，ご使用のCPUユニットのマニュアルを参照してください。 

Data Transfer 

入出力データ交信を開始／停止します。 

Start DP ：入出力データ交信を開始します。 

Stop DP ：入出力データ交信を停止します。 

Current Autorefresh 

Settings 

“Auto Refresh Settings”ページが表示されます。 

“Auto Refresh Settings”ページについては，本章(3)(e)を参照してください。 

Slave List 
“Slave List”ページが表示されます。 

“Slave List”ページについては，本章(3)(f)を参照してください。 

Current Configuration 

“Current Module Settings”ページが表示されます。 

QJ71PB92DまたはA(1S)J71PB92Dの場合は，CPUユニットがSTOP状態のときに表示可能になりま

す。 

“Current Module Settings”ページについては，本章(3)(g)を参照してください。 

Save Current 

Configuration 

各パラメータの設定を拡張子(*.gxdp)のXMLファイルに保存します。 

QJ71PB92DまたはA(1S)J71PB92Dの場合は，CPUユニットがSTOP状態のときに保存可能になりま

す。 

XMLファイルは，拡張子を*.xmlに変更するとWebブラウザで閲覧できます。 

 

(d-2) プルダウンメニューに表示される動作モード 

プルダウンメニューに表示される動作モードを，下記に示します。 
 
・A(1S)J71PB92Dの動作モード 

 

表10-14 A(1S)J71PB92Dの動作モード 

表  示 内  容 

Normal Operation 通常サービスモード 

Parameter Set パラメータ設定モード 

Extd. Operation 拡張サービスモード 

Normal Operation (Frozen) 通常サービスモード＊1 

Parameter Set (Frozen) パラメータ設定モード＊1 

Extd. Operation (Frozen) 拡張サービスモード＊1 
 

＊1 フラッシュROMに登録されている動作モード 
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・QJ71PB92Dの動作モード 

 

表10-15 QJ71PB92Dの動作モード 

表  示 内  容 

Normal Operation 通常サービスモード (MODE 0) 

Parameter Set パラメータ設定モード (MODE 1) 

Extd. Operation 拡張サービスモード (MODE E) 

Normal Operation (Frozen) 通常サービスモード (MODE 0)＊1 

Parameter Set (Frozen) パラメータ設定モード (MODE 1)＊1 

Extd. Operation (Frozen) 拡張サービスモード (MODE E)＊1 

Clear Frozen Mode 

 
 Set Mode ボタンをクリックすると，フラッシュROM

に登録されている動作モードを削除し，パラメータ

設定モードに変更します。 

Clear FlashROM 

 
 Set Mode ボタンをクリックすると，フラッシュROM

を初期化します。 
 

＊1 フラッシュROMに登録されている動作モード 

 

・QJ71PB92Vの動作モード 

 

表10-16 QJ71PB92Vの動作モード 

表  示 内  容 

Parameter Set パラメータ設定モード 

Self Diagnosis 自己診断モード 

DP Operation 通信モード（モード3） 

Parameter Set (Frozen) パラメータ設定モード＊1 

DP Operation (Frozen) 通信モード（モード3）＊1 

Clear Frozen Mode 

 
 Set Mode ボタンをクリックすると，フラッシュROM 

に登録されている動作モードを削除し，パラメータ

設定モードに変更します。 

Clear FlashROM 

 
 Set Mode ボタンをクリックすると，フラッシュROM

を初期化します。 
 

＊1 フラッシュROMに登録されている動作モード 
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(d-3) 注意事項 
 

(d-3-1) プロジェクト書き込み時の注意事項 

① マスタユニットの確認 

プロジェクトを書込む前に，書き込み先のマスタユニットとプロジェクト

のマスタユニットが同じ機種か確認してください。 

機種が違う場合は，下記いずれかを行ってください。 

・書き込み先のマスタユニットを，プロジェクトのマスタユニットと同じ

機種に交換します。 

・“Change Master Type”コマンドで，プロジェクトのマスタユニットを

書き込み先のマスタユニットに変更します。 

“Change Master Type”コマンドについては，5.1節(7)を参照してくだ

さい。 
 

上記の処置を行わない場合は，プロジェクトをマスタユニットへ書き込む

ことができません。 
 

② 自動リフレッシュパラメータ書き込み時の注意事項 

GX Developer起動中にWebベースオンラインアクセス機能で自動リフレッ

シュパラメータを書き込んだ場合，GX DeveloperのPC読出およびPCデータ

削除などのファイル一覧に表示されません。 

GX DeveloperのPC読出およびPCデータ削除の Refresh view ボタンにより

ファイル一覧を更新してください。 
 

(d-3-2) 動作モード変更の注意事項 

① マスタユニットを二重化システムに装着した場合の注意事項 

・ケーブル（RS-232ケーブル，USBケーブルなど）を接続していない二重

化CPUに装着した，マスタユニットの動作モードは変更できません。 

二重化システム構築時に両系のマスタユニットの動作モードを変更す

る場合は，それぞれの系にケーブル（RS-232ケーブル，USBケーブルな

ど）を接続し，マスタユニットの動作モードを変更してください。 

・二重化CPUの運転モードがバックアップモードの場合は，マスタユニッ

トの動作モードを変更できません。 

マスタユニットの動作モードの変更は，二重化CPUの運転モードがセパ

レートモードまたはデバッグモードのときに行ってください。 

・二重化CPUに装着されたマスタユニットの動作モードを変更する場合は，

二重化CPUのトラッキング転送を停止してください。 

トラッキング転送を停止せずにマスタユニットの動作モードを変更す

ると，正常に動作しなくなる場合があります。 

・マスタユニットの動作モード変更後に，二重化CPUの運転モードをバッ

クアップモードにする場合は，両系のマスタユニットの動作モードを同

一に設定してください。 
 

② A(1S)J71PB92Dの動作モード変更の注意事項 

A(1S)J71PB92Dユニットを使用する場合は，ユニット正面のモード設定ス

イッチを1（パラメータ設定モード）に設定してください。 

モードの変更は，CPUリセットすると反映されます。 
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(d-3-3) Save Current Configurationで保存するXMLファイルについて 

Save Current Configurationで保存するXMLファイルは，プロジェクトファ

イルではありません。 

このため，GX Configurator-DPでは開けません。 
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(e) Auto Refresh Settings 

シーケンサCPUに書き込まれている全ユニットの自動リフレッシュパラメー

タが，一覧表示されます。 
 

(e-1) 表示／設定画面 
 

 

図10-11 Auto Refresh Settingsページ 

 

表10-17 Auto Refresh Settingsページの項目 

項  目 内  容 

Head addr. 先頭入出力番号が表示されます。（単位：× 10H） 

Module Name ユニットの製品形名が表示されます。 

Direction 自動リフレッシュさせるバッファメモリについて，入力データか出力データかが表示されま

す。 

Buffer addr. 自動リフレッシュさせるバッファメモリアドレスが表示されます。 

Buffer size 自動リフレッシュさせるバッファメモリのデータサイズが表示されます。（単位：ワード）

Device 自動リフレッシュ先デバイスが表示されます。 
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(f) Slave List 

マスタユニットに書き込まれているプロジェクトに追加された，全スレーブ

ユニットの情報が一覧表示されます。 

 

ポイント  

マスタユニットを二重化システムに装着している場合は，ケーブル（RS-232ケーブ

ル，USBケーブルなど）を接続した二重化CPUに装着されている，マスタユニットが

モニタ対象になります。 

 

(f-1) 表示／設定画面 
 

 

図10-12 Slave Listページ 

 

表10-18 Slave Listページの項目 

項  目 内  容 

FDL Addr FDLアドレスが表示されます。 

Link Status 

入出力データ交信の状態が表示されます。 

Link ：入出力データ交信中 

No Link ：入出力データ交信停止中 

Input Addr. 入力データのバッファメモリアドレスが表示されます。 

Input Size 入力データのサイズが表示されます。（単位：ワード） 

Output Addr. 出力データのバッファメモリアドレスが表示されます。 

Output Size 出力データのサイズが表示されます。（単位：ワード） 

Last known CPU Error シーケンサCPUで発生した最新のエラーが表示されます。 
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(g) Current Module Settings 

マスタユニットに書き込まれている各パラメータが表示されます。 

 

ポイント  

マスタユニットを二重化システムに装着している場合は，ケーブル（RS-232ケーブ

ル，USBケーブルなど）を接続した二重化CPUに装着されている，マスタユニットが

モニタ対象になります。 

 

(g-1) 表示／設定画面 
 

 

図10-13 Current Module Settingsページ 

 

表10-19 Current Module Settingsページの項目 

項  目 内  容 

Read Master Parameter 

from Module 

マスタパラメータが表示されます。 

Read Bus Parameter from 

Module 

バスパラメータが表示されます。 

Read Slave List from 

Module 

スレーブパラメータが表示されます。 

Slave User and 

Configuration 

Parameter 

ユーザパラメータおよびCfg.Dataが表示されます。 

Slave Modules スレーブユニットに追加されている，ユニットが表示されます。 
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(h) Module Configuration（スレーブユニットの場合） 

“Rack Configuration”ページで選択したスレーブユニットの情報が表示さ

れます。 

動作モードの変更やプロジェクトの書き込みなどを行います。 
 

(h-1) 表示／設定画面 
 

 

図10-14 Module Configurationページ 

 

表10-20 Module Configurationページの項目 

項  目 内  容 

Board Type スレーブユニットの製品形名が表示されます。 

FDL Address スレーブユニットのFDLアドレスが表示されます。 

Mode 

スレーブユニットの動作モードを表示および変更します。 

動作モードを変更する場合は，プルダウンメニューから変更する動作モードを選択し， 

 Set Mode ボタンをクリックすると，変更できます。 

プルダウンメニューに表示される動作モードについては，本章(3)(h-2)を参照してください。

Project 

下記の操作を行い，GX Configurator-DPで作成したスレーブユニットのプロジェクトを書き

込みます。 

プロジェクトの書き込み中は入出力データ交信を停止し，書き込みが終了すると再開します。

①  Browse ボタンをクリックし，スレーブユニットのプロジェクトを選択します。 

② 自動リフレッシュパラメータをシーケンサCPUに書込む場合は，“Update Autorefresh

in CPU”をチェックします。（シーケンサCPUがSTOP状態の場合に，チェックできます。）

③  WriteToPLC ボタンをクリックし，プロジェクトを書き込みます。 
 

CPU Mode 

CPUユニットの動作状態を表示および変更します。 

動作状態を変更する場合は，プルダウンメニューから変更する動作状態を選択し， Set ボタ

ンをクリックすると，変更できます。 

CPUユニットの状態によっては，操作が有効にならない場合があります。 

（例： CPUユニットがRUN中にRESETは実行できません。） 

詳細については，ご使用のCPUユニットのマニュアルを参照してください。 

Data Transfer 

入出力データ交信中に，バッファメモリの入力送信エリアのデータ交信を開始／停止します。

Start DP ：入力送信エリアのデータ交信を開始します。 

Stop DP ：入力送信エリアのデータ交信を停止します。 

Save Current 

Configuration 

設定内容を，スレーブユニットのプロジェクトファイルに保存します。 

保存したプロジェクトファイルは，GX Configurator-DPで開くことができます。 
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(h-2) プルダウンメニューに表示される動作モード 

プルダウンメニューに表示される動作モードを，下記に示します。 
 

表10-21 QJ71PB93Dの動作モード 

表  示 内  容 

Normal Operation 通常運転モード 

Diagnostics Mode 自己診断モード 
 
 

(h-3) 注意事項 

① 自動リフレッシュパラメータ書き込み時の注意事項 

GX Developer起動中にWebベースオンラインアクセス機能で自動リフレッ

シュパラメータを書き込んだ場合，GX DeveloperのPC読出およびPCデータ

削除などのファイル一覧に表示されません。 

GX DeveloperのPC読出およびPCデータ削除の Refresh view ボタンにより

ファイル一覧を更新してください。 
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第１１章 トラブルシューティング 

下記のトラブルが発生した場合は，参照項に示すトラブルシューティングを行って

ください。 

 

表11-1 トラブルシューティング一覧 

No. トラブル内容 参照項 

1 

“GX Configurator-DP Server Administrator”ダイアログボックスを開くときに，下記のメッ

セージが表示された場合。 

“Your computer has different names for DNS(“xxx”) and Netbios(“yyy”).” 

（メッセージ内の“xxx”および“yyy”は，パソコンの設定により変わります。） 

本章(1) 

2 サーバを起動してから最初にアクセスしたときに，ページが表示されない場合。 本章(2)(a)

3 
サーバとクライアントが同一イントラネットのパソコンのときに，プロキシが設定されている

Webブラウザで，ページが表示されない場合。 
本章(2)(b)

4 複数のWebブラウザを起動したときに，正常にページを表示できなくなった場合。 本章(2)(c)

 

(1) ホスト名とNetBIOS名が違っている場合 

サーバのパソコンの，ホスト名とNetBIOS名が違っている場合は，下記のようなダ

イアログボックスが表示されます。（下記ダイアログボックスは，“GX 

Configurator-DP Server Administrator”ダイアログボックスを開くときに，表

示されます。） 
 

 

 
図11-1 ダイアログボックス 

 
上記ダイアログボックスが表示されたときに，Webブラウザでページを表示できな

い場合は，ダイアログボックスのメッセージに従ってURLを修正し，ページを表示

させてください。 

 

備  考 

ホスト名またはNetBIOS名を統一すると，上記の問題は発生しなくなります。 

ホスト名はたはNetBIOS名を修正する場合は，ネットワーク管理者と相談してくださ

い。 

 

 

11 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

11 - 2                                         11 - 2 

１１ トラブルシューティング 
MELSOFT

 

 (2) Webベースオンラインアクセス機能のページが表示されない場合 

(a) サーバを起動してから最初にアクセスしたときに，ページが表示されない場

合 

サーバを起動してから最初にアクセスしたときにページが表示されない場合

は，15～30秒後にWebブラウザの表示を更新してください。 
 

サーバの起動処理に15～30秒程度かかる場合があり，起動処理中にアクセス

してもページは表示されません。 
 

(b) サーバとクライアントが同一イントラネットのパソコンのときに，プロキシ

が設定されているWebブラウザで，ページが表示されない場合 

ネットワーク管理者に相談の上，サーバへのアクセスでプロキシを使用しな

いように，Webブラウザの設定（＊1）を変更してください。 
 

＊1 Webブラウザの設定については，Webブラウザのマニュアルを参照してく

ださい。 
 

(b-1) Microsoft R Internet Explorer Version 5の設定例 

① Internet Explorerのメニューバーから[Tools]→[Internet Options]メ

ニューを選択し，“Internet Options”ダイアログボックスを表示させま

す。 

② “Connections”タブを表示し， LAN Settings ボタンをクリックして，

“Local Area Network (LAN) Settings”ダイアログボックスを表示させ

ます。 

③ “Bypass proxy server for local addresses”にチェックし， OK ボタ

ンをクリックして設定を終了します。 
 

 

 
図11-2 Internet Explorer Version5 の設定例 
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(c) 複数のWebブラウザを起動したときに，正常にページを表示できなくなった場

合 

ネットワーク管理者に相談の上，Webベースオンラインアクセス機能のサーバ

のCookieを受け入れるように設定（＊1）してください。 
 

＊1 Cookieの設定については，Webブラウザのマニュアルを参照してください。 
 

(c-1) Microsoft R Internet Explorer Version 5の設定例 

① Internet Explorerのメニューバーから[Tools]→[Internet Options]メ

ニューを選択し，“Internet Options”ダイアログボックスを表示させま

す。 

② “Security”タブを表示し， Custom Level ボタンをクリックして，

“Security Settings”ダイアログボックスを表示させます。 

③ Cookieの設定項目までスクロールし，“Allow per-session cookies”を

“Enable”または“Prompt”（＊1）に設定します。 
 

＊1 “Prompt”に設定した場合は，Webブラウザでページを表示させたと

きに，ダイアログボックスが表示されます。 

このダイアログボックスで，Cookieを受け入れるように設定してくだ

さい。 
 

④  OK ボタンをクリックし，設定を終了します。 
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サービスネットワーク（三菱電機システムサービス(株)） 
 

北海道支店

(011)890－7515

新潟機器サービスステーション

(025)241-7261

北陸支店

(076)252－9519

京滋機器サービスステーション

(075)611－6211

関西機電支社

(06)6458－9728

姫路機器サービスステーション

(079)281－1141

中四国支社

(082)285－2111

北日本支社

(022)238－1761

東京機電支社

(03)3454－5521

神奈川機器サービスステーション

(045)938－5420

関東機器サービスステーション

(048)652－0378

静岡機器サービスステーション

(054)287－8866

中部支社

(052)722－7601

四国支店

(087)831－3186

倉敷機器サービスステーション

(086)448－5532

九州支社

(092)483－8208

長崎機器サービスステーション

(095)834-1116

 
 

 

 

 

 

 

 

Microsoft，Windows，WindowsNTは，米国Microsoft Corporationの米国およびその他の国における登録商標です。 

Adobe，Acrobatは，Adobe Systems Incorporatedの登録商標です。 

Pentium，Celeronは，Intel Corporationの米国およびその他の各国における商標および登録商標です。 

Ethernetは，米国Xerox.co.ltdの登録商標です。 

PC-9800，PC98-NXは，日本電気株式会社の登録商標です。 

その他，本文中における会社名，商品名は，各社の商標または登録商標です。 
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